SNPlex™ Genotyping System 48-plex

User Guide
SNPLEX™ SYSTEM AMPLIFICATION KIT (4349358) NOTICE TO PURCHASER: LIMITED LABEL LICENSE

City, CA 94404, U.S.A.

expressly, by implication, or by estoppel, or under any other patent rights owned or licensable by Applied Biosystems. Further information on purchasing licenses to practice the patented methods may be obtained by contacting the Director of Licensing, Applied Biosystems, 850 Lincoln Centre Drive, Foster City, California 94404, U.S.A.

SNPLEX™ SYSTEM CONTROL POOL (4362635) NOTICE TO PURCHASER: LIMITED LICENSE

Drive, Foster City, CA 94404, U.S.A.

including without limitation reporting the results of purchaser's activities for a fee or other commercial consideration, is conveyed by the purchase of this product.

SNPLEX™ SYSTEM OLIGONUCLEOTIDE LIGATION KIT (4362268) NOTICE TO PURCHASER: LIMITED LICENSE

The purchase price of SNPLEX™ SYSTEM OLIGONUCLEOTIDE LIGATION KIT includes a limited, non-transferable, non-exclusive license (without the right to resell, repackage, or sublicense) under the method claims of U.S. Patents 4,988,617 and 5,830,711 or counterpart claims in patents and applications outside the U.S., to use only this amount of the product to practice the Oligonucleotide Ligation Assay (OLA) and Ligation Detection Reaction (LDR) methods described in said patents solely for the purchaser's own research and development activities when this product is used in conjunction with SNPLEX™ System Ligation Probes or SNPLEX™ System Control Pool. No other rights are granted expressly, by implication, or by estoppel, or under any other patent rights owned or licensable by Applied Biosystems. Further information on purchasing licenses for the OLA and LDR methods and other applications may be obtained by contacting the Director of Licensing at Applied Biosystems, 850 Lincoln Centre Drive, Foster City, CA 94404, U.S.A.

NOTICE TO PURCHASER: LIMITED LICENSE

This product is sold under licensing arrangements between Applied Biosystems and Invitrogen Corporation. The purchase price of this product includes limited, nontransferable rights under U.S. Patent 5,035,996 and foreign equivalents owned by Invitrogen Corporation to use only this amount of the product to practice the claims in said patents solely for activities of the purchaser within the field of research. Further information on purchasing licenses under the above patents may be obtained by contacting the Director, Corporate Development at Invitrogen Corporation, 1600 Faraday Avenue, PO Box 6482, Carlsbad, California 92008.

SNPLEX™ GENOTYPING SYSTEM LIGATION PROBES (4346978) NOTICE TO PURCHASER: LIMITED LICENSE

The purchase price of SNplex™ Genotyping System Ligation Probes includes a limited, non-transferable, non-exclusive license (without the right to resell, repackage, or sublicense) under the method claims of U.S. Patents 4,988,617 and 5,830,711 or counterpart claims in patents and applications outside the U.S., to use only this amount of the product to practice the Oligonucleotide Ligation Assay (OLA) and Ligation Detection Reaction (LDR) methods described in said patents solely for the purchaser's own research and development activities when this product is used in conjunction with SNMPlex™ System Oligonucleotide Ligation Kit. No other rights are granted expressly, by implication, or by estoppel, or under any other patent rights owned or licensable by Applied Biosystems. Further information on purchasing licenses for the OLA and LDR methods and other applications may be obtained by contacting the Director of Licensing at Applied Biosystems, 850 Lincoln Centre Drive, Foster City, CA 94404, U.S.A.

SNPLEX™ SYSTEM CONTROL POOL (4362635) NOTICE TO PURCHASER: LIMITED LICENSE

The purchase price of SNplex™ System Control Pool includes a limited, non-transferable, non-exclusive license (without the right to resell, repackage, or sublicense) under the method claims of U.S. Patents 4,988,617 and 5,830,711 or counterpart claims in patents and applications outside the U.S., to use only this amount of the product to practice the Oligonucleotide Ligation Assay (OLA) and Ligation Detection Reaction (LDR) methods described in said patents solely for the purchaser's own research and development activities when this product is used in conjunction with SNPLEX™ System Oligonucleotide Ligation Kit. No other rights are granted expressly, by implication, or by estoppel, or under any other patent rights owned or licensable by Applied Biosystems. Further information on purchasing licenses for the OLA and LDR methods and other applications may be obtained by contacting the Director of Licensing at Applied Biosystems, 850 Lincoln Centre Drive, Foster City, CA 94404, U.S.A.

SNPLEX™ SYSTEM AMPLIFICATION KIT (4349358) NOTICE TO PURCHASER: LIMITED LABEL LICENSE

Use of this product is covered by one or more of the following US patents and corresponding patent claims outside the US: 5,079,352, 6,127,155, 5,677,152 (claims 1-23) and 5,773,258 (claims 1-10). The purchase of this product includes a limited, non-transferable immunity from suit under the foregoing patent claims for using only this amount of product for the purchaser's own internal research. No right under any other patent claim and no right to perform commercial services of any kind, including without limitation reporting the results of purchaser's activities for a fee or other commercial consideration, is conveyed by the purchase of this product expressly, by implication, or by estoppel. This product is for research use only. Diagnostic uses require a separate license from Roche. Further information on purchasing licenses may be obtained by contacting the Director of Licensing, Applied Biosystems, 850 Lincoln Centre Drive, Foster City, California 94404, USA.

NOTICE TO PURCHASER: LIMITED LICENSE

This product is sold under licensing arrangements between Applied Biosystems and Invitrogen Corporation. The purchase price of this product includes limited, nontransferable rights under U.S. Patent 5,035,996 and foreign equivalents owned by Invitrogen Corporation to use only this amount of the product to practice the claims in said patents solely for activities of the purchaser within the field of research. Further information on purchasing licenses under the above patents may be obtained by contacting the Director, Corporate Development at Invitrogen Corporation, 1600 Faraday Avenue, PO Box 6482, Carlsbad, California 92008.
SNPLEX™ SYSTEM PURIFICATION KIT (4349357) NOTICE TO PURCHASER: DISCLAIMER OF LICENSE

No license to use the Oligonucleotide Ligation Assay (OLA) and/or Ligation Detection Reaction (LDR) methods covered by patents owned or licensable by Applied Biosystems is conveyed expressly, by implication or by estoppel to the purchaser by the purchase of this product. Further information on purchasing licenses to practice the patented methods may be obtained by contacting the Director of Licensing, Applied Biosystems, 850 Lincoln Centre Drive, Foster City, California 94404, U.S.A.

SNPLEX™ SYSTEM ZIPCHUTE™ KIT, 48-PLEX (4349361) NOTICE TO PURCHASER: LIMITED LICENSE

SNPLEX™ SYSTEM ZIPCHUTE™ KIT is covered by composition claims of U.S. Patent 5,777,096 (owned by Applied Biosystems), or counterpart claims in patents and applications outside the U.S. The purchase price of SN Plex System Zipchute Kit includes a limited, non-transferable, non-exclusive license (without the right to resell, repackaging, or sublicense) to use only this amount of the product solely for the purchaser's own research and development activities. No other rights are granted expressly, by implication, or by estoppel, under these or any other patent rights owned or licensable by Applied Biosystems. Further information on purchasing licenses may be obtained by contacting the Director of Licensing at Applied Biosystems, 850 Lincoln Centre Drive, Foster City, CA 94404, U.S.A.

SNPLEX™ SYSTEM ASSAY STANDARDS KIT (4349351)

SN Plex™ System Assay Standards Kit is covered under one or more of U.S. Patent Nos. 5,654,419, 5,707,804, 5,688,648, 6,028,190, 5,869,255, 6,177,247, 6,544,744, 5,728,528, U.S. patent application 10/288,104, and corresponding foreign patents and patent applications, licensed from the University of California

NOTICE TO PURCHASER: DISCLAIMER OF LICENSE

This product is optimized for use in the DNA sequencing or fragment analysis methods covered by patents owned or licensable by Applied Biosystems. No license under these patents to use the DNA sequencing or fragment analysis methods is conveyed expressly or by implication to the purchaser by the purchase of this product. A license to use the DNA sequencing or fragment analysis methods for certain research and development activities accompanies the purchase of certain Applied Biosystems reagents when used in conjunction with an authorized DNA sequencing machine, or is available from Applied Biosystems. No rights are granted expressly, by implication, or by estoppel, or under any other patent rights owned or licensable by Applied Biosystems. Further information on purchasing licenses to practice the DNA sequencing or fragment analysis methods may be obtained by contacting the Director of Licensing, Applied Biosystems, 850 Lincoln Centre Drive, Foster City, California 94404, U.S.A.

SNPLEX™ SYSTEM MATRIX STANDARD (4349365)

SN Plex™ System Matrix Standard is covered under one or more of U.S. Patent Nos. 5,654,419, 5,707,804, 5,688,648, 6,028,190, 5,869,255, 6,177,247, 6,544,744, 5,728,528, U.S. patent application 10/288,104, and corresponding foreign patents and patent applications, licensed from the University of California

NOTICE TO PURCHASER: DISCLAIMER OF LICENSE

This product is optimized for use in the DNA sequencing or fragment analysis methods covered by patents owned or licensable by Applied Biosystems. No license under these patents to use the DNA sequencing or fragment analysis methods is conveyed expressly or by implication to the purchaser by the purchase of this product. A license to use the DNA sequencing or fragment analysis methods for certain research and development activities accompanies the purchase of certain Applied Biosystems reagents when used in conjunction with an authorized DNA sequencing machine, or is available from Applied Biosystems. No rights are granted expressly, by implication, or by estoppel, or under any other patent rights owned or licensable by Applied Biosystems. Further information on purchasing licenses to practice the DNA sequencing or fragment analysis methods may be obtained by contacting the Director of Licensing, Applied Biosystems, 850 Lincoln Centre Drive, Foster City, California 94404, U.S.A.

TRADEMARKS:

AB (Design), ABI PRISM, Applied Biosystems, BigDye, GeneAmp, GeneMapper, and LIZ are registered trademarks and Applaera, Celera Discovery System, Celera Genomics, FAM, Hi-Di, MicroAmp, POP-7, ROX, SN Plex, SN P browser, TAMRA, Zip Chute, and Zip Code are trademarks of App lera Corporation or its subsidiaries in the U.S. and/or certain other countries.

TaqMan is registered trademark of Roche Molecular Systems, Inc.
PicoGreen is a registered trademark of Molecular Probes, Inc.
AFLP is a registered trademark of Keygene N.V.
All other trademarks are the sole property of their respective owners.

Part Number 4360856 Rev. D 09/2007
Contents

Preface

How to Use This Guide ................................................................. xi
How to Obtain More Information ........................................... xii
How to Obtain Support ............................................................... xiii

Safety Information

Safety Conventions Used in This Document ........................... xvi
Chemical Safety ................................................................. xvii
Chemical Waste Safety ........................................................... xviii
Biological Hazard Safety ......................................................... xix
Workstation Safety ............................................................... xx

Chapter 1  Introduction

Product Overview ................................................................. 1-2
  Product Description ......................................................... 1-2
  About SNP-Specific Probes ................................................. 1-2
  About Universal ASO/LSO Linkers ....................................... 1-3
  About ZipChute Probe-Based Chemistry ............................... 1-4
  SNPlex System Documentation ........................................... 1-5
SNPlex System Kits and Reagents ........................................... 1-7
  Overview ............................................................................. 1-7
  Kits and Reagents ............................................................. 1-7
  Ordering SNPlex System Kits and Reagents ......................... 1-9
Required Non-Kit Materials ..................................................... 1-9
  Equipment and Consumables .............................................. 1-9
  Reagents ........................................................................... 1-11
  Other Required Materials ................................................. 1-12
  Optional Materials ............................................................ 1-13
Chemistry Overview ............................................................. 1-14
  Component Kits .............................................................. 1-14
  Workflow ........................................................................... 1-14
  Preparing and Fragmenting Genomic DNA ......................... 1-15
  About Purification ............................................................ 1-15
  Kits for Purifying Genomic DNA ......................................... 1-15
  Whole Genome Amplification ............................................. 1-15
  About Fragmentation .......................................................... 1-15
### Chapter 2  Setting Up Applied Biosystems 3730/3730xl and 3130xl DNA Analyzers for SNPlex System Experiments

<table>
<thead>
<tr>
<th>Overview</th>
<th>2-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported Configuration</td>
<td>2-2</td>
</tr>
<tr>
<td>Required Materials</td>
<td>2-2</td>
</tr>
<tr>
<td>Importing SNPlex System Files into the Data Collection Software</td>
<td>2-3</td>
</tr>
<tr>
<td>Replacing the PrebatchModule.txt File</td>
<td>2-3</td>
</tr>
<tr>
<td>Importing the HTSNP36_POP7_V2 Module</td>
<td>2-4</td>
</tr>
<tr>
<td>Importing the HTSNP36_POP7_V3 and HTSNP50_POP7 Modules</td>
<td>2-4</td>
</tr>
<tr>
<td>Installing Dye Set S</td>
<td>2-5</td>
</tr>
<tr>
<td>Creating an Instrument Protocol for SNPlex System Experiments</td>
<td>2-5</td>
</tr>
<tr>
<td>Preconditioning the Capillary Array</td>
<td>2-6</td>
</tr>
<tr>
<td>Performing Spatial and Spectral Calibrations</td>
<td>2-7</td>
</tr>
<tr>
<td>Performing a Spatial Calibration</td>
<td>2-7</td>
</tr>
<tr>
<td>Performing a Spectral Calibration</td>
<td>2-7</td>
</tr>
<tr>
<td>Validating Instrument Performance</td>
<td>2-11</td>
</tr>
<tr>
<td>Preparing the Test Sample Plate for the 3730/3730xl Instrument</td>
<td>2-11</td>
</tr>
<tr>
<td>Preparing a Mock Run for the 3130xl Instrument</td>
<td>2-12</td>
</tr>
<tr>
<td>Evaluating the SNPlex System Run</td>
<td>2-13</td>
</tr>
</tbody>
</table>
Chapter 3  SNPllex System Protocols

Overview
Protocols in This Guide
Before You Begin
Designing the Sample Plate Layout
Purpose
Assumptions

3730xl Instrument (96-capillary), 96-wells
3730xl Instrument (96-capillary), 384-wells
3730 Instrument (48-capillary), 96-wells
3730 Instrument (48-capillary), 384-wells
3130xl Instrument (16-Capillary), 96-Wells
3130xl Instrument (16-Capillary), 384-Wells

Preparing Genomic DNA
Guidelines for DNA Concentrations and Quantity
Preparing Purified gDNA
Fragmenting the gDNA
Drying Down gDNA
Dispensing gDNA into Reaction Plates

Phosphorylating and Ligating Probes to gDNA (OLA)
Oligonucleotide Ligation Kit Components
About SNPllex System Ligation Probes
Preparing the OLA Reactions
Assembling the OLA Reaction: Dried-Down gDNA
Assembling the OLA Reaction: Wet gDNA
Running the OLA Reactions on the Thermal Cycler

Purifying Ligated OLA Reaction Products
Purification Kit Components
Required Materials
Preparing an Exonuclease Reaction

Performing PCR
Amplification Kit Components
Required Materials
Preparing the PCR Master Mix
Assembling and Running the PCR Reaction

Hybridizing PCR Products to ZipChute Probes
Reagents Required for Hybridization
Required Materials
Preparing Wash Buffer and Binding Buffer with Positive Hybridization Control
Preparing the Hybridization Plates
Binding PCR Products to the Hybridization Plate
Isolating Biotinylated Strands on the Hybridization Plate
Hybridizing the ZipChute Probes

Eluting ZipChute Probes
Standards Kit Components
Required Materials
Preparing the Sample Loading Mix
Eluting the ZipChute Probes
Chapter 4 Analyzing Data Using GeneMapper Software

Overview ............................................................................................................. 4-2
Installing GeneMapper Software v4.0 ................................................................. 4-3
Importing SNPlex System Panels and Bins ......................................................... 4-3
  About SNPlex System Panels and Bins ........................................................... 4-3
  Importing SNPlex System Panels and Bins .................................................... 4-3
Importing the SNPlex Analysis Method for the 3130x/ Instrument .................. 4-5
  Installing the Analysis Method ...................................................................... 4-5
Importing the AIF ............................................................................................... 4-5
  About Assay Information Files for the SNPlex System ................................ 4-5
  Importing AIFs ............................................................................................... 4-6
Importing SNPlex System Data into GeneMapper Software ............................. 4-6
  Required Fields ............................................................................................. 4-6
  Setting Analysis Method, Size Standard, and Panel Automatically ............... 4-7
  Importing Sample Files .................................................................................. 4-8
Analyzing SNPlex System Data .......................................................................... 4-8
Reviewing Results ............................................................................................... 4-9
Exporting SNPlex System Data .......................................................................... 4-10
Chapter 5  Troubleshooting

Troubleshooting Overview ................................................. 5-2
  About the Study Manager and Quality Control Metrics ............... 5-2
  Troubleshooting Workflow .............................................. 5-2
  Standard Workflow Illustration ...................................... 5-3
Checking File Structure ..................................................... 5-3
Reviewing Raw Data ......................................................... 5-4
  Reviewing Allelic Ladders: Signal Strength ......................... 5-5
  Reviewing Allelic Ladders: Resolution ............................... 5-7
  Reviewing All Wells: Spectral Calibration ........................... 5-8
Adding Runs to the Study Manager ........................................ 5-8
Reviewing IQC Metrics ....................................................... 5-9
  Purposes of IQC Metrics ................................................ 5-9
  About Review Modes ..................................................... 5-9
  Changing Review Modes ................................................ 5-10
  Review Strategy ............................................................ 5-10
  Reviewing Ladder IQC Values .......................................... 5-10
  Reviewing Size Standard IQC Values ................................. 5-12
  Reviewing PHC IQC Values ............................................. 5-16
  Reviewing Assay IQC Values ........................................... 5-18
  Reviewing the Signals Plot ............................................. 5-21
Reviewing Cluster Plots ..................................................... 5-23
Reviewing SQC Values ....................................................... 5-28

Appendix A  Using the SN Plex System Control Set

  Product Description ....................................................... A-2
  About the Control Pool SNPs .......................................... A-2
  About the Dried gDNA Plate .......................................... A-4
  Using the Control Pool .................................................. A-5
  Expected Results .......................................................... A-5
Appendix B  GeneMapper Software v4.0: Analysis Methods for
SNPlex System Assays

Analysis Methods for SNPlex System Assays ........................................... B-2
  Overview ............................................................................................. B-2
  Selecting a Clustering Algorithm ......................................................... B-2
  Terms Used in Clustering Analysis ....................................................... B-3
SNPlex_Rules_3730/SNPlex_Rules_3130 ...................................................... B-4
  Settings of the SNPlex_Rules_3730 Method ......................................... B-4
  Selecting an Allele Calling Method ....................................................... B-6
  Modifying the Allele Cut-off Value ...................................................... B-6
  Modifying the Clustering Parameters ................................................. B-6
SNPlex_Model_3730 ........................................................................... B-9
  Settings of the SNPlex_Model_3730 Method ....................................... B-9

Index
Preface

How to Use This Guide

Purpose of This Guide

The Applied Biosystems SNPllex™ Genotyping System 48-plex User Guide provides information on how to use the SNPllex™ System kits with the Applied Biosystems 3730/3730xl or 3130xl DNA Analyzer. This document includes new information about:

- Improved protocols for 384-well and 96-well plates.
- Control (ligation probe) pool and dried gDNA plates kit, which you can use to evaluate the performance of the SNPllex System.
- Use of GeneMapper® Software v4.0 to analyze SNPllex System data. This version of the software provides a new clustering algorithm (Model), which raises the accuracy of scoring. The existing Rules clustering algorithm is also included.
- Updated troubleshooting using the Study Manager.

IMPORTANT! Chapters 1 and 3 describe significant changes in the assay setup.

Audience

This guide is intended for novice and experienced SNPllex™ Genotyping System 48-plex users who perform SNPllex System assays and analyze the data using GeneMapper software.

Text Conventions

This guide uses the following conventions:

- **Bold** indicates user action. For example:
  Type **0**, then press **Enter** for each of the remaining fields.
- **Italic** text indicates new or important words and is also used for emphasis. For example:
  Before analyzing, **always** prepare fresh matrix.
- A right arrow bracket (>) separates successive commands you select from a drop-down or shortcut menu. For example:
  Select **File > Open > Spot Set**.
  Right-click the sample row, then select **View Filter > View All Runs**.

User Attention Words

Two user attention words appear in Applied Biosystems user documentation. Each word implies a particular level of observation or action as described below:

**Note:** Provides information that may be of interest or help but is not critical to the use of the product.

**IMPORTANT!** Provides information that is necessary for proper instrument operation, accurate chemistry kit use, or safe use of a chemical.
Examples of the user attention words appear below:

**Note:** The size of the column affects the run time.

**Note:** The Calibrate function is also available in the Control Console.

**IMPORTANT!** To verify your client connection to the database, you need a valid Oracle user ID and password.

**IMPORTANT!** You must create a separate Sample Entry Spreadsheet for each 96-well plate.

**Safety Alert Words** Safety alert words also appear in user documentation. For more information, see “Safety Alert Words” on page xvi.

### How to Obtain More Information

**Related Documentation** The following related documents are available:

- **SNPlex™ Genotyping System, 48-plex Assay Design and Ordering Guide** (PN 4357460) – Describes the SNPlex Genotyping Systems assay design and ordering process, the file formats to use for a successful submission, and guidelines to maximize the assay design success rate.

- **SNPlex™ Genotyping System, 48-plex Quick Reference Card** (PN 4360855) – Provides condensed procedures for using the SNPlex Genotyping System 48-plex.

- **SNPlex™ Genotyping System 48-plex General Automation Getting Started Guide** (PN 4363143) – Assists principal investigators and laboratory staff with using the SNPlex Genotyping System 48-plex with general robotics.

- **SNPlex™ Genotyping System 48-plex Automating OLA Using the Biomek FX Getting Started Guide** (PN 4360796) – Explains how to set up the Biomek FX instrument for automating the OLA portion of the SNPlex System assay.

- **SNPlex™ Genotyping System 48-plex Automating OLA Using the TECAN Genesis RSP Getting Started Guide** (PN 4360790) – Explains how to set up the TECAN Genesis RSP instrument for automating the OLA portion of the SNPlex System assay.

- **SNPlex™ Genotyping System 48-plex Automation Guide Automating PCR Using the Tomtec Quadra 3 Getting Started Guide** (PN 4358100) – Explains how to set up the Tomtec Quadra 3 instrument for automating the post-PCR portion of the SNPlex System assay.

- **Applied Biosystems 3730/3730xl DNA Analyzers Getting Started Guide** (PN 4331468) – Provides information about using the 3730/3730xl instrument.

- **GeneMapper® Software v4.0 Online Help** – Describes the analysis software and provides procedures for common tasks.

**Note:** For additional documentation, see “How to Obtain Support” on page xiii.

**Send Us Your Comments** Applied Biosystems welcomes your comments and suggestions for improving its user documents. You can e-mail your comments to:

[techpubs@appliedbiosystems.com](mailto:techpubs@appliedbiosystems.com)
How to Obtain Support

For the latest services and support information for all locations, go to http://www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:

• Search through frequently asked questions (FAQs)
• Submit a question directly to Technical Support
• Order Applied Biosystems user documents, MSDSs, certificates of analysis, and other related documents
• Download PDF documents
• Obtain information about customer training
• Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers to contact Applied Biosystems Technical Support and Sales facilities.
Safety Information

This section includes the following topics:

Safety Conventions Used in This Document .................................................. xvi
Chemical Safety ................................................................. xvii
Chemical Waste Safety ............................................................. xviii
Biological Hazard Safety .............................................................. xix
Workstation Safety ................................................................. xx
Safety Conventions Used in This Document

Four safety alert words appear in Applied Biosystems user documentation at points in the document where you need to be aware of relevant hazards. Each alert word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular level of observation or action, as defined below:

Definitions

IMPORTANT! – Indicates information that is necessary for proper instrument operation, accurate chemistry kit use, or safe use of a chemical.

⚠️ CAUTION – Indicates a potentially hazardous situation that, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.

⚠️ WARNING – Indicates a potentially hazardous situation that, if not avoided, could result in death or serious injury.

⚠️ DANGER – Indicates an imminently hazardous situation that, if not avoided, will result in death or serious injury. This signal word is to be limited to the most extreme situations.

Except for IMPORTANTs, each safety alert word in an Applied Biosystems document appears with an open triangle figure that contains a hazard symbol. These hazard symbols are identical to the hazard icons that are affixed to Applied Biosystems instruments.

Examples

The following examples show the use of safety alert words:

IMPORTANT! You must create a separate a Sample Entry Spreadsheet for each 96-well microtiter plate.

⚠️ CAUTION The lamp is extremely hot. Do not touch the lamp until it has cooled to room temperature.

⚠️ WARNING CHEMICAL HAZARD. Formamide. Exposure causes eye, skin, and respiratory tract irritation. It is a possible developmental and birth defect hazard. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

⚠️ DANGER ELECTRICAL HAZARD. Failure to ground the instrument properly can lead to an electrical shock. Ground the instrument according to the provided instructions.
Chemical Safety

Chemical Hazard Warning

⚠️ WARNING CHEMICAL HAZARD. Before handling any chemicals, refer to the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all relevant precautions.

⚠️ WARNING CHEMICAL HAZARD. All chemicals in the instrument, including liquid in the lines, are potentially hazardous. Always determine what chemicals have been used in the instrument before changing reagents or instrument components. Wear appropriate eyewear, protective clothing, and gloves when working on the instrument.

⚠️ WARNING CHEMICAL HAZARD. Four-liter reagent and waste bottles can crack and leak. Each 4-liter bottle should be secured in a low-density polyethylene safety container with the cover fastened and the handles locked in the upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

⚠️ WARNING CHEMICAL STORAGE HAZARD. Never collect or store waste in a glass container because of the risk of breaking or shattering. Reagent and waste bottles can crack and leak. Each waste bottle should be secured in a low-density polyethylene safety container with the cover fastened and the handles locked in the upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

About MSDSs

Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with shipments of hazardous chemicals to new customers. They also provide MSDSs with the first shipment of a hazardous chemical to a customer after an MSDS has been updated. MSDSs provide the safety information you need to store, handle, transport, and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to replace the appropriate MSDS in your files.

Obtaining MSDSs

You can obtain from Applied Biosystems the MSDS for any chemical supplied by Applied Biosystems. This service is free and available 24 hours a day.

To obtain MSDSs:

1. Go to https://docs.appliedbiosystems.com/msdssearch.html

2. In the Search field, type in the chemical name, part number, or other information that appears in the MSDS of interest. Select the language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of the following:
   - Open – To view the document
   - Print Target – To print the document
   - Save Target As – To download a PDF version of the document to a destination that you choose
Chemical Safety Guidelines

To minimize the hazards of chemicals:

- Read and understand the Material Safety Data Sheets (MSDS) provided by the chemical manufacturer before you store, handle, or work with any chemicals or hazardous materials. (See “About MSDSs” on page xvii.)
- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing). For additional safety guidelines, consult the MSDS.
- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood). For additional safety guidelines, consult the MSDS.
- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer’s cleanup procedures as recommended on the MSDS.
- Comply with all local, state/provincial, or national laws and regulations related to chemical storage, handling, and disposal.

Chemical Waste Safety

Chemical Waste Hazard

⚠️ CAUTION HAZARDOUS WASTE. Refer to Material Safety Data Sheets and local regulations for handling and disposal.

⚠️ WARNING CHEMICAL WASTE HAZARD. Wastes produced by Applied Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

⚠️ WARNING CHEMICAL STORAGE HAZARD. Never collect or store waste in a glass container because of the risk of breaking or shattering. Reagent and waste bottles can crack and leak. Each waste bottle should be secured in a low-density polyethylene safety container with the cover fastened and the handles locked in the upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

Chemical Waste Safety Guidelines

To minimize the hazards of chemical waste:

- Read and understand the Material Safety Data Sheets (MSDSs) provided by the manufacturers of the chemicals in the waste container before you store, handle, or dispose of chemical waste.
- Provide primary and secondary waste containers. (A primary waste container holds the immediate waste. A secondary container contains spills or leaks from the primary container. Both containers must be compatible with the waste material and meet federal, state, and local requirements for container storage.)
- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing). For additional safety guidelines, consult the MSDS.
- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood). For additional safety guidelines, consult the MSDS.
- Handle chemical wastes in a fume hood.
- After emptying the waste container, seal it with the cap provided.
• Dispose of the contents of the waste tray and waste bottle in accordance with good laboratory practices and local, state/provincial, or national environmental and health regulations.

**Waste Disposal**

If potentially hazardous waste is generated when you operate the instrument, you must:

• Characterize (by analysis if necessary) the waste generated by the particular applications, reagents, and substrates used in your laboratory.

• Ensure the health and safety of all personnel in your laboratory.

• Ensure that the instrument waste is stored, transferred, transported, and disposed of according to all local, state/provincial, and/or national regulations.

**IMPORTANT!** Radioactive or biohazardous materials may require special handling, and disposal limitations may apply.

---

**Biological Hazard Safety**

**General Biohazard**

![WARNING] BIOHAZARD. Biological samples such as tissues, body fluids, and blood of humans and other animals have the potential to transmit infectious diseases. Follow all applicable local, state/provincial, and/or national regulations. Wear appropriate protective eyewear, clothing, and gloves. Read and follow the guidelines in these publications:

• U.S. Department of Health and Human Services guidelines published in *Biosafety in Microbiological and Biomedical Laboratories* (stock no. 017-040-00547-4; [http://bmbl.od.nih.gov](http://bmbl.od.nih.gov))

• Occupational Safety and Health Standards, Bloodborne Pathogens (29 CFR§1910.1030; [http://www.access.gpo.gov/nara/cfr/waisidx_01/29cfr1910a_01.html](http://www.access.gpo.gov/nara/cfr/waisidx_01/29cfr1910a_01.html)).

Additional information about biohazard guidelines is available at: [http://www.cdc.gov](http://www.cdc.gov)
Workstation Safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your workstation to promote neutral or relaxed working positions.

⚠ CAUTION MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD. These hazards are caused by potential risk factors that include but are not limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:

- Use equipment that comfortably supports you in neutral working positions and allows adequate accessibility to the keyboard, monitor, and mouse.
- Position the keyboard, mouse, and monitor to promote relaxed body and head postures.
Introduction

This chapter covers:

Product Overview ................................................................. 1-2
SNPlex System Kits and Reagents ............................................. 1-7
Required Non-Kit Materials ..................................................... 1-9
Chemistry Overview ............................................................... 1-14
Laboratory Design: Precautions for Preventing Amplicon Contamination .... 1-30
Chapter 1  Introduction

Product Overview

The human genome contains between 6 million and 30 million single nucleotide polymorphisms (SNPs). Geneticists estimate that 300,000 or more SNPs may be required per individual to map complex diseases, such as cancer and heart disease, in a given population.

The SNPlex™ Genotyping System uses Applied Biosystems oligonucleotide ligation assay (OLA) combined with multiplex PCR technology to achieve allelic discrimination and target amplification. The chemistry is made possible through the use of a set of universal core reagent kits and a set of SNP-specific ligation probes.

The complete SNPlex Genotyping System contains the following components:

- **Universal SNPlex System Kits and reagents** – The SNPlex System Kits contain all the reagents needed to perform the SNPlex System Assay. “SNPlex System Kits and Reagents” on page 1-7 provides details about each kit.
- **SNP-specific ligation probes** – Applied Biosystems designs SNP-specific probes (also called assays) based on the SNPs that you specify. You can submit SNPs as IDs from common databases, such as dbSNP, or as custom sequences containing your SNPs of interest. For more information about the assay design process, refer to the SNPlex™ Genotyping System, 48-plex Assay Design and Ordering Guide (PN 4357460).
- **Validated SNP content** – Applied Biosystems SNPbrowser™ 3.5 software provides annotated locus information for over one million SNPs in several populations (generated either by Applied Biosystems or the International HapMap Project) allowing you to design assays based on polymorphisms in human DNA samples.
- **Genotyping analysis software** – The SNPlex System software suite consists of Data Collection v2.0 or higher and GeneMapper® 4.0 software. The suite allows you to collect and manage raw data, process and analyze the data, and finally store and manage the processed locus, sample, and called genotype information.
- **Electrophoresis instruments and consumables** – The Applied Biosystems 3730/3730xl and 3130xl DNA Analyzers enable the separation and detection of SNP-specific reporter probes using standard capillary arrays, electrophoresis buffers, and polymers. A unique matrix standard allows you to spectrally calibrate your electrophoresis instruments.

Each assay includes three SNP-specific ligation probes:

- Two of the probes are allele-specific oligos (ASOs). These are designed specifically for the detection of polymorphisms by having the discriminating nucleotide on the 3’ end. Each ASO probe sequence also contains one of 96 unique ZipCode™ sequences for ZipChute™ probe binding. In a multiplex reaction, the universal ZipCode sequences on each ASO are unique. Therefore, in a 48-plex reaction, there are 96 ASOs (two for each SNP), and 96 different ZipCode sequences.

- The third probe is a locus-specific oligo (LSO). Its sequence is common to both alleles of a given locus and anneals adjacent to the SNP site on its target DNA. Each LSO also contains a partial universal PCR-primer binding site. In a 48-plex reaction, there are 48 LSOs.
All 144 probes for a 48-plex reaction are shipped together as an ASO/LSO probe pool. It is this pool that confers genotyping specificity to the SNPlex System assay. All other reagents are universal and not SNP specific.

Order SNP-specific probes separately (through the Applied Biosystems Web site at www.appliedbiosystems.com; refer to the SNPlex™ Genotyping System, 48-plex Assay Design and Ordering Guide). SNP-specific probes are not included in the SNPlex System kits.

About Universal ASO/LSO Linkers

The SNPlex System Oligonucleotide Ligation Kit includes a set of Universal ASO/LSO linkers.

- Each ASO is ligated to a universal ASO-specific linker. These linkers contain
  - A universal PCR primer sequence corresponding to the universal forward primer (UA sequence)
  - A partial cZipCode sequence

The ASO linkers anneal to the universal ZipCode sequence of the ASO probes. In a 48-plex reaction, there are 96 different ASO linkers (one for each of the 96 ASO probes); each 48-plex utilizes the same set of 96 universal ASO linkers. Although the ASO linkers anneal to specific ZipCode sequences, they are not SNP-specific.

- One additional linker is ligated to the LSO and has a universal sequence that is compatible with all LSOs. (That is, there is only one LSO linker in a 48-plex reaction.) The sequence includes a partial binding site for a universal reverse primer.

- Each linker contains a spacer that protects a complete ligation product from exonuclease digestion.

Figure 1-1 shows the interaction between SNP-specific probes and universal linkers.
About ZipChute
Probe-Based
Chemistry

ZipChute™ probes are used for decoding the genotype information by functioning as reporter probes.

Each ZipChute probe has:

- A **ZipCode-binding sequence** – This sequence binds to the single-stranded cZipCode (complementary ZipCode) region of the PCR products.
- **Mobility modifiers** – Each ZipChute probe contains a different number of mobility modifiers, which enable size separation during electrophoresis.
- A **fluorescent label** – The fluorescent dye allows the 3730/3730xl/3130xl instrument to detect the ZipChute probe.

ZipChute probes are arranged in pairs, each pair representing both alleles of a SNP. The peaks of a pair, observed after electrophoretic separation, are used to identify the alleles of the corresponding SNP. Because each allele within a locus is represented by the same color, the SNPlex System uses both the size and color of the ZipChute probes to resolve alleles within a locus.

The SNPlex System ZipChute Kit contains a universal ZipChute mixture, which can be used for all multiplex reactions. The ZipChute probes constitute a library of reference alleles, called an allelic ladder. The master set of probes is used to normalize GeneMapper software parameters and aid in simplifying and automating allele scoring.

**Figure 1-2** shows the functional parts of a ZipChute probe.

![Figure 1-2 Parts of a ZipChute probe](image-url)
Table 1-1 lists the documentation available for the SNPlex Genotyping System 48-plex.

<table>
<thead>
<tr>
<th>Document Title</th>
<th>Part Number</th>
<th>Contents</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNPlex™ Genotyping System 48-plex Assay Design and</td>
<td>4357460</td>
<td>• Explains how to design SNPlex System ligation probes&lt;br&gt;• Provides instructions for using the Web site to order SNPlex System ligation probes&lt;br&gt;• Describes the error conditions that you may encounter when designing probes</td>
<td>• Part of the SNPlex Genotyping System Starter Kit, 48-plex&lt;br&gt;• Downloadable from the Applied Biosystems Web site&lt;sup&gt;a&lt;/sup&gt; and the SNPlex System Web site&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>Ordering Guide</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNPlex™ Genotyping System 48-plex User Guide</td>
<td>4360856</td>
<td>• Describes the SNPlex Genotyping System 48-plex&lt;br&gt;• Explains how to set up the 3730, 3730x, and 3130x instruments for use with the SNPlex System&lt;br&gt;• Contains the 96- and 384-well protocols for the 3730/3730x and 3130x analyzers&lt;br&gt;• Provides information about analyzing SNPlex System data with GeneMapper Software v4.0&lt;br&gt;• Discusses the troubleshooting process for SNPlex System experiments</td>
<td>• Part of the SNPlex Genotyping System Starter Kit, 48-plex&lt;br&gt;• Downloadable from the Applied Biosystems Web site&lt;sup&gt;a&lt;/sup&gt; and the SNPlex System Web site&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>SNPlex™ Genotyping System 48-plex Quick Reference</td>
<td>4360855</td>
<td>Contains short versions of the 96- and 384-well protocols for the 3730/3730x and 3130x analyzers, as well as summaries of GeneMapper software analysis.</td>
<td></td>
</tr>
<tr>
<td>Card</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNPlex™ Genotyping System 48-plex General Automation</td>
<td>4363143</td>
<td>• Describes options for automating the SNPlex System assay using liquid-handling instruments&lt;br&gt;• Describes the laboratory set up for automation&lt;br&gt;• Provides a sample automated workflow</td>
<td>• Part of the SNPlex Genotyping System Starter Kit, 48-plex&lt;br&gt;• Downloadable from the Applied Biosystems Web site&lt;sup&gt;a&lt;/sup&gt; and the SNPlex System Web site&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>Getting Started Guide</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNPlex™ Genotyping System 48-plex Automating OLA</td>
<td>4360796</td>
<td>• Explains how to set up the Biomek FX instrument for automating the OLA portion of the SNPlex System assay&lt;br&gt;• Provides the step-by-step automation protocols for using the Biomek FX instrument to automate the OLA portions of the SNPlex System assay</td>
<td>Downloadable from the Applied Biosystems Web site&lt;sup&gt;a&lt;/sup&gt; and the SNPlex System Web site&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
</tbody>
</table>
Table 1-1  SN Plex Genotyping System, 48-plex documentation (continued)

<table>
<thead>
<tr>
<th>Document Title</th>
<th>Part Number</th>
<th>Contents</th>
<th>Availability</th>
</tr>
</thead>
</table>
| 48-plex Automating OLA Using the TECAN Genesis RSP Getting Started Guide | 4360790 | • Explains how to set up the TECAN Genesis RSP instrument for automating the OLA portion of the SN Plex System assay  
• Provides the step-by-step automation protocols for using the TECAN Genesis RSP instrument to automate the OLA portions of the SN Plex System assay | Downloadable from the Applied Biosystems Web site\(^a\) and the SN Plex System Web site\(^b\) |
| 48-plex Automating PCR Using the Tomtec Quadra 3 Getting Started Guide | 4358100 | • Explains how to set up the Tomtec Quadra 3 instrument for automating the post-PCR portion of the SN Plex System assay  
• Provides the step-by-step automation protocols for using the Tomtec Quadra 3 instrument to automate the post-PCR portions of the SN Plex System assay | Downloadable from the Applied Biosystems Web site\(^a\) and the SN Plex System Web site\(^b\) |

Related Documentation

<table>
<thead>
<tr>
<th>Document Title</th>
<th>Part Number</th>
<th>Contents</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied Biosystems 3730/3730xl DNA Analyzers Getting Started Guide</td>
<td>4331468</td>
<td>Provides information about using the 3730/3730xl instrument</td>
<td>Downloadable from the Applied Biosystems Web site(^a)</td>
</tr>
<tr>
<td>Applied Biosystems 3130/3130xl DNA Analyzers Getting Started Guide</td>
<td>4352715</td>
<td>Provides information about using the 3130/3130xl instrument</td>
<td>Downloadable from the Applied Biosystems Web site(^a)</td>
</tr>
<tr>
<td>GeneMapper(^\text{®}) Software v4.0, SN Plex System Analysis Getting Started Guide</td>
<td>4363077</td>
<td>Provides information on SN Plex data analysis and a troubleshooting tutorial.</td>
<td>Downloadable from the Applied Biosystems Web site(^a)</td>
</tr>
<tr>
<td>GeneMapper(^\text{®}) Software v4.0 Online Help</td>
<td>NA</td>
<td>Describes the analysis software and provides procedures for common tasks</td>
<td>Installed with GeneMapper software</td>
</tr>
</tbody>
</table>

\(^a\) [http://www.appliedbiosystems.com](http://www.appliedbiosystems.com) > Support > Products & Services Literature  
\(^b\) [http://www.appliedbiosystems.com](http://www.appliedbiosystems.com) > Products & Services > Genotyping > SNP Genotyping Assays > Capillary Electrophoresis-Based Assays > SN Plex\(^\text{™}\) Genotyping System
SNPlex System Kits and Reagents

Overview

The reagents you need to perform a SNPlex System assay are provided in six parts:

- A core reagents kit, which contains reagents required to perform the SNPlex System assay
- A starter kit, which contains additional reagents required by first-time SNPlex System users, as well as documentation
- The ligation probes
- Hybridization plates (96-well or 384-well)
- A control pool
- A dried gDNA plates kit

These reagents are described in the following section. Additional reagents can be ordered separately.

<table>
<thead>
<tr>
<th>Reagent Name</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNPlex™ Genotyping System Core Reagents Kit(^a), 48-plex (5000 reactions)</td>
<td>4362266</td>
</tr>
<tr>
<td>SNPlex™ System Core Kit (1500 reactions)</td>
<td>4375768</td>
</tr>
<tr>
<td>SNPlex™ System Assay Control Kit(^a)</td>
<td>4349363</td>
</tr>
<tr>
<td>SNPlex™ System Oligonucleotide Ligation Kit(^a)</td>
<td>4362268</td>
</tr>
<tr>
<td>- Universal Linkers, 48-plex SNPlex™ System</td>
<td></td>
</tr>
<tr>
<td>- Oligonucleotide Ligation Master Mix SNPlex™ System</td>
<td></td>
</tr>
<tr>
<td>- dATP (100 ×) SNPlex™ System</td>
<td></td>
</tr>
<tr>
<td>SNPlex™ System Purification Kit(^a)</td>
<td>4349357</td>
</tr>
<tr>
<td>- Lambda Exonuclease SNPlex™ System</td>
<td></td>
</tr>
<tr>
<td>- Exonuclease Buffer (10X) SNPlex™ System</td>
<td></td>
</tr>
<tr>
<td>- Exonuclease I SNPlex™ System</td>
<td></td>
</tr>
<tr>
<td>SNPlex™ System Amplification Kit(^a)</td>
<td>4349358</td>
</tr>
<tr>
<td>- Amplification Primers (20X) SNPlex™ System</td>
<td></td>
</tr>
<tr>
<td>- Amplification Master Mix (2X) SNPlex™ System</td>
<td></td>
</tr>
<tr>
<td>Hybridization Binding Buffer SNPlex™ System</td>
<td>4349304</td>
</tr>
<tr>
<td>Hybridization Wash Buffer (10X) SNPlex™ System</td>
<td>4349301</td>
</tr>
<tr>
<td>ZipChute™ Dilution Buffer SNPlex™ System</td>
<td>4349306</td>
</tr>
<tr>
<td>SNPlex™ System ZipChute™ Kit, 48-plex</td>
<td>4349361</td>
</tr>
<tr>
<td>- Denaturant SNPlex™ System</td>
<td></td>
</tr>
<tr>
<td>- ZipChute™ Mix, 48-plex SNPlex™ System</td>
<td></td>
</tr>
<tr>
<td>- Positive Hybridization Controls SNPlex™ System</td>
<td></td>
</tr>
<tr>
<td>Reagent Name</td>
<td>Part Number</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>SNPllex™ System Standards Kit, 48-plex</td>
<td>4349351</td>
</tr>
<tr>
<td>• Sample Loading Reagent SNPllex™ System</td>
<td></td>
</tr>
<tr>
<td>• Size Standard, 48-plex SNPllex™ System</td>
<td></td>
</tr>
<tr>
<td>• Allelic Ladder, 48-plex SNPllex™ System</td>
<td></td>
</tr>
<tr>
<td>SNPllex™ System Starter Kit, 48-plex</td>
<td>4362267</td>
</tr>
<tr>
<td>SNPllex™ Genotyping Dried gDNA Plate Control Pool System CD</td>
<td>4366107</td>
</tr>
<tr>
<td>SNPllex™ Genotyping System 48-plex User Guide</td>
<td>4340856</td>
</tr>
<tr>
<td>SNPllex™ Genotyping System 48-plex Quick Reference Card</td>
<td>4340855</td>
</tr>
<tr>
<td>SNPllex™ Genotyping System 48-plex General Automation Getting Started Guide</td>
<td>4363143</td>
</tr>
<tr>
<td>SNPllex™ System Array Conditioning Kit</td>
<td>4352018</td>
</tr>
<tr>
<td>SNPllex™ System Control Pool, 48-plex</td>
<td>4362635</td>
</tr>
<tr>
<td>SNPllex™ System Dried gDNA Plates</td>
<td>4362637</td>
</tr>
<tr>
<td>DS-40 Spectral Calibration Standard Kit (Dye Set S)</td>
<td>4349365</td>
</tr>
<tr>
<td>SNPllex™ System Control Pool Kit</td>
<td>4362639</td>
</tr>
<tr>
<td>• Control Pool, 48-plex SNPllex™ System</td>
<td></td>
</tr>
<tr>
<td>• SNPllex™ Genotyping Dried gDNA Plate Control Pool System CD</td>
<td></td>
</tr>
<tr>
<td>SNPllex™ System Dried gDNA Plates Kit</td>
<td>4366135</td>
</tr>
<tr>
<td>• Dried gDNA Plate SNPllex™ System</td>
<td></td>
</tr>
<tr>
<td>• SNPllex™ Genotyping Dried gDNA Plate Control Pool System CD</td>
<td></td>
</tr>
<tr>
<td>SNPllex™ System Hybridization Plates, 384-well (5 plates)</td>
<td>4349369</td>
</tr>
<tr>
<td>SNPllex™ System Hybridization Plates, 96-well (5 plates)</td>
<td>4357279</td>
</tr>
<tr>
<td>SNPllex™ System Hybridization Plates, 96-well (10 plates)</td>
<td>4362933</td>
</tr>
<tr>
<td>SNPllex™ System Ligation Probes</td>
<td>4346978</td>
</tr>
</tbody>
</table>

a. Each SNPllex System kit provides sufficient reagent to perform 5,000 reactions. A smaller System Core Kit is available for performing 1,500 reactions. If all the reagents in a kit are not consumed in a single use, Applied Biosystems recommends dividing the reagents in to aliquots to minimize repeated freeze-thaw cycles.

b. Sufficient for 5,000 reactions (Applied Biosystems 3730xl, 3130xl DNA Analyzer) or 2,500 reactions (Applied Biosystems 3730 DNA Analyzer).
Required Non-Kit Materials

Equipment and Consumables

This is a list of all of the required materials not provided in the kits.

Table 1-2 Required equipment and consumables

<table>
<thead>
<tr>
<th>Item</th>
<th>Vendor</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied Biosystems 3730/3730xl DNA Analyzer</td>
<td>See your Applied Biosystems representative for information.</td>
<td></td>
</tr>
<tr>
<td>POP-7™ polymer, 28-mL bottle</td>
<td>Applied Biosystems</td>
<td>4363929</td>
</tr>
<tr>
<td>POP-7 polymer, 28-mL bottle, box of 10</td>
<td>Applied Biosystems</td>
<td>4363935</td>
</tr>
<tr>
<td>DS-40 Spectral Calibration Standard Kit (Dye Set S)</td>
<td></td>
<td>4349365</td>
</tr>
<tr>
<td>10X Running Buffer with EDTA</td>
<td></td>
<td>4335613</td>
</tr>
<tr>
<td>36-cm 48-capillary array</td>
<td></td>
<td>4331247</td>
</tr>
<tr>
<td>50-cm 48-capillary array</td>
<td></td>
<td>4331250</td>
</tr>
<tr>
<td>36-cm 96-capillary array</td>
<td></td>
<td>4331244</td>
</tr>
<tr>
<td>50-cm 96-capillary array</td>
<td></td>
<td>4331246</td>
</tr>
<tr>
<td>96-Well Plate Septa</td>
<td></td>
<td>4315933</td>
</tr>
<tr>
<td>384-Well Plate Septa</td>
<td></td>
<td>4315934</td>
</tr>
</tbody>
</table>

First-time Orders

The first time you order SN Plex System reagents, you must order
- Ligation probes
- A starter kit
- A core reagents kit
- A set of hybridization plates, either 96-well or 384-well depending on your experiment

Subsequent Orders

As you consume the reagents, you can order ligation probes, core reagents, hybridization plates, control pools, and dried gDNA plates kits as needed.

Note: You can order components of the core reagents kit individually (using the individual kit part numbers instead of the core reagent kit part number).
Table 1-2  Required equipment and consumables (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Vendor</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>96-Well Plate Base (septa sealed)</td>
<td>Applied Biosystems</td>
<td>4334873</td>
</tr>
<tr>
<td>96-Well Plate Retainer (septa sealed)</td>
<td></td>
<td>4334869</td>
</tr>
<tr>
<td>384-Well Plate Base (septa sealed)</td>
<td></td>
<td>4334874</td>
</tr>
<tr>
<td>384-Well Plate Retainer (septa sealed)</td>
<td></td>
<td>4334868</td>
</tr>
<tr>
<td>96-Well Plate Base (heat sealed)</td>
<td></td>
<td>4334875</td>
</tr>
<tr>
<td>384-Well Plate Base (heat sealed)</td>
<td></td>
<td>4334877</td>
</tr>
<tr>
<td>96- and 384-Well Plate Retainer (heat sealed)</td>
<td></td>
<td>4334865</td>
</tr>
</tbody>
</table>

Applied Biosystems 3130x/ DNA Analyzer

See your Applied Biosystems representative for information.

<table>
<thead>
<tr>
<th>Item</th>
<th>Vendor</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>POP-7 polymer, 7-mL bottle</td>
<td>Applied Biosystems</td>
<td>4352759</td>
</tr>
<tr>
<td>POP-7 polymer, 3.5-mL bottle</td>
<td></td>
<td>4363785</td>
</tr>
<tr>
<td>DS-40 Spectral Calibration Standard Kit (Dye Set S)</td>
<td></td>
<td>4349365</td>
</tr>
<tr>
<td>10X Running Buffer with EDTA</td>
<td></td>
<td>4335613</td>
</tr>
<tr>
<td>36-cm 16-capillary array</td>
<td></td>
<td>4315931</td>
</tr>
<tr>
<td>50-cm 16-capillary array</td>
<td></td>
<td>4315930</td>
</tr>
<tr>
<td>96-Well Plate Septa</td>
<td></td>
<td>4315933</td>
</tr>
<tr>
<td>384-Well Plate Septa</td>
<td></td>
<td>4315934</td>
</tr>
</tbody>
</table>

Plate Accessories

<table>
<thead>
<tr>
<th>Item</th>
<th>Vendor</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>96-Well Plate Base</td>
<td>Applied Biosystems</td>
<td>4317237</td>
</tr>
<tr>
<td>96-Well Plate Retainer</td>
<td></td>
<td>4317241</td>
</tr>
<tr>
<td>384-Well Plate Base</td>
<td></td>
<td>4317236</td>
</tr>
<tr>
<td>384-Well Plate Retainer</td>
<td></td>
<td>4317240</td>
</tr>
</tbody>
</table>

GeneAmp® PCR System 9700 Dual 384-Well Sample Block Module or GeneAmp® PCR System 9700 Dual 96-Well Sample Block Module

See your Applied Biosystems representative for information.

<table>
<thead>
<tr>
<th>Item</th>
<th>Vendor</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroAmp™ Optical 96-Well Reaction Plate</td>
<td>Applied Biosystems</td>
<td>N8010560</td>
</tr>
<tr>
<td>ABI PRISM® 384-Well Clear Optical Reaction Plate, with Barcode, 50 plates</td>
<td></td>
<td>4309849</td>
</tr>
<tr>
<td>ABI PRISM® 384-Well Optical Reaction Plate with Barcode, 500 plates</td>
<td></td>
<td>4326270</td>
</tr>
<tr>
<td>96-Well Sample Plates w/barcode</td>
<td></td>
<td>4306737</td>
</tr>
</tbody>
</table>
Table 1-2  Required equipment and consumables (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Vendor</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reaction Plate Covers&lt;sup&gt;b&lt;/sup&gt;</td>
<td>Applied Biosystems</td>
<td>N8010550</td>
</tr>
<tr>
<td>MicroAmp™ 96-Well Full Plate Cover&lt;sup&gt;c&lt;/sup&gt; (Do not use for post-PCR steps)</td>
<td></td>
<td>4312639</td>
</tr>
<tr>
<td>ABI PRISM® Optical Cover Compression Pad (requires adhesive and heat seals).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IMPORTANT! Do not use compression pads with MicroAmp™ 96-Well Full Plate Covers.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adhesive Seals&lt;sup&gt;b&lt;/sup&gt;</td>
<td>Corning</td>
<td>6569</td>
</tr>
<tr>
<td>384-Well Microplate Aluminum Sealing Tape</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adhesive PCR Foil Seal</td>
<td>ABGene</td>
<td>AB-0626</td>
</tr>
<tr>
<td>Silverseal</td>
<td>Greiner</td>
<td>676 090</td>
</tr>
<tr>
<td>Heat Seals and Sealers&lt;sup&gt;b&lt;/sup&gt;</td>
<td>ABGene</td>
<td>AB-3739</td>
</tr>
<tr>
<td>Easy-Peel 610 Meter Roll</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Easy-Peel Individual Sheets</td>
<td>AB-0745</td>
<td></td>
</tr>
<tr>
<td>Thermo-Sealer</td>
<td>AB-0384</td>
<td></td>
</tr>
<tr>
<td>Plate Sealer, ALPS 300</td>
<td>AB-0950</td>
<td></td>
</tr>
<tr>
<td>Uniseal AL</td>
<td>Whatman</td>
<td>7704-0002</td>
</tr>
<tr>
<td>GeneMapper® Software v4.0&lt;sup&gt;d&lt;/sup&gt;</td>
<td>See your Applied Biosystems representative for information.</td>
<td></td>
</tr>
<tr>
<td>Data Collection Software v2.0 or higher</td>
<td>See your Applied Biosystems representative for information.</td>
<td></td>
</tr>
</tbody>
</table>

a. Provided in the SNPlex System Starter Kit.

b. IMPORTANT! Applied Biosystems has found that certain plate covers negatively affect the performance of the SNPlex System assay. If you use covers other than the recommended plate covers, test them using the SNPlex™ System Control Set (see Appendix A).

c. Do not use MicroAmp™ 96-Well Full Plate Covers in hybridization steps. In a thermal cycler, these covers do not seal without pressure.


Reagents  Table 1-3  Required reagents

<table>
<thead>
<tr>
<th>Item</th>
<th>Vendor</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hi-Di™ Formamide</td>
<td>Applied Biosystems</td>
<td>4311320</td>
</tr>
<tr>
<td>Sterile 1X TE buffer (10 mM Tris-base, pH 8.0, and 1 mM Na₂EDTA)</td>
<td>Fluka</td>
<td>93283</td>
</tr>
<tr>
<td>0.1 N NaOH</td>
<td>Major Laboratory Supplier (MLS)</td>
<td>–</td>
</tr>
<tr>
<td>Nuclease-free water</td>
<td>Promega</td>
<td>P119C</td>
</tr>
</tbody>
</table>
Other Required Materials

Table 1-4  Other required materials

<table>
<thead>
<tr>
<th>Item</th>
<th>Vendor</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hybridization oven</td>
<td>MLS</td>
<td>—</td>
</tr>
<tr>
<td>- Capable of maintaining a constant temperature of 37 °C ±1 °C.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- With a built-in rotary shaker, or large enough and with a power source to accommodate a rotary shaker. A suitable shaker has a small throw and high rpm, for example, a 1.5 mm stroke/orbit and a maximum of 1350 rpm.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Centrifuge (equipped to accommodate reaction plates)</td>
<td>MLS</td>
<td>—</td>
</tr>
<tr>
<td>Vortex mixer</td>
<td>MLS</td>
<td>—</td>
</tr>
<tr>
<td>96-well aluminum block</td>
<td>MLS</td>
<td>—</td>
</tr>
<tr>
<td>384-well aluminum block</td>
<td>MLS</td>
<td>—</td>
</tr>
<tr>
<td>Multichannel pipettor, 200-µL</td>
<td>MLS</td>
<td>—</td>
</tr>
<tr>
<td>Pipetting reservoirs, 25-mL</td>
<td>MLS</td>
<td>—</td>
</tr>
<tr>
<td>Pipetting reservoirs, 100-mL</td>
<td>MLS</td>
<td>—</td>
</tr>
<tr>
<td>Standard heat block</td>
<td>MLS</td>
<td>—</td>
</tr>
<tr>
<td>Sterile, wide-bore pipette tips</td>
<td>VWR</td>
<td>46620-642</td>
</tr>
</tbody>
</table>
## Optional Materials

### Table 1-5 Optional reagents

<table>
<thead>
<tr>
<th>Function</th>
<th>Item</th>
<th>Vendor</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNA Purification (choose one)</td>
<td>Qiagen® Flexigene Kit</td>
<td>Qiagen</td>
<td>51206</td>
</tr>
<tr>
<td>DNA Quantitation (choose one)</td>
<td>Qiagen Puregene Kit</td>
<td>Qiagen</td>
<td>158767</td>
</tr>
<tr>
<td>DNA Quantitation (choose one)</td>
<td>TaqMan® RNase P Detection Reagents Kit</td>
<td>Applied Biosystems</td>
<td>4316831</td>
</tr>
<tr>
<td><strong>Note:</strong> The RNase P kits require one of the TaqMan® Universal PCR Master Mixes listed below.</td>
<td>or TaqMan® Universal PCR Master Mix</td>
<td>or 4304437</td>
<td>4324018</td>
</tr>
<tr>
<td></td>
<td>or TaqMan® Universal PCR Master Mix without UNG</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PicoGreen® dsDNA Quantitation Kit</td>
<td>Molecular Probes</td>
<td>P-7589</td>
<td></td>
</tr>
<tr>
<td>PicoGreen® dsDNA Quantitation Kit, special packaging</td>
<td>Molecular Probes</td>
<td>P-11496</td>
<td></td>
</tr>
<tr>
<td>PicoGreen® dsDNA Quantitation reagent</td>
<td>Molecular Probes</td>
<td>P-7581</td>
<td></td>
</tr>
<tr>
<td>PicoGreen® dsDNA Quantitation reagent, special packaging</td>
<td>Molecular Probes</td>
<td>P-11495</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 1 Introduction

Chemistry Overview

Component Kits

Several kits and reagents are required for the SNplex System Assay, as specified in “Kits and Reagents” on page 1-7. These kits and reagents include the associated enzymes, master mixes, and other components required to perform each step in the SNplex System Assay.

Workflow

Figure 1-3 summarizes the processes required to perform the SNplex™ System Assay. For simplicity, the figure shows the assay for a single SNP allele.

Figure 1-3  Summary of the SNplex System Assay process
Preparing and Fragmenting Genomic DNA

To prepare the genomic DNA (gDNA) samples:

- Purify the DNA sample.
- Determine the concentration of the DNA.
- Fragment, if necessary, and dilute DNA.
- Optionally, dry-down the DNA.

**IMPORTANT!** Perform procedures related to purifying, fragmenting, and determining concentration of DNA in an amplicon-free environment (see “Laboratory Design: Precautions for Preventing Amplicon Contamination” on page 1-30).

**About Purification**

Because most laboratories have their own methods for purifying samples, Applied Biosystems offers only guidelines rather than a specific procedure for purifying genomic DNA (gDNA). gDNA purified for SNP analysis should have:

- A concentration of DNA between 50 to 200 ng/µL
- A length of ≥12 kb before boiling
- A low level of protein contamination
- Low levels of PCR-inhibiting substances such as guanidine hydrochloride, heme, isopropanol, and ethanol

**Kits for Purifying Genomic DNA**

Applied Biosystems suggests the following kits for purifying genomic DNA from blood for the SNPlex System assay:

- Qiagen Flexigene Kit (PN 51206)
- Qiagen Puregene Kit (PN 158767)

**Whole Genome Amplification**

Consider using whole genome amplification (WGA) if you encounter problems arising from insufficient quantities of gDNA. When using WGA, consider the

- **Quality of gDNA** – Use only high-quality gDNA for WGA.
- **Input quantity of gDNA** – Use 30 to 50 ng of gDNA to avoid allelic imbalance and under-representation.
  - If the gDNA is degraded (low quality), consider using higher input concentrations.
  - Double the concentration of amplified DNA during the ligation step.

**About Fragmentation**

For certain assays, fragmentation by boiling may increase signal and give better overall performance. For some assays, this step may not improve assay performance and over-fragmentation will decrease signal of all assays. Before fragmenting DNA, verify that all samples have comparable quality. Fragmenting degraded samples leads to over-fragmented DNA, which in turn leads to poorly-clustered genotypes. To check the quality of DNA samples and avoid over fragmentation, run an aliquot of each sample on a 0.8% agarose gel (see Figure 1-4 on page 1-16) before and after fragmentation.
If necessary a subset of samples can be run on a gel.

**IMPORTANT!** All samples in the subset must be from the same extraction, have been stored the same and are of the same age. If the subset produces variable results on the gel, run the entire sample set on a gel.

Before fragmentation, high-quality DNA appears as a solid, high-molecular-weight (>12 kb) band. Degraded DNA appears as a smear. If DNA is already degraded before fragmentation, omit the heat-fragmentation step.

![High molecular weight gDNA, before heat fragmentation (A), and after 5 minutes fragmentation in 1× TE, pH 8.0 at 99 °C (B)](image)

After fragmentation, good quality samples yield a smear in the 2 to 7 kb range. DNA that yields a smear <1 kb is over fragmented and may fail with SNPlex System genotyping.

To produce the most consistent results for SNPlex System genotyping, fragment the DNA using heat-mediated fragmentation: 2 to 5 minutes at 99 °C for samples with a concentration of 50-200 ng/μL and volume of 12.5 to 150 μL in water or 1X TE.

Concentration and volume affects the efficiency of the fragmentation. When fragmenting samples of similar starting quality, use the same concentration and volume for all samples in the process. Optimal fragmentation time for samples with the same starting quality, but different concentrations and volumes, will be different. For example, optimum time for 12.5 μL of gDNA at 50 ng/μL will be much less compared to the time needed to fragment 150 μL of gDNA at 200 ng/μL.
**About Quantification**

Applied Biosystems recommends quantifying the concentration of human gDNA using the TaqMan® RNase P DNA Quantification Kit, which provides both quantitative and qualitative assessment of DNA. Fluorescence- or absorbance-based assays, such as the PicoGreen® assay, are more sensitive to the DNA preparation process and can result in “falsely” high calculations of gDNA concentration. In such cases, Applied Biosystems recommends using double the gDNA concentration during the ligation step (as recommended when quantifying the gDNA with the TaqMan® RNase P Quantification Assay).

**IMPORTANT!**

If insufficient or poor quality DNA is used, data collected can exhibit poorly-clustered genotypes and low signals. Obtaining meaningful results from insufficient or poor quality DNA can require repeated data review, troubleshooting, and reanalysis.

**IMPORTANT!** Take care when quantifying gDNA. To obtain tight genotype clusters, the amounts of the different gDNA samples used for the ligation step must be relatively equal. When possible, run an aliquot of the quantified gDNA samples on a 0.8% agarose gel to verify equal gDNA concentration.

### TaqMan RNase P Kit

Applied Biosystems recommends quantifying the concentration of human gDNA using the TaqMan® RNase P Detection Reagents Kit. This kit requires TaqMan® Universal PCR Master Mix. Using this kit for quantifying DNA is optional. The assay provides a functional evaluation of the quality of DNA.

**IMPORTANT!** If using the TaqMan® RNase P Detection Reagents Kit to quantify DNA, quantify the DNA before fragmenting it.

There are two copies of the RNase P gene per human cell. After RNase P reagents bind to the RNase P gene, the gene is amplified by PCR. During amplification, the RNase P gene probe is cleaved, generating a reporter signal. By referencing a standard curve of RNase P gene concentration in human gDNA, you can interpolate your starting concentration of gDNA.

For non-human species, select an appropriate single-copy gene for TaqMan assay design.

---

Table 1-6  Recommended concentrations of each human DNA type for each assay type

<table>
<thead>
<tr>
<th>DNA Type</th>
<th><strong>RNase P</strong></th>
<th>fluorescent or absorbance</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>gDNA fragment solution</td>
<td>Ligation</td>
</tr>
<tr>
<td>Genomic DNA (gDNA)</td>
<td>18.5 ng/µL</td>
<td>2.0 µL of 18.5 ng/µL</td>
</tr>
<tr>
<td>High-quality Whole Genome Amplified (wGA)</td>
<td>18.5 ng/µL</td>
<td>2.0 µL of 18.5 ng/µL</td>
</tr>
<tr>
<td>Low-quality Whole Genome Amplified (wGA)</td>
<td>37 ng/µL</td>
<td>2.0 µL of 37 ng/µL</td>
</tr>
</tbody>
</table>
PicoGreen Kits

IMPORTANT! If you use PicoGreen Kits to quantify DNA, quantify the DNA before fragmenting it.

The PicoGreen® dsDNA Quantitation Reagents and Kits from Molecular Probes are also available for double-stranded DNA quantitation.

Note that fluorescence-based assays are more sensitive to the quality of the gDNA preparation, and consequently poor DNA quality can lead to falsely high values for gDNA concentration. To achieve tight genotype clusters with the SNPllex System assay, double the quantity of input gDNA.

<table>
<thead>
<tr>
<th>Item</th>
<th>Molecular Probes Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>PicoGreen® dsDNA Quantitation Kit</td>
<td>P-7589</td>
</tr>
<tr>
<td>PicoGreen® dsDNA Quantitation Kit, special packaging</td>
<td>P-11496</td>
</tr>
<tr>
<td>PicoGreen® dsDNA Quantitation reagent</td>
<td>P-7581</td>
</tr>
<tr>
<td>PicoGreen® dsDNA Quantitation reagent, special packaging</td>
<td>P-11495</td>
</tr>
</tbody>
</table>
Phosphorylating and Ligating Probes to gDNA (OLA)

**Protocol Summary**  
The SNPlex™ System Oligonucleotide Ligation Kit allows you to perform several reactions of the SNPlex System assay workflow simultaneously (see “Phosphorylating and Ligating Probes to gDNA (OLA)” on page 3-12).

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| Prepare the pooled SNPlex System ligation probe pool. | Thaw a multiplexed set of SNPlex System ligation probes specific for up to 48 SNPs.  
Three probes are used to interrogate each SNP:  
- Two of the probes are allele-specific oligos (ASOs). These are designed specifically for the polymorphism by having the discriminating nucleotide on the 3’ end. Each ASO probe sequence also contains a unique ZipCode™ sequence for ZipChute™ probe binding.  
- The third probe is a locus-specific oligo (LSO). Its sequence is common to both alleles of a given locus and anneals adjacent to the SNP site on its target DNA. The LSO probe contains a partial binding site for a universal reverse primer.  
In a 48-plex reaction, there are 96 ASOs and 48 LSOs, for a total of 144 SNP-specific oligos. |
| Prepare the universal linkers. | Thaw the universal linkers. (The same pool of linkers is compatible with all ligation probe pools.)  
Three linkers are used for each SNP:  
- Two of the linkers anneal to the two ASOs. These linkers contain  
  - A PCR primer sequence corresponding to the universal forward primer (UA sequence)  
  - A partial cZipCode sequence  
- The third linker anneals to the LSO and has a universal sequence that is compatible with all LSOs. The sequence includes a partial binding site for a universal reverse primer.  
In a 48-plex reaction, there are 96 ASO linkers and a single LSO linker (which anneals to all LSOs, regardless of sequence), for a total of 97 linkers. |
| Prepare the OLA reaction mix. | Thaw the OLA master mix and dATP and combine them with the SNPlex System ligation probes and universal linkers. |
Assemble the OLA reaction.

Dispense the OLA reaction mix (containing OLA Master Mix, dATP, ligation probes, and universal linkers) into the wells of a reaction plate that contains either dried gDNA or wet gDNA.

Reserve the appropriate number of wells, as indicated in the following table. Refer to pages 3-3 to 3-7 for recommended plate layouts.

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Plate Type</th>
<th>NTC</th>
<th>Ctrl DNA</th>
<th>Allelic Ladder</th>
<th>Total # Controls</th>
<th>Total # Samples</th>
</tr>
</thead>
<tbody>
<tr>
<td>3730x/ (96-capillary)</td>
<td>96-Well</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>4</td>
<td>92</td>
</tr>
<tr>
<td></td>
<td>384-Well</td>
<td>4</td>
<td>4</td>
<td>8</td>
<td>16</td>
<td>92 × 4</td>
</tr>
<tr>
<td>3730 (48-capillary)</td>
<td>96-Well</td>
<td>2</td>
<td>2</td>
<td>4</td>
<td>8</td>
<td>88</td>
</tr>
<tr>
<td></td>
<td>384-Well</td>
<td>8</td>
<td>8</td>
<td>16</td>
<td>32</td>
<td>88 × 4</td>
</tr>
<tr>
<td>3130x/ (16-capillary)</td>
<td>96-Well</td>
<td>1</td>
<td>1</td>
<td>6</td>
<td>8</td>
<td>88</td>
</tr>
<tr>
<td></td>
<td>384-Well</td>
<td>4</td>
<td>4</td>
<td>24</td>
<td>32</td>
<td>88 × 4</td>
</tr>
</tbody>
</table>

Thermal-cycle the OLA reactions.

Under temperature-controlled conditions, enzyme phosphorylates the ASO and LSO linkers and ligation probes, the linkers anneal with their respective ligation probes, and one or both of the 96 ASO probes and one of the 48 LSO probes per locus bind to the gDNA sample.

Ligase promotes the ligation of linkers with their respective ligation probes and the ligation of ASO and LSO probes. UNG enzyme present in the OLA master mix prevents the re-amplification of dU-containing accidental carryover PCR products.
The OLA Procedure

Purifying Ligated OLA Reaction Products

Protocol Summary

The SNPllex™ System Purification Kit uses two exonucleases to digest portions of the ligated OLA reaction products, unligated and partially ligated oligonucleotides, and gDNA (see “Purifying Ligated OLA Reaction Products” on page 3-19).

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform the exonuclease digestion</td>
<td>Prepare a 2X Exonuclease mix. Add the 2X Exonuclease mix to the OLA reaction to digest the appropriate DNA sequences, including:</td>
</tr>
<tr>
<td></td>
<td>• Unligated oligonucleotides</td>
</tr>
<tr>
<td></td>
<td>• Ligated products not protected by linker spacers</td>
</tr>
<tr>
<td></td>
<td>• 5’ portion of ASO linker of correct OLA product, to permit primer annealing</td>
</tr>
<tr>
<td></td>
<td>• 3’ portion of LSO linker of correct OLA product, to permit primer annealing</td>
</tr>
<tr>
<td></td>
<td>• gDNA</td>
</tr>
<tr>
<td></td>
<td>Spacers protect a complete ligation product from exonuclease digestion.</td>
</tr>
</tbody>
</table>
The Purification Procedure

![Purification diagram]

**Legend**
- Green: Universal PCR primer sequence
- Red: Universal reverse PCR priming site
- Blue: Genome equivalent region
- Dashed: ZipCode sequence
- Thick line: Spacer

**Figure 1-6 Purification procedure**

**PCR Amplifying Ligated OLA Reaction Products**

**Protocol Summary**

The SNPlex™ System Amplification Kit allows you to amplify the purified and diluted OLA reaction products (see “Performing PCR” on page 3-21).

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prepare the PCR master mix</td>
<td>The Amplification Master Mix, SNPlex System contains buffer and enzyme. The Amplification Primers, SNPlex System contains two universal primers:</td>
</tr>
<tr>
<td></td>
<td>• The universal forward primer is unlabeled.</td>
</tr>
<tr>
<td></td>
<td>• The universal reverse primer is biotinylated.</td>
</tr>
<tr>
<td></td>
<td>Combine the Amplification Master Mix with the Amplification Primers to form the PCR master mix.</td>
</tr>
<tr>
<td>Assemble the PCR reaction</td>
<td>Dilute the exonuclease digested OLA reaction products. The products are amplified when the universal primers bind and are extended in the presence of enzyme and adequate cycling conditions.</td>
</tr>
<tr>
<td>Thermal cycle</td>
<td>The resulting product is a double-stranded amplicon with one biotinylated strand.</td>
</tr>
</tbody>
</table>
The PCR Procedure

Dilute the digested ligation product, then:

Assemble the PCR reaction

- Amplification Master Mix, SNPlex System
- Amplification Primers, SNPlex System

Thermal-cycle

- GeneAmp® PCR System 9700 Thermal Cycler

Legend

- Green: Universal PCR primer sequence
- Red: Universal reverse PCR priming site
- Blue: Genome equivalent region
- ZipCode sequence
- Universal reverse PCR primer, biotinylated
- Universal forward PCR primer

Figure 1-7  PCR amplification procedure
Hybridizing PCR Products to ZipChute Probes and Performing Electrophoresis

**Protocol Summary**

The hybridization reagents (binding buffer, wash buffer, ZipChute dilution buffer, ZipChute kit) and the SNPlex™ System Standards Kit use fluorescently-labeled ZipChute™ probes and size standards to analyze the results of the assay (see "Hybridizing PCR Products to ZipChute Probes" on page 3-23).

**Table 1-7 SNPlex protocol summary**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prepare the hybridization plates, then bind the PCR products to the hybridization plates.</td>
<td>Wash the streptavidin-coated plates and combine the Binding Buffer SNPlex System with the Positive Hybridization Control SNPlex System. Add binding buffer containing positive hybridization control to the hybridization plate, then transfer PCR reactions to the hybridization plate.</td>
</tr>
<tr>
<td>Remove non-biotinylated strand.</td>
<td>Add sodium hydroxide to separate the strands. The double-stranded amplicon becomes single stranded. The biotinylated strand remains bound to the streptavidin while the unbound strand is washed away.</td>
</tr>
<tr>
<td>Hybridize the ZipChute probes to the amplicon.</td>
<td>Prepare the hybridization master mix, then add fluorescently labeled ZipChute probes, which bind specifically to the single-stranded cZipCode™ sequence of the bound, biotinylated PCR strand.</td>
</tr>
<tr>
<td>Prepare the sample loading mix.</td>
<td>Combine Size Standard, 48-plex and Sample Loading Reagent to form the sample loading mix. To establish a sizing calibration curve that is used to identify ZipChute probes, each well contains a fluorescently labeled Size Standard, 48-plex. Eleven size-standard (orange) peaks appear in each lane of the electropherogram.</td>
</tr>
<tr>
<td>Elute the ZipChute probes.</td>
<td>Add the Sample Loading Mix to the wells and incubate the plate at 37 °C to release the ZipChute probes from the biotinylated strand.</td>
</tr>
<tr>
<td>Transfer the elution product to the sample loading plate.</td>
<td>Transfer the elution product to either a 96-well or 384-well reaction plate for use on the capillary electrophoresis instrument.</td>
</tr>
</tbody>
</table>
Dispense the Allelic Ladder, 48-plex

The allelic ladder is labeled with FAM™ and dR6G dyes. Dispense the ladder into the appropriate number of wells of the sample loading plate, as specified in the following table:

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Protocol</th>
<th># Allelic Ladder Wells</th>
</tr>
</thead>
<tbody>
<tr>
<td>3730 (48-capillary)</td>
<td>96-well</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>384-well</td>
<td>16</td>
</tr>
<tr>
<td>3730x/ (96-capillary)</td>
<td>96-well</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>384-well</td>
<td>8</td>
</tr>
<tr>
<td>3130x/ (16-capillary)</td>
<td>96-well</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>384-well</td>
<td>24</td>
</tr>
</tbody>
</table>

Load reactions onto the 3730/3730x/ or 3130x/ analyzer.

Load plates onto the 3730/3730x/ or 3130x/ analyzer to generate sample files. Conduct data analysis using GeneMapper® Analysis Software v4.0.
Hybridization and Loading

1. Wash the hybridization plates.
2. Add the PCR product to the plates.
3. Add 0.1 N NaOH to the plates.
4. Remove supernatant.
5. Wash the hybridization plates and add the ZipChute hybridization mix.
6. Wash and spin dry the hybridization plates and add the Sample Loading Reagent with Size Standard mix.
7. Transfer reactions to a sample plate and dispense the SNPlex Allelic Ladder.
8. Load reactions onto a 3730/3730xl or 3130xl instrument.
9. Perform data analysis.

Legend:
- Universal PCR primer sequence
- Universal reverse PCR primer, biotinylated
- Universal forward PCR primer
- Genome equivalent region
- ZipCode sequence
- Fluorescent dye label
- Mobility modifiers
- Hybridization Plate

Applied Biosystems 3730/3730xl/3130xl DNA Analyzer
GeneMapper® Software v4.0
## Table 1-8 Summary of storage and sensitivity

<table>
<thead>
<tr>
<th>Item</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reagents and Products</strong></td>
<td></td>
</tr>
<tr>
<td>• UNG</td>
<td>Store at -20 °C in a manual defrost freezer. For long term storage, aliquot and store at -80 °C. Avoid repeated freeze-thaw cycles.</td>
</tr>
<tr>
<td>• SNPlex™ System Matrix Standard</td>
<td>May be stable for up to one year when stored at 2 °C to 8 °C and protected from light. IMPORTANT! Do not freeze. Make fresh samples for each run. Samples can be stored 2 °C to 8 °C for up to 8 hours. Discard excess material.</td>
</tr>
<tr>
<td>• Samples on instrument</td>
<td>Samples left on the instrument before loading may degrade within 36 to 48 hours. If you cannot run samples within 32 hours, complete the SNPlex process and store the sealed plate(s), at -20 °C and protected from light. Elute the ZipChutes in the streptavidin plate and store the plate 2 °C to 8 °C and protected from light.</td>
</tr>
<tr>
<td><strong>ZipChutes in the streptavidin plate</strong></td>
<td>Elute and store the plate at 2 to 8 °C and protected from light.</td>
</tr>
<tr>
<td><strong>Bulk materials</strong></td>
<td></td>
</tr>
<tr>
<td>• OLA purification</td>
<td>Exonucleases are generally unstable at elevated temperatures. Avoid preparing a large volume for later use. If using the master mix the same day, keep the mix chilled (such as in an ice bath).</td>
</tr>
<tr>
<td>• PCR amplification</td>
<td>Store the mix at 2 to 8 °C for up to 24 hours.</td>
</tr>
<tr>
<td>• PCR product binding and ZipChute hybridization</td>
<td></td>
</tr>
<tr>
<td>• Binding buffer</td>
<td>Prepare fresh daily. Maintain at room temperature until use.</td>
</tr>
<tr>
<td>• ZipChute hybridization master mix</td>
<td>If using the master mix the same day, aliquot and store the aliquots at 2 to 8 °C and protected from light. Use each aliquot within an hour after removing from the refrigerator.</td>
</tr>
<tr>
<td>• Sample loading reagent with size standard</td>
<td>Aliquot and store the aliquots at 2 to 8 °C and protected from light. Use each aliquot within an hour after removing from the refrigerator.</td>
</tr>
</tbody>
</table>
### Oligonucleotide Ligation Kit
- Master Mix: After opening, store at 4 to 8 °C for up to one month. Vortex briefly before use.
- DATP (100X): Store at –15 to –20 °C.
- Universal Linkers: Store at –15 to –20 °C.

### Phosphorylation and Ligation Kit
- OLA Reactions: Store at –20 °C for up to 21 days.
- OLA Master Mix: Store at 4 to 8 °C for up to one month or at –20 °C for up to 1 year.
- OLA Reaction mix: Once prepared, keep the OLA Reaction Mix at room temperature for no longer than 6 hours. After 6 hours, store at 4 °C for up to 4 days. If preparing a large quantity of the OLA Reaction Mix, store it at 4 °C or at –20 °C for up to 4 days.

### Purification Kit
- SNPlex™ Lambda Exonuclease: Store at –15 to –20 °C
- SNPlex™ Exonuclease I: Store at –15 to –20 °C
- SNPlex™ Exonuclease Buffer (10X): Store at –15 to –20 °C
- 2X Exonuclease Master Mix: Prepare the 2X Exonuclease Master Mix on ice immediately before use. Avoid preparing a large volume of the 2X Exonuclease Master Mix for later use.
- OLA reaction products: To use the OLA reaction products within 21 days, store at –20 °C. Seal the plates with MicroAmp Clear Adhesive Film.

### Amplification Kit (for PCR reaction)
- SNPlex™ Amplification Master Mix: After opening, store at 4 to 8 °C. Avoid freeze-thaw cycles.
- SNPlex™ Amplification Primers: Store at –15 to –20 °C. Avoid freeze-thaw cycles.
- PCR reaction products: Store at 4 °C for up to 24 hours. Store at –20 °C for up to 35 days.
### Table 1-8  Summary of storage and sensitivity (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>SNPlex™ Hybridization Kit</strong></td>
<td></td>
</tr>
<tr>
<td>– SNPlex™ Wash Buffer</td>
<td>Store at ambient temperature.</td>
</tr>
<tr>
<td>– SNPlex™ Binding Buffer</td>
<td>Store at ambient temperature.</td>
</tr>
<tr>
<td>– SNPlex™ System ZipChute Dilution Buffer</td>
<td>Store at ambient temperature.</td>
</tr>
<tr>
<td>– SNPlex™ System ZipChute Kit components</td>
<td>Store at –15 to –20 °C. Avoid freeze-thaw cycles.</td>
</tr>
<tr>
<td>– Hybridization Master Mix</td>
<td>Once prepared, keep the Hybridization Master Mix at room temperature for no longer than 2 hours. After 2 hours, store at 4 °C and protected from light for up to 4 days. If preparing a large quantity of the Hybridization Master Mix, store it at 4 °C and protected from light for up to 4 days.</td>
</tr>
<tr>
<td>• <strong>Standards Kit</strong></td>
<td></td>
</tr>
<tr>
<td>– SNPlex™ Sample Loading Reagent</td>
<td>Store at –15 to –20 °C.</td>
</tr>
<tr>
<td>– Sample loading mix</td>
<td>Prepare fresh daily.</td>
</tr>
</tbody>
</table>
Laboratory Design: Precautions for Preventing Amplicon Contamination

Product Design

Preventing amplicon contamination from previous PCR runs is especially important in protocols that use universal primers for all amplifications.

To help prevent amplicon contamination, the SNPlex System kits are designed to be used in a linear workflow: dedicated components used in each step of the assay are not reintroduced in subsequent steps of the workflow.

In addition, the OLA master mix contains uracil-N-glycosylase (UNG). UNG acts on single- and double-stranded dU-containing DNA to cause the release of uracil, creating an alkali-sensitive apyrimidic site in the DNA. UNG has no activity on RNA or dT-containing DNA.

Two Laboratory Areas

In order to minimize the risk of downstream PCR products contaminating upstream OLA reactions, SNPlex System experiments should be conducted in two separate laboratories: OLA and PCR.

OLA Laboratory

In this laboratory, you perform OLA, purify OLA products, and assemble the PCR reactions. You may prepare gDNA samples in the OLA laboratory, or in a separate amplicon-free area.

Observe the following precautions:

- Limit access to the OLA lab. As much as possible, a person who enters the PCR lab should not enter the OLA lab for the rest of the day.
- Wear safety goggles, lab coats, gloves, and hair covers that are dedicated to the OLA lab.
- Use a thermal cycler in the OLA lab that has been designated for OLA only.
- Store the following kits and associated materials (for example, microtiter plates and pipette tips) in the OLA lab:
  - SNPlex System Oligonucleotide Ligation Kit (48-plex)
  - SNPlex System Purification Kit (48-plex)
  - SNPlex System Amplification Kit (48-plex)
  - SNPlex System Assay Control Kit
  - SNPlex System Ligation Probes
  - SNPlex System Control Pool, 48-plex
  - SNPlex System Dried gDNA Plates Kit
- Place a sticky mat at the entrance of the OLA lab.
**PCR Laboratory**

In this laboratory, you thermal cycle the PCR reactions, then proceed with the remaining steps in the SNPlex System assay. You may perform the run on the 3730/3730xl or 3130xl analyzers in this laboratory, or in a separate data collection area.

**IMPORTANT!** Never move equipment, containers, or other items from the PCR Laboratory or data collection area into the OLA laboratory.

Observe the following precautions:

- Wear safety goggles, lab coats, gloves, and hair covers that are dedicated to the PCR lab.
- Use a thermal cycler in the PCR lab that has been designated for PCR amplification only.
- Store the following kits and associated materials (for example, microtiter plates and pipette tips) in the PCR lab:
  - Hybridization Binding Buffer SNPlex System
  - Hybridization Wash Buffer (10X) SNPlex System
  - ZipChute Dilution Buffer SNPlex System
  - SNPlex System ZipChute Kit, 48-plex
  - SNPlex System Standards Kit, 48-plex
  - SNPlex System Hybridization Plates (384-well or 96-well)
  - SNPlex System Matrix Standard DS-40, Dye Set S*
  - SNPlex System Array Conditioning Kit

**Additional Precautions**

- Use filter-tips for all pipetting steps.
- Routinely decontaminate robotic equipment. Refer to the manufacturer’s directions for a procedure.
- Routinely decontaminate thermal cyclers. Refer to the manufacturer’s directions for a procedure.
- Routinely decontaminate laboratory work surfaces.

---

1. If performing the electrophoresis runs in the PCR laboratory.
SNPlex System
Assay Workflow

Figure 1-8 summarizes the procedures that you should carry out in each lab.

Figure 1-8 Division of procedures between OLA and PCR labs
Setting Up Applied Biosystems 3730/3730xl and 3130xl DNA Analyzers for SNPlex System Experiments

This chapter covers:

Overview ................................................................. 2-2
Importing SNPlex System Files into the Data Collection Software ........ 2-3
Preconditioning the Capillary Array .................................. 2-6
Performing Spatial and Spectral Calibrations ....................... 2-7
Validating Instrument Performance .................................. 2-11
Overview

Setting up the Applied Biosystems 3730/3730xl or 3130xl DNA Analyzers for use with the SNPlex™ Genotyping System involves:

- Importing SNPlex™ System modules into the Data Collection software as needed
- Preconditioning the capillary array
- Performing spatial and spectral calibrations
- Validating instrument performance


Supported Configuration

The SNPlex Genotyping System is optimized for use with:

- A 3730/3730xl or 3130xl analyzer
- Data Collection software v2.0 or higher
- POP-7™ Performance Optimized Polymer
- A 36-cm capillary array
- 50-cm capillary array (with Data Collection software v.3.0 or higher)
- GeneMapper® Software v4.0 or higher

Required Materials

<table>
<thead>
<tr>
<th>Description</th>
<th>Vendor</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>POP-7™ Performance Optimized Polymer</td>
<td>Applied Biosystems</td>
<td>4335615</td>
</tr>
<tr>
<td>SNPlex™ System Array Conditioning Kit</td>
<td>Applied Biosystems</td>
<td>4352018</td>
</tr>
<tr>
<td>DS-40 Spectral Calibration Standard Kit (Dye Set S)</td>
<td>Applied Biosystems</td>
<td>4349365</td>
</tr>
<tr>
<td>10X Running Buffer with EDTA</td>
<td>Applied Biosystems</td>
<td>4335613</td>
</tr>
<tr>
<td>36-cm 48-capillary array (3730 analyzer)</td>
<td>Applied Biosystems</td>
<td>4331247</td>
</tr>
<tr>
<td>36-cm 96-capillary array (3730xl analyzer)</td>
<td>Applied Biosystems</td>
<td>4331244</td>
</tr>
<tr>
<td>50-cm 48-capillary array (3730 analyzer)</td>
<td>Applied Biosystems</td>
<td>4331250</td>
</tr>
<tr>
<td>50-cm 96-capillary array (3730xl analyzer)</td>
<td>Applied Biosystems</td>
<td>4331246</td>
</tr>
<tr>
<td>50-cm 16-capillary array (3130xl analyzer)</td>
<td>Applied Biosystems</td>
<td>4315930</td>
</tr>
<tr>
<td>36-cm 16-capillary array (3130xl analyzer)</td>
<td>Applied Biosystems</td>
<td>4315931</td>
</tr>
<tr>
<td>Hi-Di™ Formamide</td>
<td>Applied Biosystems</td>
<td>4311320</td>
</tr>
<tr>
<td>SNPlex™ System Assay Standards Kit</td>
<td>Applied Biosystems</td>
<td>4349351</td>
</tr>
<tr>
<td>MicroAmp™ Optical 96-Well Reaction Plate</td>
<td>Applied Biosystems</td>
<td>N8010560</td>
</tr>
</tbody>
</table>
Importing SNPlex System Files into the Data Collection Software

Depending on which instrument and Data Collection software version you are using, you must import certain files before you can collect SNPlex System data. Refer to Table 2-2 for the requirements specific to your configuration.

Table 2-2  Files required by instrument configuration

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Data Collection Software Version</th>
<th>Files to Import</th>
<th>File Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>3730/3730xl</td>
<td>2.0</td>
<td>PrebatchModule.txt, HTSNP36_POP7PV2S.zip</td>
<td>Applied Biosystems website (see “Supported Configuration” on page 2-2) “SNPlex 3730 3730xl Data Collection v2”</td>
</tr>
<tr>
<td>3730/3730xl</td>
<td>3.0</td>
<td>No import required</td>
<td>—</td>
</tr>
<tr>
<td>3130xl</td>
<td>3.0</td>
<td>HTSNP36_POP7_V3, HTSNP50_POP7S.zip</td>
<td>Applied Biosystems website (see “Supported Configuration” on page 2-2) “SNPlex 3130xl Data Collection v3”</td>
</tr>
</tbody>
</table>

The files for the 3730/3730xl and 3130xl instruments are similarly named, but are not interchangeable. The files for each platform are found on a unique folder on the web for each platform.

To replace PrebatchModule.txt
(3730/3730xl instrument and Data Collection software v.2.0 only):

1. On the computer running the Data Collection software, navigate to E:\AppliedBiosystems\UDC\DataCollection\SupportFiles\ga3730\ServiceModules.

2. Rename the existing PrebatchModule.txt file. For example, OriginalPrebatchModule.txt.

3. Copy the PrebatchModule.txt file from the Data Collection Files folder on the SNPlex web folder.

4. Verify that the first line of the file reads //SNPlex v2.0 prebatch.

5. Paste the file into the ServiceModules folder.
### Importing the HTSNP36_POP7_V2 Module

To import the HTSNP36_POP7_V2 module *(3730/3730xl instrument and Data Collection software v.2.0 only):*

1. Determine if the module is installed on your computer.
   - a. Start the Data Collection software.
   - b. Open the Module Manager window.
   - c. Check the list of modules.

2. If the module is not installed, copy the HTSNP36_POP7_V2.xml file from the Data Collection Files folder (see Table 2-2 on page 2-3).

3. Paste the file into the following directory:
   
   E:\AppliedBiosystems\UCD\DataCollection\SupportFiles\ga3730\RunModules

4. In E:\AppliedBiosystems\UCD\DataCollection\bin, double-click the Import3730RunModules.exe file.

5. Verify that the module has been installed by opening the Module Manager window and observing that HTSNP36_POP7_V2_1 appears in the module list.

6. In the Module Manager, click **Edit**, then verify that the module has a 45-second prerun at 15 kV.

### Importing the HTSNP36_POP7_V3 and HTSNP50_POP7 Modules

To import the modules for the 3130xl instrument **only:**

1. Determine if the modules are installed on your computer.
   - a. Start the Data Collection software.
   - b. Open the Module Manager window.
   - c. In the list of modules, look for HTSNP36_POP7_V3 and HTSNP50_POP7.

2. If the module(s) is not listed it is not installed, and you must copy the files from the Data Collection Files folder in the SNplex folder on the web (see Table 2-2 on page 2-3).

3. Paste the files into the following location:
   
   E:\AppliedBiosystems\UCD\DataCollection\SupportFiles\ga3100\RunModules\SaphireMod

4. Navigate back to
   
   E:\AppliedBiosystems\UCD\DataCollection\bin
   
   then double-click the Import3100RunModules.exe file.

5. Verify that the modules are installed by repeating step 1 of this procedure.
### Installing Dye Set S

To install Dye Set S (3730/3730xl with Data Collection software v.2.0 or 3130xl instruments only):

1. Start the Data Collection software.
2. Open the Protocol Manager.
3. Start a new spectral calibration using Dye Set S.
   - If the protocol is not available, install it as explained in step 4.
   - If the protocol is available, exit this procedure.
4. In the Protocol Manager, click **New**.
5. Click the folder icon, then navigate to the S.zip file in the Data Collection Files folder in the SNPlex folder on the web (see Table 2-2 on page 2-3).
   **Note:** Check the S.zip file for the correct instrument.
6. Click **Open**. Dye Set S should now be available.

### Creating an Instrument Protocol for SNPlex System Experiments

An instrument protocol contains all the setting necessary to run the instrument.

**To create an instrument protocol:**

1. In the Tree pane of the Data Collection Software, click **GA Instruments > ga3730 or ga3730xl or ga3130xl > Protocol Manager**.
2. In the Instrument Protocols section, click **New**. The Protocol Editor opens.
3. Complete the Protocol Editor as shown in the figure below.

   ![Protocol Editor](image)

   - **Name:** SNPlex Protocol
   - **Select:** REGULAR
   - **Run Module for DC V2.0:** HTSNP36_POP7_V2_1
   - **Run Module for DC V3.0:** HTSNP36_POP7_V3 or HTSNP50_POP7
4. Click **OK** to save the instrument protocol.
Preconditioning the Capillary Array

Before installing a new, unused capillary array for use with SNPlex System chemistry on 3730/3730xl or 3130xl analyzers—that is, before performing spectral or spatial calibrations or SNPlex System protocols—you must precondition the capillary array. Runs performed using improperly conditioned arrays have poorly resolved peaks.

**Note:** Array conditioning is not required for arrays that have accumulated more than 50 sequencing or fragment analysis runs.

**To precondition the new capillary array:**

1. Using the reagents in the SNPlex System Array Conditioning Kit, prepare a 500X dilution of Array Conditioning Buffer.
   - a. Dispense 100 mL of molecular biology-grade, deionized water into a sterile graduated cylinder.
   - b. Add 200 μL of Array Conditioning Buffer (included in the SNPlex™ System Array Conditioning Kit, PN 4352018).
   - c. Cover and invert several times to mix.
2. Rinse the plastic array header shipping cover (supplied with the new array) with deionized water.
3. Pour the diluted Array Conditioning Buffer solution into the cover, then place the array into the solution-filled cover.
4. Assemble the 20-mL syringe, Luer adaptor, and tubing supplied in the SNPlex™ System Array Conditioning Kit (PN 4352018). Slip the open end of the tubing over the capillary bundle at the detection end of the array.
5. Using the syringe, pull enough of the diluted Array Conditioning Buffer solution to fill the array.
   Ensure that the array is filled by looking at the detection cell. Capillaries filled with Array Conditioning Buffer solution appear dark. Additionally, a small volume of solution enters the attached tubing.
6. Allow the solution to incubate in the array for 30 min. Make sure that the array tips are submerged in the solution.
7. Remove the syringe assembly, then rinse the array bundle end briefly with deionized water.
8. Install the array on the 3730/3730xl or 3130xl analyzer using the Array Install wizard.
   You do not need to rinse the array interior before installing it on the instrument.
   Select the optional extra array fill at the end of the wizard.
9. Change the buffer (cup and tray), water, and waste reservoirs.
Performing Spatial and Spectral Calibrations

Performing a Spatial Calibration

Data Collection software uses images collected during spatial calibration to establish a relationship between the signal emitted by each capillary and the position where that signal falls and is detected by the CCD camera.

Perform a spatial calibration after you:

- Install a new or used capillary array
- Remove the capillary array from the detection cell block (even to adjust it)
- Move the instrument (even if the instrument was moved on a table with wheels)

To perform a spatial calibration:

1. In the Data Collection software navigation pane, select the Spatial Run Scheduler.
2. Select the appropriate module for your instrument:
   - 3730/3730xl instrument: SpatialFill_1
   - 3130xl instrument: 3130SpatialFill_1
3. Perform the spatial calibration as described in the Applied Biosystems 3730/3730xl DNA Analyzers Getting Started Guide or the Applied Biosystems 3130xl DNA Analyzer Getting Started Guide.

Performing a Spectral Calibration

The SNPllex™ Matrix Standard DS-40 (PN 4349365) is used to generate the “multicomponent matrix” required when analyzing 6FAM™, dR6G, and LIZ®-labeled DNA fragments on the Applied Biosystems DNA Analyzers. The Data Collection software for these instruments uses the multicomponent matrix to automatically analyze the differently colored fluorescent dye-labeled samples in a single capillary.

You do not need to run matrix standards with every set of sample injections. However, you do need to run the standards once in order to generate a matrix file that is then applied to samples run under similar conditions. For more information on the use of matrix standards, refer to the instrument User’s Manual.

The SNPllex™ System Matrix Standard kit consists of one tube of matrix standard, which is sufficient for a minimum of:

- 8 array runs on the 3730xl analyzer
- 16 array runs on the 3730 analyzer
- >40 array runs on the 3130xl analyzer

This standard is formulated in buffer and is stable for one year when stored at 2 °C to 8 °C. Do not freeze. Avoid exposure to light.
Preparing matrix standard for 3730/3730xl instruments

**WARNING** CHEMICAL HAZARD. Formamide. Exposure causes eye, skin, and respiratory tract irritation. It is a possible developmental and birth defect hazard. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

**To prepare the matrix standard for the 3730 or 3730xl analyzers:**

1. Thaw and thoroughly mix the contents of the tube and spin briefly in a microcentrifuge.

2. Prepare a spectral calibration sample by combining:
   - 900 µL Hi-Di™ Formamide (PN 4311320)
   - 100 µL DS-40 Spectral Calibration Standard (PN 4349365)

3. Heat the mixture at 95 °C for 5 min to denature the DNA fragments, then immediately place on ice.
   
   **Note:** Make samples fresh for each run. Samples can be stored refrigerated for up to 8 hours. Discard excess material.

4. Dispense 5 µL (384-well plates) or 10 µL (96-well plates) of the spectral calibration sample into the appropriate number of wells.
   
   - 48 wells for a 3730 analyzer
   - 96 wells for a 3730xl analyzer

   For instructions on setting up a plate for a 48-capillary array or a 96-capillary array, refer to the *Applied Biosystems 3730/3730xl DNA Analyzers User Reference Guide* (PN 4331468).

5. Centrifuge the plate to ensure that the samples are at the bottom of the wells.

6. Create a spectral instrument protocol in the Protocol Manager, as shown in the figure below.

   ![Protocol Manager](image)

   Or Spect50_MtxStd_POP7
   (Data Collection v.3.0 only)

   For details on setting up a run, refer to the *Applied Biosystems 3730 / 3730xl DNA Analyzers User Reference Guide* (PN 4331468).
To prepare the matrix standard for the 3730 or 3730xl analyzers: (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 7.   | Create a plate record for the spectral calibration as explained in the *Applied Biosystems 3730/3730xl DNA Analyzers Getting Started Guide* (PN 4331468). Briefly,  
  a. Select **Plate Manager**.  
  b. Click New, then complete the following fields:  
    – Plate ID: Enter an ID for the plate.  
    – Plate Name: Enter a name for the plate.  
    – Application: Select **Spectral Calibration**.  
    – Plate Type: Select **96-well** or **384-well**, as appropriate.  
    – Plate Seal: Select **Septa** or **Heat Seal**, as appropriate.  
    – Owner Name: Enter a name.  
    – Operator Name: Enter a name.  
  c. Click **OK**. A blank sample sheet appears.  
  d. Complete the following fields:  
    – Sample Name  
    – Instrument Protocol: Select the instrument protocol that you created in step 6 on page 2-6. |
| 8.   | Place the plate with the spectral calibration samples into the In Stack. |
| 9.   | Click **Run**.  
  For details on how to perform a spectral calibration, refer to the *Applied Biosystems 3730/3730xl DNA Analyzers Getting Started Guide* (PN 4331468). |
Preparing matrix standard for 3130x/ instruments

The SNPlex™ System Matrix Standard DS-40 (PN 4349365) consists of one tube of matrix standard, which is sufficient for approximately 50 array runs. You do not need to run matrix standards with every set of sample injections. However, you do need to run the standards once to generate a matrix file that you apply to subsequent samples run with the same dye set.

**CHEMICAL HAZARD.** Formamide. Exposure causes eye, skin, and respiratory tract irritation. It is a possible developmental and birth defect hazard. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

To perform a spectral calibration:

1. Thaw and thoroughly mix the contents of the tube and spin briefly in a microcentrifuge.

2. Prepare a spectral calibration sample by combining:
   - 180 µL Hi-Di™ Formamide (PN 4311320)
   - 20 µL DS-40 Spectral Calibration Standard

3. Vortex thoroughly, then briefly centrifuge the mixture.

4. Heat the mixture at 95 °C for 5 minutes to denature the DNA fragments, then immediately place on ice (for approximately 2 minutes).

5. Dispense 10 µL of the spectral calibration sample into rows 1 and 2 of a 96-well plate.

6. Centrifuge the plate to ensure that the samples are at the bottom of the wells.

7. Create and run the calibration plate.
   a. In the Plate Manager window, create a plate record. Select the instrument protocol you created for spectral calibration.
   b. Assemble a 96-well plate, with the spectral calibration samples, and place it into the AutoSampler.
   c. Link the plate to the plate record using Run Scheduler. All plates must be linked for the software to run. The 3130x/ Genetic Analyzer has two plate bays. Link the plate by selecting the appropriate plate record then clicking a plate bay.
   d. In the Data Collection Software window toolbar, click on the arrow to begin the run.

For more details on how to schedule a run, load and run the AutoSampler, and evaluate the calibration data, refer to the *Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide.*
Validating Instrument Performance

To assess signal intensity and resolution, you must perform a mock run using a diluted solution of the SNplex™ ZipChute™ Mix and an internal size standard.

**WARNING** CHEMICAL HAZARD. SNplex Sample Loading Reagent causes eye, skin, and respiratory tract irritation. It is a possible developmental and birth defect hazard. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

To prepare the test sample plate:

1. Dilute the ZipChute Mix by combining:
   - 2 µL ZipChute Mix, 48-plex (from the SNplex™ System ZipChute™ Kit, 48-plex)
   - 448 µL molecular-biology-grade deionized water
2. Vortex thoroughly.
3. Prepare the test sample by mixing:
   - 920 µL SNplex Sample Loading Reagent (from the SNplex System Assay Standards Kit, PN 4349351)
   - 40 µL of SNplex Size Standard (from the SNplex System Assay Standards Kit, PN 4349351)
   - 40 µL of the diluted ZipChute™ Mix
4. Vortex thoroughly.
5. Dispense 10 µL of the spectral calibration sample into the appropriate number of wells of a MicroAmp™ Optical 96-Well Reaction Plate.
   - 48 wells for a 3730 analyzer
   - 96 wells for a 3730xl analyzer
6. Complete the plate record, selecting the instrument protocol you created for SNplex System experiments (“Creating an Instrument Protocol for SNplex System Experiments” on page 2-5).
7. Start the run.
Preparing a Mock Run for the 3130xl Instrument

To assess signal intensity and resolution, perform a mock run using a diluted solution of the SN Plex ZipChute Mix and an internal size standard.

**WARNING** CHEMICAL HAZARD. Sample Loading Reagent, SN Plex System. Exposure causes eye, skin, and respiratory tract irritation. SN Plex Sample Loading Reagent is a possible developmental and birth defect hazard. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

To perform a mock run:

1. Dilute the ZipChute Mix by combining:
   - 2 µL ZipChute Mix, 48-plex (from the SN Plex™ System ZipChute™ Kit, 48-plex)
   - 448 µL molecular-biology-grade deionized water
2. Vortex thoroughly.
3. Prepare the test sample by mixing:
   - 184 µL SN Plex Sample Loading Reagent (from the SN Plex™ System Assay Standards Kit, PN 4349351)
   - 8 µL of SN Plex Size Standard (from the SN Plex™ System Assay Standards Kit, PN 4349351)
   - 8 µL of the diluted ZipChute™ Mix
4. Vortex thoroughly.
5. Dispense 10 µL of the test sample into each of 16 wells of a MicroAmp™ Optical 96-Well Reaction Plate. Use any pair of rows beginning with an odd-number row.
6. Complete the plate record by selecting the name of the instrument protocol you created for SN Plex System Experiments.
7. Start the run.
Evaluating the SNPlex System Run

To evaluate the SNPlex system run, review the sample data from each well of the sample plate using the History View of the Data Collection software. All 11 size-standard peaks (shown in orange) should be approximately the same height and width. Refer to the SNPlex™ Genotyping System 48-plex User Guide for more details.

Figure 2-1 shows examples of acceptable and poor resolution.

<table>
<thead>
<tr>
<th>Good Resolution</th>
<th>Poor Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Graph" /></td>
<td><img src="image2.png" alt="Graph" /></td>
</tr>
</tbody>
</table>

Figure 2-1  Example of acceptable and poor resolution
This chapter covers:

Overview ................................................................. 3-2
Designing the Sample Plate Layout ......................... 3-3
Preparing Genomic DNA ........................................... 3-8
Phosphorylating and Ligating Probes to gDNA (OLA) .......... 3-12
Purifying Ligated OLA Reaction Products .................. 3-19
Performing PCR ...................................................... 3-21
Hybridizing PCR Products to ZipChute Probes ............ 3-23
Eluting ZipChute Probes ........................................... 3-27
Preparing Samples for Electrophoresis ...................... 3-29
Creating Results Groups and Plate Records ............... 3-31
Loading and Running the Sample Plates .................... 3-40
Overview

This chapter provides all the protocols necessary to manually perform SNplex® System experiments using 96- or 384-well plates on the Applied Biosystems 3730/3730xl or 3130xl DNA Analyzers. All volumes are for single reactions and need to be scaled-up appropriately.

The SNplex™ Genotyping System 48-plex General Automation Getting Started Guide provides modified protocols for automating the SNplex System assay using robotics.

Figure 3-1 illustrates the workflow for SNplex System experiments.

Figure 3-1  SNplex System experiment workflow
Before You Begin

At this point, you should already have ordered your SNPllex System probe pools. If you have not done so, refer to the SNPllex™ Genotyping System Assay Ordering Guide for information about designing and ordering SNPllex System probe pools.

Designing the Sample Plate Layout

Purpose

To analyze SNPllex System data, GeneMapper® software requires that each run:

- Includes at least one allelic ladder sample, which allows GeneMapper software to perform sizing bin adjustments on a per-run basis, greatly reducing binning errors.
- Has a unique run folder set up in the Data Collection software. All samples from a run must be saved in a unique run folder.

Coordinating the layout of your sample plates with the structure and naming of Data Collection software run folders allows the software to organize SNPllex System data into folders grouped by probe pool and run.

IMPORTANT! Combining sample plate layout with the proper run folder naming convention (explained in “Setting Up Results Groups” on page 3-32) allows the Data Collection software to organize data into folders grouped by probe pool and instrument run. This organization is the required data structure for GeneMapper software to perform clustering analysis. Applied Biosystems recommends running one probe pool per injection to simplify data analysis.

This section describes recommended plate layouts. Refer to “Setting Up Results Groups” on page 3-32 for information on setting up results groups for SNPllex System experiments.

Assumptions

The following illustrations provide examples of sample layouts for 384-well and 96-well plates. The setups assume that there are four probe pools per 384-well plate and one probe pool per 96-well plate. The number of gDNA samples, controls, NTCs, and allelic ladders differs between 96-capillary, 48-capillary, and 16-capillary instruments.

3730x/ Instrument (96-capillary), 96-wells

An instrument running a 96-capillary array injects once, picking up contents from each of the 96-wells of the plate and performing a single run.

1 to 92 = gDNA samples  C = Control DNA
N = NTC  L = Allelic Ladder
### 3730xl Instrument (96-capillary), 384-wells

An instrument running a 96-capillary array injects once from each of the four quadrants of a 384-well plate, performing four separate runs.

![Diagram of 96-capillary array injections](image)

**Yellow** = Probe Set A, Quadrant 1  
**Blue** = Probe Set C, Quadrant 3  
**Green** = Probe Set B, Quadrant 2  
**Orange** = Probe Set D, Quadrant 4

1 to 92 = gDNA samples  
C = Control DNA  
N = NTC  
L = Allelic Ladder

### 3730 Instrument (48-capillary), 96-wells

An instrument running a 48-capillary array injects twice from a 96-well plate, picking up contents from half of the wells (48 wells per injection) and performing two separate runs.

![Diagram of 48-capillary array injections](image)

1 to 88 = gDNA samples  
C = Control DNA  
N = NTC  
L = Allelic Ladder
3730 Instrument (48-capillary), 384-wells

An instrument running a 48-capillary array injects twice from each of the quadrants of a 384-well plate, performing eight separate runs.

Designing the Sample Plate Layout

<table>
<thead>
<tr>
<th>Injection 1</th>
<th>Injection 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>A</td>
<td>B</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Injection 2</th>
<th>Injection 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>A</td>
<td>B</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Injection 3</th>
<th>Injection 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>A</td>
<td>B</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Injection 4</th>
<th>Injection 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>A</td>
<td>B</td>
</tr>
</tbody>
</table>

Legend:
- **Yellow** = Probe Set A, Quadrant 1
- **Green** = Probe Set B, Quadrant 2
- **Blue** = Probe Set C, Quadrant 3
- **Orange** = Probe Set D, Quadrant 4
- **C** = Control DNA
- **N** = NTC
- **L** = Allelic Ladder

1 to 88 = gDNA samples

---

SNPlex™ Genotyping System 48-plex User Guide

---

3-5
The 3130xl instrument injects six times, picking up the contents from 16 wells per injection, in order to electrophorese the contents from each well on a 96-well plate.

### Injection 1

<table>
<thead>
<tr>
<th>Well</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Injection 2

<table>
<thead>
<tr>
<th>Well</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Injection 3

<table>
<thead>
<tr>
<th>Well</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Injection 4

<table>
<thead>
<tr>
<th>Well</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Injection 5

<table>
<thead>
<tr>
<th>Well</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Injection 6

<table>
<thead>
<tr>
<th>Well</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1 to 88 = gDNA samples
C = control DNA
N = NTC
L = Allelic Ladder
The 3130xl instrument injects 24 times (5 are shown), picking up the contents from 16 wells per injection, in order to electrophorese the contents from each well on a 384-well plate.

Note that a No Template Control (NTC) is not required in every run; however, it is helpful to include one in each probe pool. Therefore, if a 384-well plate had four SNPlex pools, the injection pattern would consist of 24 separate runs with 20 runs containing 1 allelic ladder and 15 samples and 4 runs containing 1 allelic ladder, 1 NTC, and 14 samples.
Preparing Genomic DNA

Guidelines for DNA Concentrations and Quantity

For information about DNA quantification, refer to “About Quantification” on page 1-17. See Table 3-1 for recommended DNA concentrations.

Table 3-1 Recommended concentrations of each human DNA type for each assay type

<table>
<thead>
<tr>
<th>DNA Type</th>
<th>RNase P</th>
<th>Fluorescence or Absorbance</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>gDNA fragment solution</td>
<td>Ligation</td>
</tr>
<tr>
<td>Genomic DNA (gDNA)</td>
<td>18.5 ng/µL</td>
<td>2.0 µL of 18.5 ng/µL</td>
</tr>
<tr>
<td>High-quality Whole Genome Amplified (wGA)</td>
<td>18.5 ng/µL</td>
<td>2.0 µL of 18.5 ng/µL</td>
</tr>
<tr>
<td>Low-quality Whole Genome Amplified (wGA)</td>
<td>37 ng/µL</td>
<td>2.0 µL of 37 ng/µL</td>
</tr>
</tbody>
</table>

**IMPORTANT!** If insufficient or poor quality DNA is used, data collected can exhibit poorly-clustered genotypes and low signals. Obtaining meaningful results from insufficient or poor quality DNA can require repeated data review, troubleshooting, and reanalysis.

**IMPORTANT!** Perform all gDNA fragmentation procedures in an amplicon-free environment. Review “Preparing and Fragmenting Genomic DNA” on page 1-15 for important information about this process.

Fragmentation may improve genotyping of some regions of the genome. However, excessive fragmentation will reduce signal. Heat fragmentation should be omitted if less than the recommended amount of DNA will be used. Regardless of DNA quantity and quality, the operator may choose to omit fragmentation, dilute the gDNA to 18.5 ng/µL with 1× TE buffer, pH 8.0, and proceed to the next step.

Recommendations for fragmenting gDNA are as follows:

- Fragment DNA only as needed.
- Run samples on a gel before and after fragmentation. A subset of samples may be used on the gel only if part of the same extraction and if they have been stored similarly. If the subset shows a wide variation in fragment sizes it is recommended that you analyze the entire set.
- Avoid excessive fragmentation. Samples with bands less than 10 kb generally do not require additional fragmentation. DNA less than 1 kb may fail with SNPlex™.
- Generally 5 minutes at 99 °C should be sufficient for samples ranging from 50 to 200 ng/µL in a volume of 12.5 to 150 µL per well. Both concentration and volume affect the efficiency of fragmentation. Lower concentrations and smaller volumes require less time.
- When fragmenting samples of similar quality, use the same concentration and volume for all samples being processed.
## Preparing Purified gDNA

Prepare the purified gDNA for fragmentation:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Purify your gDNA (see page 1-15 for recommended kits).</td>
</tr>
<tr>
<td>2.</td>
<td>Determine the concentration of your DNA. Refer to “About Quantification” on page 1-17.</td>
</tr>
</tbody>
</table>
| 3. | (Optional, but recommended.) Run an aliquot of each quantified DNA sample on a 0.8% agarose gel.  
   - If the sample appears as a solid, high-molecular-weight (>7 kb) band, continue with the procedure.  
   - If the sample is over fragmented, appears as a smear <1 kb, or is lacking a distinct high-molecular-weight (>7 kb) band, omit the heat-fragmentation step. |
| 4. | Using 1× TE, pH 8.0, dilute the purified DNA to a final concentration of between 50 and 200 ng/µL and a final volume between 12.5 and 150 µL.  
   **Note:** The starting concentration of DNA affects the fragment size achieved after boiling. When fragmenting samples of similar starting quality, use the same concentration and volume for all samples in the process. Concentration and volume affect the efficiency of the fragmentation. Optimal fragmentation time for samples with the same starting quality, but different concentrations and volumes, are different. For example, optimum time for 12.5 µL of gDNA at 50 ng/µL is much less than the time needed to fragment 150 µL of gDNA at 200 ng/µL. For more dilute DNA samples, you may need to concentrate the DNA or reduce the duration of heating. The duration of heating is determined empirically. |

---

a. 1× TE: 10mM TrisHCl, pH 8.0 and 1mM EDTA.  
b. Heat fragmentation is equally effective when you dilute purified DNA in nuclease-free water, 0.5× TE pH8.0, 2× TE pH8.0, 1× TE pH 7.5, 1× TE pH 7.0, Gentra’s PureGene® DNA Hydration Solution, or Qiagen’s FlexiGene Hydration Buffer.
Fragmenting the gDNA

To fragment the gDNA:

1. Program the thermal cycler as follows to achieve fragmentation in the 2 to 7 kb range:

<table>
<thead>
<tr>
<th>Step</th>
<th>Step Type</th>
<th>Temperature (°C)</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Hold</td>
<td>4</td>
<td>1 min</td>
</tr>
<tr>
<td>2</td>
<td>Hold</td>
<td>99</td>
<td>0 - 10 min</td>
</tr>
<tr>
<td>3</td>
<td>Hold</td>
<td>4</td>
<td>∞</td>
</tr>
</tbody>
</table>

2. Chill a 96-well aluminum block on ice, then place a compatible reaction plate onto it.

3. Dispense up to 12.5 to 50 µL/well of the prepared gDNA onto the chilled reaction plate.

4. Cover the reaction plate.

5. Run the program to boil the gDNA:
   a. Start the thermal cycler.
   b. Pause the program after the thermal cycler block reaches 4 °C.
   c. Insert the chilled reaction plate containing the prepared gDNA.
   d. Resume the program.

6. After the program is complete, remove the reaction plate and place it on the chilled aluminum block.

7. If the same sample was divided into multiple wells, pool the boiled gDNA.

8. Dilute the gDNA to 18.5 ng/µL with 1X TE, pH 8.0.

   **Note:** If using whole genome amplification (WGA), Applied Biosystems recommends using double the gDNA concentration (see Table 3-1 on page 3-8).

---

Drying Down gDNA

The SNPlex System assay is equally effective on dried-down or wet gDNA. However, if the experiment requires multiple plates using the same gDNA or the same gDNA is used in several experiments, you can dry-down the gDNA in the plates, which are then ready for use at any time.
### Dispensing gDNA into Reaction Plates

To dispense gDNA into reaction plates:

1. **Label the reaction plate.**

2. **Into each of the control DNA wells, add**
   - 1.26 µL 1X TE buffer, pH 8.0
   - 0.74 µL Control DNA (≈37 ng) (from the SNPlex System Assay Control Kit, PN 4349363)

   **Note:** Control DNA is already fragmented when shipped.

3. **Into each of the NTC wells, add 2 µL of 1X TE buffer, pH 8.0.**

   **Note:** Leave the L wells for the allelic ladder empty. For information on setting up the allelic ladder wells, refer to “Preparing Samples for Electrophoresis” on page 3-29.

---

**C = Control DNA, NTC = No Template Control, L = Allelic Ladder**

For information about proper sample plate layout, refer to “Designing the Sample Plate Layout” on page 3-3.
To dispense gDNA into reaction plates:

4. Dispense 2 μL of the fragmented gDNA, from step 8 on page 3-10, into the remaining wells of the plate, then briefly centrifuge the plate to ensure that the contents are collected at the bottom of the wells.

5. Allow the plate to air dry for three days in a dark, amplicon-free location. Cover the plate with a lint-free tissue while air-drying.

6. Verify that all the liquid has evaporated.

7. Seal the plates and store at room temperature in the dark until use.

**Phosphorylating and Ligating Probes to gDNA (OLA)**

For a summary of the steps in the OLA procedure, refer to “Phosphorylating and Ligating Probes to gDNA (OLA)” on page 1-19.

**Oligonucleotide Ligation Kit Components**

The components in the SNPlex System™ Oligonucleotide Ligation Kit (PN 4362268) are listed below. The kit contains enough reagent for 5,000 reactions.

<table>
<thead>
<tr>
<th>Component</th>
<th>Storage Temperature ( °C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oligonucleotide Ligation Master Mix, SNPlex System*</td>
<td>4 to 8</td>
</tr>
<tr>
<td>dATP (100X), SNPlex System</td>
<td>−15 to −25</td>
</tr>
<tr>
<td>Universal Linkers, 48-plex SNPlex System</td>
<td></td>
</tr>
</tbody>
</table>

a. The Oligonucleotide Ligation Master Mix is shipped frozen. After first use, store at 4 to 8 °C for up to 1 month. Vortex briefly prior to use.

**About SNPlex System Ligation Probes**

The SNPlex System Ligation Probe Pools that you order arrive in individually labeled tubes. Each tube contains a pool of the following three probe types, mixed together:

- Allele-specific oligo A1 (ASO\textsubscript{A1})
- Allele-specific oligo A2 (ASO\textsubscript{A2})
- Locus-specific oligo (LSO)

The universal linkers are delivered in a separate tube.
To prepare the OLA reactions:

1. Thaw the following reagents at room temperature:
   - Universal Linkers, 48-plex SNplex System
   - dATP (100X), SNplex System
   - SNplex System Ligation Probes

2. Thaw the OLA Master Mix at 4 to 8 °C, then invert several times to mix.
   If a precipitate forms with the OLA Master Mix, place the tube briefly in a
   heating block set to 37 °C.
   **Note:** You can store the OLA Master Mix at 4 to 8 °C for up to one month or
   frozen at –20 °C for up to 1 year. If kept frozen, minimize freeze-thaw
   cycles.

3. Vortex, then quick-spin the tubes.

4. Prepare an OLA reaction mix by scaling the volumes indicated below to the
   desired number of OLA reactions.
   You can set up the reactions at room temperature.
   **IMPORTANT!** Prepare extra volume to account for losses that may occur
   during pipetting.

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Reaction (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Dried gDNA Method</td>
</tr>
<tr>
<td>Nuclease-free water</td>
<td>2.30</td>
</tr>
<tr>
<td>Oligonucleotide Ligation Master Mix SNplex System</td>
<td>2.50</td>
</tr>
<tr>
<td>Universal Linkers, 48-plex</td>
<td>0.05</td>
</tr>
<tr>
<td>SNplex System Ligation Probes</td>
<td>0.10</td>
</tr>
<tr>
<td>dATP (100X), SNplex System</td>
<td>0.05</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>5.00</strong></td>
</tr>
</tbody>
</table>

   **Note:** Once prepared, you can keep the OLA reaction mix for up to 6 hours
   at room temperature before use without a loss in performance. After 6 hours,
   you may store the OLA reaction mix for up to 4 days at 4 °C for later use.
   You may also prepare a large quantity of the OLA reaction mix and store it at
   4 °C or at –20 °C for up to 4 days.

5. Depending on which procedure you have selected, assemble the OLA
   reaction as described in:
   - “Assembling the OLA Reaction: Dried-Down gDNA” on page 3-14
   - “Assembling the OLA Reaction: Wet gDNA” on page 3-16
You can set up the reactions at room temperature.

To prepare the OLA reaction when using dried-down gDNA:

1. Retrieve the reaction plates containing the fragmented, dried gDNA (see “Preparing Genomic DNA” on page 3-8).
   If the plates have not been labeled, label them as shown in the following figures.

C = Control DNA, NTC = No Template Control, L = Allelic Ladder

For information about proper sample plate layout, refer to “Designing the Sample Plate Layout” on page 3-3.
To prepare the OLA reaction when using dried-down gDNA: (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 2.   | Pipette 5.0 µL of OLA reaction mix (see step 4 on page 3-13) into each well of the plate.  
**Note:** It is not necessary to add reaction mix into the allelic ladder wells.  
For information on setting up the allelic ladder wells, refer to “Preparing Samples for Electrophoresis” on page 3-29. |
| 3.   | Cover 384-well reaction plates containing the SNPlex OLA reactions with one of the recommended plate covers (see Table 1-2 on page 1-9) and an optical cover compression pad.  
**IMPORTANT!** It is critical that you use only the recommended plate covers. Certain plate covers negatively affect the performance of the SNPlex System assay. If you must use covers other than the recommended plate covers, test them using the SNPlex™ System Control Set (see Appendix A).  
**Note:** If you are using 96-well plates, use MicroAmp™ Full Plate Covers to seal the plate. |
Assembling the OLA Reaction: Wet gDNA

You can set up the reaction at room temperature.

To prepare the OLA reaction when using wet gDNA:

1. Retrieve and label the appropriate number of reaction plates.

<table>
<thead>
<tr>
<th>96-capillary array, 96-well plate</th>
<th>96-capillary arrays, 384-well plate</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Diagram 1" /></td>
<td><img src="image2.png" alt="Diagram 2" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>48-capillary array, 96-well plate</th>
<th>48-capillary array, 384-well plate</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3.png" alt="Diagram 3" /></td>
<td><img src="image4.png" alt="Diagram 4" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>16-capillary array, 96-well plate</th>
<th>16-capillary array, 384-well plate</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.png" alt="Diagram 5" /></td>
<td><img src="image6.png" alt="Diagram 6" /></td>
</tr>
</tbody>
</table>

C = Control DNA, NTC = No Template Control, L = Allelic Ladder

For information about proper sample plate layout, refer to “Designing the Sample Plate Layout” on page 3-3.

2. Pipette 3.0 µL of OLA reaction mix (see step 4 on page 3-13) into each well of the plate.

   **Note:** It is not necessary to add reaction mix into the allelic ladder wells.

   For information on setting up the allelic ladder wells, refer to “Preparing Samples for Electrophoresis” on page 3-29.

3. • Into each sample well, add 2.0 µL of gDNA (from step 8 on page 3-10).
   • Into each control well (wells labeled C in diagrams above), add 2.0 µL of control DNA (see step 2 on page 3-11).
To prepare the OLA reaction when using wet gDNA: (continued)

4. Cover 384-well reaction plates containing the SNPllex OLA reactions with one of the recommended plate covers (see Table 1-2 on page 1-9) and an optical cover compression pad.

**IMPORTANT!** It is critical that you use an appropriate plate cover. Applied Biosystems has found that certain plate covers negatively affect the performance of the SNPllex System assay. If you use covers other than the recommended plate covers, test them using the SNPllex™ System Control Set (see Appendix A).

**Note:** If you are using 96-well plates, use MicroAmp™ Full Plate Covers to seal the plate.

5. Transfer the reaction plates to a thermal cycler.

### Running the OLA Reactions on the Thermal Cycler

### To thermal-cycle the OLA reactions:

1. If you use an Applied Biosystems 9700 thermal cycler with a dual 384- or dual 96-well plate mode, program the thermal cycler as follows. Thermal cycling conditions are the same for 384- and 96-well plates, as indicated in the following table:

<table>
<thead>
<tr>
<th>Step</th>
<th>Step Type</th>
<th>Temperature (°C)</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>HOLD</td>
<td>48</td>
<td>30 min</td>
</tr>
<tr>
<td>2</td>
<td>HOLD</td>
<td>90</td>
<td>20 min</td>
</tr>
<tr>
<td>3</td>
<td>25 Cycles</td>
<td>94</td>
<td>15 sec</td>
</tr>
<tr>
<td></td>
<td></td>
<td>60</td>
<td>30 sec</td>
</tr>
<tr>
<td></td>
<td></td>
<td>51 3% ramp&lt;sup&gt;a&lt;/sup&gt;</td>
<td>30 sec</td>
</tr>
<tr>
<td>4</td>
<td>HOLD</td>
<td>99</td>
<td>10 min</td>
</tr>
<tr>
<td>5</td>
<td>HOLD</td>
<td>4</td>
<td>∞</td>
</tr>
</tbody>
</table>

<sup>a</sup> Use a 2% ramp with standard or maximum setting for 96-well single plate modules on 9700 instruments.

**IMPORTANT!** Do not use the 9600 emulation mode on the Applied Biosystems 9700 thermal cycler. Use standard mode. The standard mode can be selected in the window appearing after pressing “Start” to run the program. This option can be set after pressing the “Run” button.
To thermal-cycle the OLA reactions: (continued)

If you use a thermal cycler other than an Applied Biosystems 9700 thermal cycler, use the following thermal-cycling parameters. Thermal cycling parameters are identical for 384- and 96-well plates.

<table>
<thead>
<tr>
<th>Step</th>
<th>Step Type</th>
<th>Temperature (°C)</th>
<th>For 9600</th>
<th>For 9800 and Veriti™a</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>HOLD</td>
<td>48</td>
<td>30 min</td>
<td>30 min</td>
</tr>
<tr>
<td>2</td>
<td>HOLD</td>
<td>90</td>
<td>20 min</td>
<td>20 min</td>
</tr>
<tr>
<td>3</td>
<td>25 Cycles</td>
<td>94</td>
<td>15 sec</td>
<td>15 sec</td>
</tr>
<tr>
<td></td>
<td></td>
<td>60</td>
<td>30 sec</td>
<td>30 sec</td>
</tr>
<tr>
<td></td>
<td></td>
<td>59</td>
<td>33 sec</td>
<td>50 sec</td>
</tr>
<tr>
<td></td>
<td></td>
<td>58</td>
<td>33 sec</td>
<td>50 sec</td>
</tr>
<tr>
<td></td>
<td></td>
<td>57</td>
<td>33 sec</td>
<td>50 sec</td>
</tr>
<tr>
<td></td>
<td></td>
<td>56</td>
<td>33 sec</td>
<td>50 sec</td>
</tr>
<tr>
<td></td>
<td></td>
<td>55</td>
<td>33 sec</td>
<td>50 sec</td>
</tr>
<tr>
<td></td>
<td></td>
<td>54</td>
<td>33 sec</td>
<td>50 sec</td>
</tr>
<tr>
<td></td>
<td></td>
<td>53</td>
<td>33 sec</td>
<td>50 sec</td>
</tr>
<tr>
<td></td>
<td></td>
<td>52</td>
<td>33 sec</td>
<td>50 sec</td>
</tr>
<tr>
<td></td>
<td></td>
<td>51</td>
<td>30 sec</td>
<td>30 sec</td>
</tr>
<tr>
<td>4</td>
<td>HOLD</td>
<td>99</td>
<td>10 min</td>
<td>10 min</td>
</tr>
<tr>
<td>5</td>
<td>HOLD</td>
<td>4</td>
<td>∞</td>
<td>∞</td>
</tr>
</tbody>
</table>

a. Use of the Veriti™ instrument requires a firmware update that increases the number of steps per cycle.

For other instruments, program a ramp from 60 to 51 °C so that the rate of cooling is approximately 50 seconds per °C after an initial hold at 60 °C for 30 seconds and a final hold of 51 °C for 30 seconds. Check to make sure that the total time for one cycle is 7 to 8 minutes.

2. When thermal-cycling is complete, remove the OLA reaction plate from the thermal cycler.

3. Briefly spin the OLA reaction plates to collect the liquid in the bottom of the wells.

4. For best results, proceed directly to exonuclease digestion of OLA products, as described in “Purifying Ligated OLA Reaction Products” on page 3-19. Alternatively, you can leave the plate at the 4 °C hold step overnight or store the OLA reactions at –20 °C for up to 21 days.
Purifying Ligated OLA Reaction Products

For a summary of the steps in the purification procedure, refer to “Purifying Ligated OLA Reaction Products” on page 1-21.

**Purification Kit Components**

The components in the SNPlex™ System Purification Kit (PN 4349357) are listed in the table below. The kit contains enough reagent for 5,000 reactions.

<table>
<thead>
<tr>
<th>Component</th>
<th>Storage Temperature (°C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lambda Exonuclease, SNPLex System</td>
<td>–15 to –25</td>
</tr>
<tr>
<td>Exonuclease I, SNPLex System</td>
<td>–15 to –25</td>
</tr>
<tr>
<td>Exonuclease Buffer, SNPLex System</td>
<td>–15 to –25</td>
</tr>
</tbody>
</table>

**Required Materials**

Refer to “Required Non-Kit Materials” on page 1-9 for a complete list of vendors and part numbers.

**Preparing an Exonuclease Reaction**

To prepare an exonuclease reaction:

1. Thaw the Exonuclease Buffer at room temperature. If a precipitate forms, place the tube briefly in a heating block set to 37 °C.

2. Vortex, then quick-spin the tubes.

3. Prepare a 2× Exonuclease master mix on ice by scaling the volumes listed below to the desired number of OLA reactions.

   **Note:** Prepare extra volume to account for losses that may occur during pipetting.

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Reaction (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nuclease-free water</td>
<td>4.2</td>
</tr>
<tr>
<td>Exonuclease Buffer (10X) SNPLex System</td>
<td>0.5</td>
</tr>
<tr>
<td>Lambda Exonuclease SNPLex System</td>
<td>0.2</td>
</tr>
<tr>
<td>Exonuclease I SNPLex System</td>
<td>0.1</td>
</tr>
<tr>
<td>Total</td>
<td>5.0</td>
</tr>
</tbody>
</table>

   **Note:** Prepare the 2× Exonuclease master mix on ice immediately before use. Applied Biosystems does not recommend preparing a large volume of the 2× Exonuclease master mix for later use.

4. Pipette 5 µL of 2× Exonuclease master mix into each well of the OLA reaction plate.

5. Seal the plate with one of the recommended plate covers (see Table 1-2 on page 1-9). If you are using 96-well plates, use MicroAmp™ Full Plate Covers to seal the plate.
To prepare an exonuclease reaction: (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Step Type</th>
<th>Temperature (°C)</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>HOLD</td>
<td>37</td>
<td>90 min</td>
</tr>
<tr>
<td>2</td>
<td>HOLD</td>
<td>80</td>
<td>10 min</td>
</tr>
<tr>
<td>3</td>
<td>HOLD</td>
<td>4</td>
<td>∞</td>
</tr>
</tbody>
</table>

6. Vortex the plates and spin to collect liquid in the bottom of the wells.

7. Program the thermal cycler:

8. Transfer the reaction plates to the thermal cycler, and start the program.
   **Note:** The plate can be left at the 4 °C hold overnight.

9. After thermal-cycling is complete, spin to collect liquid in the bottom of the wells.

10. Process the enzyme-digested OLA reaction products. To use the OLA reaction products:
    • Immediately – Proceed to “Performing PCR” on page 3-21.
    • Within 21 days – Store at –20 °C.

   **Note:** For storage, seal the plates with one of the recommended plate covers (see Table 1-2 on page 1-9).

   **Note:** For best results, use the OLA reaction products immediately.
Performing PCR

For a summary of the steps in the amplification procedure, refer to “PCR Amplifying Ligated OLA Reaction Products” on page 1-22.

Amplification Kit Components

The components in the SNPlex™ System Amplification Kit (PN 4349358) are listed in the table below. The kit contains enough reagent for 5,000 reactions.

<table>
<thead>
<tr>
<th>Component</th>
<th>Storage Temperature (°C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification Master Mix (2X) SNPlex System</td>
<td>2 to 8</td>
</tr>
<tr>
<td>Amplification Primers (20X) SNPlex System</td>
<td>−15 to −25</td>
</tr>
</tbody>
</table>

Required Materials

Refer to “Required Non-Kit Materials” on page 1-9 for a complete list of vendors and part numbers.

Preparing the PCR Master Mix

To prepare the PCR master mix:

1. Thaw the Amplification Primers.
2. Vortex, then quick-spin the tube.
3. Prepare a PCR master mix by scaling the volumes listed below to the desired number of PCR reactions.

**Note:** Prepare extra volume to account for losses that may occur during pipetting.

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Reaction (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nuclease-free water</td>
<td>2.5</td>
</tr>
<tr>
<td>Amplification Master Mix (2X) SNPlex System</td>
<td>5.0</td>
</tr>
<tr>
<td>Amplification Primers (20X) SNPlex System</td>
<td>0.5</td>
</tr>
<tr>
<td>Total Volume</td>
<td>8.0</td>
</tr>
</tbody>
</table>
Assembling and Running the PCR Reaction

To assemble and run the PCR reaction:

1. Thaw the exonuclease-digested sample plate(s) if necessary. Add 15 µL of nuclease-free water to each well, mix, then spin down.

2. Into each well of a 384- or 96-well plate, dispense:
   - 8 µL PCR master mix
   - 2 µL diluted exonuclease-digested OLA reaction product

3. Cover 384-well reaction plates containing the SNPllex OLA reactions with one of the recommended plate covers (see Table 1-2 on page 1-9) and an optical cover compression pad.a
   **Note:** If you are using 96-well plates, use MicroAmp™ Full Plate Covers to seal the plate.

4. Program the thermal cycler:

<table>
<thead>
<tr>
<th>Step</th>
<th>Step Type</th>
<th>Temperature (°C)</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>HOLD</td>
<td>95</td>
<td>10 min</td>
</tr>
<tr>
<td>2</td>
<td>30 cycles</td>
<td>95</td>
<td>15 sec</td>
</tr>
<tr>
<td></td>
<td></td>
<td>63</td>
<td>1 min</td>
</tr>
<tr>
<td>3</td>
<td>HOLD</td>
<td>4</td>
<td>∞</td>
</tr>
</tbody>
</table>

5. Transfer the reaction plates to the thermal cycler and start the program.

6. When thermal cycling is complete, remove the reaction plates.

7. If you use the PCR reaction products:
   - **Immediately** – Proceed to “Hybridizing PCR Products to ZipChute Probes” on page 3-23.
   - **Within 24 hours** – Store at 4 °C.
   - **Within 35 days** – Store at –20 °C.

---

a. IMPORTANT! Applied Biosystems has found that certain plate covers negatively affect the performance of the SNPllex System assay. If you use covers other than the recommended plate covers, test them using the SNPllex™ System Control Set (see Appendix A).
Hybridizing PCR Products to ZipChute Probes

**IMPORTANT!** For best results, this section should be executed continuously through the end of step 6 on page 3-30, that is, until immediately prior to capillary electrophoresis. The plates can then be stored at -20 °C overnight. For optimal results, run the ZipChute probes on the electrophoresis instrument the same day.

For a summary of the steps in the ZipChute hybridization procedure, refer to “Hybridizing PCR Products to ZipChute Probes and Performing Electrophoresis” on page 1-24.

The reagents required to complete the hybridization process are listed below.

<table>
<thead>
<tr>
<th>Component</th>
<th>Storage Temperature (°C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNPlex System Hybridization Plates, 384-well or</td>
<td>Ambient</td>
</tr>
<tr>
<td>SNPlex System Hybridization Plates, 96-well</td>
<td></td>
</tr>
<tr>
<td>Hybridization Wash Buffer SNPlex System</td>
<td>Ambient</td>
</tr>
<tr>
<td>Hybridization Binding Buffer SNPlex System</td>
<td>Ambient</td>
</tr>
<tr>
<td>ZipChute Dilution Buffer SNPlex System</td>
<td>Ambient</td>
</tr>
<tr>
<td>SNPlex™ System ZipChute Kit, 48-plexa</td>
<td>–15 to –25</td>
</tr>
<tr>
<td>• Denaturant SNPlex System</td>
<td></td>
</tr>
<tr>
<td>• ZipChute Mix, 48-plex SNPlex System</td>
<td></td>
</tr>
<tr>
<td>• Positive Hybridization Controls SNPlex System</td>
<td></td>
</tr>
</tbody>
</table>

a. Avoid exposure to light and minimize freeze-thaw cycles.

Refer to “Required Non-Kit Materials” on page 1-9 for a complete list of vendors and part numbers.

1. Dilute the Wash Buffer 1:10 with deionized water.  
   **Note:** Prepare sufficient volume for at least 7 washes.

2. Prepare the Binding Buffer with the Positive Hybridization Control for the desired number of hybridization reactions. For each reaction, you need  
   • 17.491 µL of undiluted Binding Buffer  
   • 0.009 µL of Positive Hybridization Control  
   **Note:** Prepare extra volume to account for losses that may occur during pipetting.
**Preparing the Hybridization Plates**

To prepare the hybridization plates:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Remove the PCR reaction plates from storage (see step 7 on page 3-22).</td>
</tr>
</tbody>
</table>
| 2.   | Vortex, then briefly spin the PCR reaction plates to collect the liquid in the bottom of the wells.  
**Note:** When removing covers from the PCR reaction plates, be careful not to aerosolize or disturb the contents of the wells, which may contaminate adjacent wells. |
| 3.   | Label the SNPlex Hybridization Plates, making sure well A-1 is at the top left corner. |
| 4.   | Wash the wells of the SNPlex Hybridization Plates once with 100 µL Wash Buffer diluted 1:10.  
**Note:** Dilute the Wash Buffer 1:10 with deionized water. |
| 5.   | Briefly shake or spin the plates upside down on a clean paper towel.  
**IMPORTANT!** For this and all subsequent washing steps, all excess liquid must be removed from the plate before adding new reagents. However, keeping the plates empty for extended periods of time negatively affects the performance of the SNPlex System assay. |

**Binding PCR Products to the Hybridization Plate**

To bind the PCR product to the hybridization plate:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Add 17.5 µL of Binding Buffer containing Positive Hybridization Control to the SNPlex Hybridization Plate.</td>
</tr>
</tbody>
</table>
| 2.   | Transfer 3.0 µL of each well containing the PCR reaction product into each well of the SNPlex Hybridization Plate and mix.  
**Note:** The notches on plates from different manufacturers do not always line up. Make sure you orient the plates with well A-1 at the upper left corner when transferring samples between plates. |
| 3.   | Cover the SNPlex Hybridization Plate with one of the recommended plate covers (see Table 1-2 on page 1-9), excluding the MicroAmp™ Full Plate Covers, which require pressure in a thermal cycler to seal. |
| 4.   | Incubate for 15 to 60 min at room temperature on a suitable orbital shaker.  
**Note:** A suitable orbital shaker has a small throw and high rpm, for example the recommended shaker has a 1.5 mm stroke/orbit and a maximum of 1350 rpm. |
| 5.   | Briefly spin the hybridization plates to collect the liquid in the bottom of the wells. |
To isolate the biotinylated strand on the hybridization plates:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Uncover the SNPlex Hybridization Plates.</td>
</tr>
<tr>
<td>2.</td>
<td>Add 50 µL of 0.1 N NaOH, then cover the plate with one of the recommended plate covers (see Table 1-2 on page 1-9), excluding the MicroAmp 96-Well Full Plate Covers. <strong>Note:</strong> Applied Biosystems recommends that you prepare the 0.1N sodium hydroxide solution fresh every 4 weeks.</td>
</tr>
<tr>
<td>3.</td>
<td>Incubate for 5 to 30 min at room temperature on a rotary shaker.</td>
</tr>
<tr>
<td>4.</td>
<td>Carefully remove the supernatant from each well, then wash each well three times with 100 µL of Wash Buffer diluted 1:10. <strong>Note:</strong> Dilute the Wash Buffer 1:10 with deionized water.</td>
</tr>
<tr>
<td>5.</td>
<td>Briefly shake the plates upside down on a clean paper towel. <strong>IMPORTANT!</strong> All excess liquid must be removed from the plate before adding new reagents. However, keeping the plates empty for extended periods of time negatively affects the performance of the SNPlex System assay.</td>
</tr>
</tbody>
</table>
Hybridizing the ZipChute Probes

**WARNING** CHEMICAL HAZARD: ZipChute Dilution Buffer, SNPlex System. Exposure causes eye irritation. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

**Denaturant, SNPlex System.** Exposure causes eye, skin, and respiratory tract irritation. Denaturant, SNPlex System is a possible developmental and birth defect hazard. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

To hybridize the ZipChutes Probes:

1. Equilibrate the oven to 37 °C.

2. Prepare a hybridization master mix by scaling the volumes listed below to the desired number of samples. Prepare extra volume to account for losses that may occur during pipetting.

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Reaction (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZipChute Mix, 48-plex SNPlex System</td>
<td>0.05</td>
</tr>
<tr>
<td>Denaturant, SNPlex System</td>
<td>11.25</td>
</tr>
<tr>
<td>ZipChute Dilution Buffer, SNPlex System</td>
<td>13.70</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>25.00</strong></td>
</tr>
</tbody>
</table>

**Note:** Once prepared, you can keep the hybridization master mix at room temperature for at least 2 hours without a loss in performance. After 2 hours the remaining hybridization master mix may be stored covered in the dark at 4 °C for up to 4 days for later use. You may prepare a large quantity of hybridization master mix and store it covered in the dark at 4 °C for up to 4 days.

3. Add 25 µL of the hybridization master mix to each well.

4. Cover the plate with one of the recommended plate covers (see Table 1-2, page 1-9), excluding the MicroAmp 96-well Full Plate Cover.

5. Incubate the plates for 60 to 75 min at 37 °C on a rotary shaker.

**Note:** During incubation, avoid exposure to direct light.

**Note:** To avoid possible overheating, do not place the plate directly on the floor of the oven.
Eluting ZipChute Probes

For a summary of the steps in the purification procedure, refer to “Hybridizing PCR Products to ZipChute Probes and Performing Electrophoresis” on page 1-24.

Standards Kit Components

The components included in the SNPlex™ System Assay Standards Kit are listed in the table below. The kit contains enough reagent for 5,000 reactions.

<table>
<thead>
<tr>
<th>Component</th>
<th>Storage Temperature (°C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size Standard, 48-plex SNPlex System</td>
<td>−15 to −25</td>
</tr>
<tr>
<td>Sample Loading Reagent, SNPlex System</td>
<td>−15 to −25</td>
</tr>
<tr>
<td>Allelic Ladder, 48-plex SNPlex System</td>
<td>−15 to −25</td>
</tr>
</tbody>
</table>

IMPORTANT! The effectiveness of each component declines with increasing freeze-thaw cycles. Store at −20 °C and minimize exposure to light.

Required Materials

Refer to “Required Non-Kit Materials” on page 1-9 for a complete list of vendors and part numbers.

Preparing the Sample Loading Mix

CHEMICAL HAZARD. Sample Loading Reagent, SNPlex System. Exposure causes eye, skin, and respiratory tract irritation. SNPlex Sample Loading Reagent is a possible developmental and birth defect hazard. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

To prepare Sample Loading Mix:

1. Thaw the Size Standard, Allelic Ladder 48-plex, and Sample Loading Reagent at room temperature.
   If precipitates form, place the tubes briefly in a heating block set to 37 °C.

2. Vortex, then quick-spin the tubes.

3. Prepare Sample Loading Mix by scaling the volumes listed below to the desired number of samples.

   Note: Prepare extra volume to account for losses that may occur during pipetting.

   Note: Prepare fresh sample loading mix daily.

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per Reaction (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size Standard, 48-plex SNPlex System</td>
<td>0.6</td>
</tr>
<tr>
<td>Sample Loading Reagent, SNPlex System</td>
<td>16.9</td>
</tr>
<tr>
<td>Total Volume</td>
<td>17.5</td>
</tr>
</tbody>
</table>
### To elute the ZipChute probes:

1. After the 60- to 75-min incubation period (see page 3-26), carefully remove the supernatant from the hybridization plates.

   **IMPORTANT!** For best results, do not let plates sit at room temperature for extended periods of time before removing supernatant.

   **IMPORTANT!** The ZipChute probes may be stripped off the plate under the following conditions:
   - Rapid aspiration of the ZipChute Mix supernatant when using a plate washer.
   - Contact between the plate washer tips and the well surfaces.
   
   Applied Biosystems recommends that you set the aspiration tip depth so that 15 to 20 µL of ZipChute supernatant remains in each well after aspiration, preventing the tips from touching the bottom of the wells.

2. Wash each well three times with 100 µL Wash Buffer diluted 1:10.

   **Note:** Dilute the 10X Wash Buffer 1:10 with deionized water.

   **Note:** After removal of the ZipChute supernatant and addition of Wash Buffer, the plate washer tips can move near (but still should not touch) the bottom of the wells when aspirating Wash Buffer supernatant.

3. **IMPORTANT!** For consistent results, after the last wash, spin the plate **upside down** at 1000 rpm for 60 sec on a stack of clean paper towels to remove all remaining buffer.

4. Immediately add 17.5 µL of Sample Loading Mix containing size standard to each well.

5. Cover the plate containing the Sample Loading Mix containing size standard with one of the recommended plate covers (see Table 1-2, page 1-9), excluding the MicroAmp 96-Well Full Plate Cover.

6. Incubate the plate in a 37 °C oven for 10-30 min on a rotary shaker.

   **Note:** To avoid possible overheating, do not place the plate directly on the floor of the oven.

---

a. For more information about configuring plate washers, refer to the SNPlex™ Genotyping System 48-plex General Automation Getting Started Guide or the SNPlex™ Genotyping System 48-plex Automation Guide Automating PCR Using the Tomtec Quadra 3 Getting Started Guide.
Preparing Samples for Electrophoresis

To dispense the allelic ladder and transfer reagent from the hybridization plate:

1. Remove the hybridization plates from the oven.
2. Briefly spin the plates to collect the liquid at the bottom of the wells.
3. Label a new reaction plate. The reaction plate must be appropriate for use with Applied Biosystems 3730/3730xl and 3130xl DNA Analyzers.
4. • If using 384-well plates, transfer 7.5 µL from each well into the wells of the new plate.
   • If using 96-well plates, transfer 10 µL from each well into the wells of the new plate.
5. To load the Allelic Ladder wells (indicated by blue shading in the figure below):

   Note: The Allelic Ladder is part of the SNPlex System Standards Kit.

<table>
<thead>
<tr>
<th>96-capillary array, 96-well plate</th>
<th>96-capillary arrays, 384-well plate</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="96-capillary array, 96-well plate diagram" /></td>
<td><img src="image2.png" alt="96-capillary arrays, 384-well plate diagram" /></td>
</tr>
<tr>
<td>Each well contains 10 µL from hybridization plate</td>
<td>Each well contains 7.5 µL from hybridization plate</td>
</tr>
<tr>
<td>1.25 µL Allelic Ladder</td>
<td>1 µL Allelic Ladder</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>48-capillary array, 96-well plate</th>
<th>48-capillary array, 384-well plate</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3.png" alt="48-capillary array, 96-well plate diagram" /></td>
<td><img src="image4.png" alt="48-capillary array, 384-well plate diagram" /></td>
</tr>
<tr>
<td>Each well contains 10 µL from hybridization plate</td>
<td>Each well contains 7.5 µL from hybridization plate</td>
</tr>
<tr>
<td>1.25 µL Allelic Ladder</td>
<td>1 µL Allelic Ladder</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>16-capillary array, 96-well plate</th>
<th>16-capillary array, 384-well plate</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.png" alt="16-capillary array, 96-well plate diagram" /></td>
<td><img src="image6.png" alt="16-capillary array, 384-well plate diagram" /></td>
</tr>
<tr>
<td>Each well contains 10 µL from hybridization plate</td>
<td>Each well contains 7.5 µL from hybridization plate</td>
</tr>
<tr>
<td>1.25 µL Allelic Ladder</td>
<td>1 µL Allelic Ladder</td>
</tr>
</tbody>
</table>
To dispense the allelic ladder and transfer reagent from the hybridization plate:

6. **Note:** Make sure there are no air bubbles trapped at the bottom of the wells. If there are, briefly spin the plate.

**Note:** For information about proper sample plate layout, refer to “Designing the Sample Plate Layout” on page 3-3.

**IMPORTANT!** If you are not going to immediately use the plates for analysis, seal the plates, and store at –20 °C.

**Note:** Consider the plate seal options for use with the 3730 and 3730xl instruments. While both septa and heat seal film are available, the septa do not provide an air-tight seal. Some gradual signal loss occurs over time when using the septa. If the SNPlex plates will remain on the instrument in excess of 12 hours, Applied Biosystems recommends using the pierceable heat seal option (Heat Seal film, 3730/3730xl instrument only; septa only can be used with the 3130xl instrument). Be aware that after the heat seal is pierced by the instrument for sample injection, the seal is no longer intact.
Creating Results Groups and Plate Records

About Data Collection Software

For optimal results, include an allelic ladder well in a run and save the run to a unique folder. See Table 3-2 for the folder setup in the software. Changes in laboratory conditions (including buffer temperature and polymer age) can cause slight changes to bin position. The software calculates and applies bin offsets (the correction from the default bin positions). Including an allelic ladder well in a run and saving the run to a unique folder allows a bin offset specific to the run to be calculated and applied. If all sample files are in one folder, all allelic ladders in the folder are averaged. The bin offset is calculated using the averaged ladder value and is applied to each run in the folder.

Table 3-2  Folder setup for the data collection software

<table>
<thead>
<tr>
<th>Instrument Data Collection Software</th>
<th>Folders(^a) per plate(^b)</th>
<th>Samples per folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>3130xl</td>
<td>6 / 24</td>
<td>16</td>
</tr>
<tr>
<td>3730</td>
<td>2 / 8</td>
<td>48</td>
</tr>
<tr>
<td>3730xl</td>
<td>1 / 4</td>
<td>96</td>
</tr>
</tbody>
</table>

a. At least 1 ladder per folder for binning offset calculation. When more than one ladder is included in a folder, the ladder results are averaged and the bin offset is calculated using the average value.

b. At least 1 NTC per plate or pool.

Starting Data Collection Software

To start the 3730/3730\(xl\)/3130\(xl\) instrument Data Collection Software:

1. Select Start > Programs > Applied Biosystems > Data Collection > Run 3730 <3130> Data Collection v2.0 or higher.

2. Wait as the Service Console dialog box starts the applications of the data collection software.

3. When all applications are running, the Data Collection Viewer opens.

About Results Groups

Results Groups allow you to specify autoanalysis settings, designate a data storage location, and specify naming conventions for sample files and run folders.

By including “Plate Quadrant” as a parameter for naming run folders, the Data Collection software automatically generates separate run folders for each plate quadrant. Because the sample plate is set up so that each plate quadrant corresponds to a probe pool, the data for each probe pool is stored in a separate folder.

If you use a 48- or 16-capillary array, including “Run Sequence Number” or “Run Name” as a parameter for naming run folders enables the Data Collection software to generate a separate folder for each run required to complete a sample plate (see “Designing the Sample Plate Layout” on page 3-3).
For example, if you use a 48-capillary instrument, two runs are required to run a single 96-well plate or one quadrant of a 384-well plate (total of eight runs for a 384-well plate). Similarly, if you are running on the 3130xl instrument (16-capillary array), six runs are required for a 96-well plate or one quadrant of a 384-well plate (total of 24 runs for a 384-well plate).

Applied Biosystems recommends that you use the above Results Groups conventions in order to allow separate sizing bin adjustments to be applied to individual runs, even if they originate from the same probe pool (quadrant). In the latter case, you can cluster the runs individually or together (as a project). This applies to Rules Analysis only.

**IMPORTANT!** For GeneMapper® software to correctly process SNPLEX System data, run folder naming conventions and sample plate layout (explained in “Designing the Sample Plate Layout” on page 3-3) must correspond to each other.

### Setting Up Results Groups

To set up results groups for SNPLEX System experiments:

1. In the Data Collection software, double-click **Results Group** to open the Results Group Editor.

2. Select the **Naming** tab.

3. Complete the information in the tab as shown in Figure 3-2 and Table 3-3.

   **Note:** When you create a new results group, the Data Collection software displays a single drop-down box under each Format section. Each time you make a selection (as specified in the table below), the software adds a drop-down box.

**Figure 3-2** shows the Results Group Editor for a sample Results Group used with 3730 instruments running a 48-capillary array or a 3130xl instrument running a 16-capillary array. Note that for instruments running 96-capillary arrays, the Run Sequence Number is unnecessary.
Creating Results Groups and Plate Records

Table 3-3  Suggested minimum sample file and run folder parameters for SNPlex System results groups

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample File Name</td>
<td>In the Format section under Sample File Name Format, select ...</td>
</tr>
<tr>
<td>Well Position</td>
<td>Well Position</td>
</tr>
<tr>
<td>Sample Name</td>
<td>Sample Name</td>
</tr>
<tr>
<td>Capillary Number</td>
<td>Capillary Number</td>
</tr>
<tr>
<td>Run Folder Name</td>
<td>In the Format section under Run Folder Name Format, select ...</td>
</tr>
<tr>
<td>Plate Name</td>
<td>Plate Name</td>
</tr>
<tr>
<td>Plate Quadrant</td>
<td>Plate Quadrant</td>
</tr>
<tr>
<td>Run Sequence Number</td>
<td>Run Sequence Number</td>
</tr>
<tr>
<td>Note:</td>
<td>If this parameter is selected, the Data Collection software adds a four-digit number to the run folder name. The number is incremented with every run on the instrument. This option is highly recommended for the 3730 instrument when running 48-capillary arrays. It is not necessary when running 96-capillary arrays or 3130xl instruments with 16-capillary arrays.</td>
</tr>
<tr>
<td>Run Name</td>
<td>An alternative to Run Sequence Number. If this parameter is selected, the Data Collection software appends a text string, such as Run_InstrumentName_Date_Time_RunSequenceNumber, to the run folder name.</td>
</tr>
<tr>
<td>Run Number</td>
<td>Run Number</td>
</tr>
</tbody>
</table>

a. Preferred over Run Name.
About Plate Records

A plate record is similar to a sample sheet or an injection list that you may have used with some Applied Biosystems instruments. Plate records are data tables in the instrument database that store information about the plates and the samples they contain.

Some plate record fields that are required for 3730/3730xl and 3130xl instrument operation and sample file generation must be completed before a run. Depending on the needs of your laboratory, you can either:

- Complete the plate record manually, adding information at the appropriate time in the workflow.
- Partially or fully automate the plate record creation process by importing information from LIMS or text editor-generated files.
Creating Plate Records

There are several ways to create plate records. Figure 3-3 illustrates three possible methods: manual, partially automated, and fully automated.

**Manual Method**
- Create plate record on the Data Collection PC containing:
  - Sample Name
  - Results Group
  - Instrument Protocol

**Partially Automated Method**
- Import plate record text file into Data Collection software. The following information is completed:
  - Sample Name
  - Results Group
  - Instrument Protocol
  - Sample Type
  - SNP Set

**Fully Automated Method**
- Import plate record text file into Data Collection software. The following information is completed:
  - Sample Name
  - Results Group
  - Instrument Protocol
  - Sample Type
  - SNP Set
  - Analysis Method
  - Panel
  - Size Standard

**Run Data Collection software**

**Add sample files to GeneMapper software**

**To Sample Information, add:**
  - Sample Type
  - Analysis Method
  - Panel
  - Size Standard
  - SNP Set

**Analyze data with GeneMapper software**

---

**Figure 3-3** Three possible methods for creating plate records
When GeneMapper software is installed on a computer that has Data Collection software, two applications are available (in the Automated Processing tab of the Results Group Editor):

- **GeneMapper-Generic** – Generates sample files but does not perform autoanalysis.
- **GeneMapper-<Instrument Name>** – Performs autoanalysis.

Table 3-4 indicates the required fields for creating plate records using each application.

**Table 3-4 Minimum required fields for fragment analysis data collection**

<table>
<thead>
<tr>
<th>Field</th>
<th>GeneMapper-Generic</th>
<th>GeneMapper-&lt;Instrument Name&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Collection Software Fields</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sample Name</td>
<td>required</td>
<td>required</td>
</tr>
<tr>
<td>Results Group</td>
<td>required</td>
<td>required</td>
</tr>
<tr>
<td>Instrument Protocol</td>
<td>required</td>
<td>required</td>
</tr>
<tr>
<td><strong>GeneMapper Software Fields</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size Standard</td>
<td>optional</td>
<td>required</td>
</tr>
<tr>
<td>Analysis Method</td>
<td>optional</td>
<td>required</td>
</tr>
<tr>
<td>SNP Set</td>
<td>optional</td>
<td>required</td>
</tr>
<tr>
<td>Panel</td>
<td>optional</td>
<td>required</td>
</tr>
<tr>
<td>Sample Type</td>
<td>optional</td>
<td>required</td>
</tr>
</tbody>
</table>

When creating plate records, note that

- You must complete the required Data Collection software fields before a run, regardless of which GeneMapper software application you are using to analyze the data.

- If you run the GeneMapper-Generic application, you can complete the GeneMapper software fields after the electrophoresis run, but before analyzing the data. Refer to Chapter 4 for information on setting up GeneMapper software.

**Note:** You cannot analyze the samples in GeneMapper software unless these fields are completed.
If you run the GeneMapper-<Instrument Name> application, you also need to complete the GeneMapper software fields before the electrophoresis run.

- You can import SNP Sets from assay information files, as explained in “Importing the AIF” on page 4-5.
- You can preset GeneMapper software to automatically apply the Analysis Method, Panel, and Size Standard whenever sample files are imported, as explained in “Importing SNPlx System Data into GeneMapper Software” on page 4-6.
- When adding Sample Type and SNP Set information to a plate record, enter them in such a way that the data can be readily analyzed by GeneMapper software without you having to edit the plate record. Additionally, these fields must be entered exactly as they are defined in GeneMapper software.

The most convenient way to create plate records is to import appropriately formatted text files that have been generated by a text editor or by a LIMS system. The simplest way to get started is to export a working plate record using the Data Collection software, then use it as a template to develop a plate record generation tool.

Plate records exported by the Data Collection software contain additional header information, including Container Name, Plate ID, Description, ContainerType, AppType, Owner, Operator, PlateSealing, and SchedulingPref. Again, the simplest way to define these fields correctly is to use a working plate record as a guide.

**Note:** Plate ID, PlateSealing, and SchedulingPref are not available on the 3130xl instrument.
Creating Plate Records by Importing Formatted Text Files

Applied Biosystems recommends using a partially automated method to generate plate records (see Figure 3-3). Such a method helps eliminate problems arising from data-entry errors and can also greatly reduce the time spent setting up plate records.

**To set up plate records by importing text files:**

1. In the Data Collection software, open the **Plate Manager**.
2. Click **Import**, then navigate to the text file that you want to import.
3. Select the file that you want to import, then click **Open**.
   - The Data Collection software imports the contents of the file into a new plate record, then displays a confirmation message if the import is successful.
   - If you set up your text file as recommended, the Sample Name, Results Group, Instrument Protocol, Sample Type, and SNP Set fields are complete at this point.
   - If you have set up the Add Samples options in GeneMapper software (“Setting Analysis Method, Size Standard, and Panel Automatically” on page 4-7), the Analysis Method, Size Standard, and Panel fields will be completed automatically when the sample files are imported into GeneMapper software.
   - **IMPORTANT!** For GeneMapper software to recognize the SNP set information, you must have imported the assay information file into GeneMapper software (“Importing AIFs” on page 4-6).

Creating Plate Records Manually

**To create the plate record manually:**

1. In the tree pane of the Data Collection Software, double-click **GA Instruments > ga3730 or ga3730xl or ga3130xl > <Instrument Name> > Run Scheduler**.
2. In the Add Plate field of the Run Scheduler view, enter or scan the bar code of a plate that you want to run, then press **Enter**.
3. In the Select an Option dialog box, click **Yes**.
4. In the New Plate dialog box, update the following fields:
   - **ID (Barcode)** – Scan or enter the barcode for the plate you want to run
   - **Name** – Enter a name for the plate
   - **Description** – Enter a description for the plate record (optional)
   - **Application** – Select GeneMapper-Generic
   - **Plate setup** – Select 384-Well or 96-Well
   - **Plate sealing** – Select Septa or Heat Seal (if using heat-sealed plates)
   - **Owner name** – Enter your owner name
   - **Operator name** – Enter your operator name

**Note:** ID (Barcode) and Plate sealing do not apply to the 3130xl instrument.
To create the plate record manually: *(continued)*

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>5.</td>
<td>Click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>
| 6. | In the Plate Editor dialog box, for each row of the plate record table, enter:  
   a. A sample name  
   b. Comments for each well of the plate (optional) |
| 7. | For each row of the Plate Record table:  
   a. Select or create a results group.  
   b. For the instrument protocol, select the protocol you created (see page 2-5).  
   **Note:** Refer to “Importing SNPlex System Files into the Data Collection Software” on page 2-3 if the run module and dye set are not available on your system. |
| 8. | In the Description field, enter a description of the plate record (optional). |
| 9. | Click **OK**. The data collection software saves the plate record to the database. |
| 10. | If running more than one plate, repeat steps 3 to 9.  
   **Note:** At this point you have specified only the Sample Name, Results Group, and Instrument Protocol fields, as shown in the manual workflow in Figure 3-3 on page 3-35. You must specify the rest of the information in the plate record (specifically, in the GeneMapper Sample Table after adding sample files) before you can analyze the data using GeneMapper software. |
Loading and Running the Sample Plates

**3730 Plate Assembly**
Assemble the plates for loading onto the 3730/3730xl analyzer. The 384-well plate assembly (shown below) is similar to the 96-well plate assembly (use sample plates, plate septa, and plate retainers for the 96-well format).

Assembling the Plates
Place the sample plate into the plate base and snap the plate retainer onto the plate and plate base. Verify that the holes of the plate retainer and the septa strip are aligned. If not, re-assemble the plate assembly.

**IMPORTANT!** Damage to the array tips will occur if the plate retainer and septa strip holes do not align correctly.

**3130 xl Plate Assembly**

Assembled components
Required Materials

Refer to “Required Non-Kit Materials” on page 1-9 for a complete list of vendors and part numbers.

Loading Sample Plates on the 3730/3730xl Instrument

To load the plates in the stacker:

1. Pull open the stacker drawer. The stacker light flashes green.
2. Open the metal door of the In-Stacker tower.
3. Place the plates in the stacker (16 maximum). The bottom plate runs first.
   **IMPORTANT!** Ensure that the plate assembly fits flat in the stacker and that plate retainer clips are properly seated in the base.
4. Close the metal In-Stacker tower door.
5. Close the stacker drawer.

Loading Sample Plates on the 3130x/ Instrument

To load the plates in the instrument:

1. Verify the oven and front doors are closed.
2. Press the Tray button and wait for the autosampler to stop at the forward position, then open the front doors.
3. Place the plate assembly on the autosampler, ensuring that the plate assembly fits flat in the autosampler.
   **Note:** There is only one orientation for the plate, with the notched end of the plate base away from you.
4. Close the instrument doors.
   **Note:** Closing the doors returns the autosampler to the home position, placing the tips of the capillaries in the buffer.

Prerequisites

If you are using Data Collection v2.0, verify that the default prebatch file has been replaced with the SNPlex System prebatch file.

**Note:** If you are using Data Collection v3.0, there is no specific prebatch file and you may disregard the following paragraph.

Double-click **PrebatchModule.txt** (typically in E:\AppliedBiosystems\UDC\DataCollection\SupportFiles\ga3730\Service Modules). If the first line of the file is not //SNPlex v2.0 Prebatch, refer to “Replacing the PrebatchModule. txt File” on page 2-3 for more information.
Running the Plates on the 3730/3730xl Instrument

To run the plates:

1. In the tree pane of the Data Collection Software, double-click GA Instruments > ga3730 or ga3730xl > <Instrument Name> > Run Scheduler.

2. In the Input Stack group box of the Run Scheduler view, click Search, then click Find All.

3. Select the plate record, then click Add.

4. Click the green arrow in the toolbar to begin the run.

   **Note:** As part of the prebatch function, the instrument oven heats to temperature before the run begins. As the data is collected, you can view it in the Array Viewer.

Running the Plates on the 3130xl Instrument

To run the plates:

1. In the tree pane of the Data Collection software, click GA Instruments > ga3130xl > <instrument name> > Run Scheduler > Plate View, then search for your plate record.

2. Link the plate.
   a. Select the plate record you want to run.
   b. Click the plate position indicator that matches the plate you want linked. The plate map color changes from yellow to green when the plate is linked.

3. In the toolbar of the Data Collection software window, click the green run arrow to begin the run.

4. In the Processing Plates dialog box, click OK.
This chapter covers:

Overview .............................................................. 4-2
Installing GeneMapper Software v4.0 ................................. 4-3
Importing SNPlex System Panels and Bins ....................... 4-3
Importing the SNPlex Analysis Method for the 3130xl Instrument 4-5
Importing the AIF .................................................... 4-5
Importing SNPlex System Data into GeneMapper Software .... 4-6
Analyzing SNPlex System Data .................................... 4-8
Reviewing Results .................................................. 4-9
Exporting SNPlex System Data .................................... 4-10
Overview

Figure 4-1 summarizes the process of analyzing SNPIex™ System data with GeneMapper® Software v4.0.

1. Install GeneMapper® software v4.0* — page 4-3
2. Import SNPIex™ system panels and bins* — page 4-3
3. Import SNPIex™ Analysis Method (3130xl only) — page 4-5
4. Import assay information files — page 4-5
5. Import SNPIex system data — page 4-6
6. Analyze the data — page 4-8
7. Review analyzed data — page 4-9
8. Export analyzed data — page 4-10

* One-time set up only

Figure 4-1 Analyzing SNPIex System data with GeneMapper Software v4.0
Installing GeneMapper Software v4.0

Install the GeneMapper Software v4.0 according to instructions provided in the GeneMapper® Software v4.0 Installation Guide (PN 4359289).

Importing SNplex System Panels and Bins

GeneMapper software uses the same analysis parameters for all 48-plex SNplex System experiments. All the parameter files required to perform analysis of the SNplex System assay chemistry by GeneMapper software are installed on your computer when you install GeneMapper Software v4.0. (See Table 4-1 on page 4-3.) Importing the parameter files into GeneMapper software is a one-time setup step.

Note: Check for updates on the Applied Biosystems Web site at http://www.appliedbiosystems.com/support/software

Table 4-1 Parameter files for analyzing SNplex System data on GeneMapper Software v4.0

<table>
<thead>
<tr>
<th>File Namea</th>
<th>File Name as Displayed After Import into GeneMapper Software</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3730/3730x/ instrument: SNplex_48plex_3730_Bins.txt or 3130x/ instrument: SNplex_48plex_3131_Bins.txt</td>
<td>3730/3730x/ instrument: SNplex_48plex_Bin_3730 or 3130x/ instrument: SNplex_48plex_Bin_3130</td>
<td>Contains bins for SNplex System allelic ladder. This file, along with the panel file, contains information about the expected sizes of the allelic ladder. IMPORTANT! Do not edit this file.</td>
</tr>
<tr>
<td>3730/3730x/ instrument: SNplex_48plex_3730_Panels.txt or 3130x/ instrument: SNplex_48plex_3130_Panels.txt</td>
<td>3730/3730x/ instrument: SNplex_48plex_Panel_3730 or 3130x/ instrument: SNplex_48plex_Panel_3130</td>
<td>Contains panels for SNplex System allelic ladder. This file, along with the bin file, contains information about the expected sizes of the allelic ladder. IMPORTANT! Do not edit this file.</td>
</tr>
</tbody>
</table>

a. The 3730/3730x/ files are written to your hard drive upon installing the GeneMapper Software v4.0. You can download the 3130x/ files from www.appliedbiosystems.com/support/software/snplex/updates.cfm.

Importing SNplex System Panels and Bins

To import SNplex System panels and bins:

1. Start the GeneMapper Software v4.0.
2. Access the Panel Manager.
   a. Select Tools > Panel Manager (Ctrl+J).
   b. Click (Panel Manager).
To import SNPlex System panels and bins: (continued)

3. Import the files from:
   - c:\AppliedBiosystems\GeneMapper\Panels for the 3730/3730xl instrument
   or
   - The “3130xl GeneMapper v4.0” folder downloaded from the web for the 3130xl instrument

   a. To import the panels, click File > Import Panels (Ctrl+M), then select SNPlex_48plex_3730_Panels.txt or SNPlex_48plex_3130_Panels.txt.
   b. To import the bins, click File > Import Bin Set (Ctrl+Shift+B), then select SNPlex_48plex_3730_Bins.txt or SNPlex_48plex_3130_Bins.txt.

   **Note:** If, when you try to import the files, the GeneMapper software displays an error message that tells you the settings already exist, override the old settings.

4. Click OK to close the Panel Manager.

5. Confirm that the SNPlex System panels and bins were imported properly. In the Panel Manager,
   a. Select, then double-click SNPlex_48plex_3730 or SNPlex_48plex_3130.
   b. Select, then double-click SNPlex_48plex_Panel_3730 or SNPlex_48plex_Panel_3130.
   c. Select an individual marker, for example, M5.1_005.

   ![Panel Manager with bins displayed](image)

   If the import was successful, two bins (one gray and one pink) are displayed.
   d. If you do not see the bins, check if the SNPlex System bin set is selected in the bins drop-down list.
   e. If you do not see the bins, reimport the bin set.

   a. Or the drive on which you installed GeneMapper Software v4.0.
Importing the SNPlex Analysis Method for the 3130xl Instrument

The analysis methods required for analyzing SNPlex System data that has been collected on the 3730/3730xl instrument come preinstalled with your GeneMapper Software v4.0. However, for the 3130xl instrument you must download the analysis method from:

www.appliedbiosystems.com/support/software/snplex/updates.cfm

Installing the Analysis Method

1. Select Tools > GeneMapper Manager to open the GeneMapper Manager.
2. Select the Analysis Methods tab.
3. Click Import.
4. Navigate to and select the file SNPlex_Rules_3130.xml.
5. Click Import.

Importing the AIF

About Assay Information Files for the SNPlex System

If your plate records are set up in Data Collection software to include sample names and SNP sets (typically imported from a text file, as recommended in “Creating Results Groups and Plate Records” on page 3-31), you must import the Assay Information File (AIF) into GeneMapper software before you import the SNPlex System sample files (*.fsa). Doing so ensures that GeneMapper software reads the sample names and SNP sets from the plate record.

IMPORTANT! If you are using the SNPlex_Model_3730 analysis method, or any method that uses the Model clustering algorithm or any method that uses analyses by project, you must import the AIF file into GeneMapper software. If you attempt to run the analysis without importing the AIF, you will lose information about markers that are associated with SNPs. (The software assumes that all markers are associated with SNPs.) For more information about analysis methods, refer to Appendix B.

Each SNPlex System probe pool order is accompanied by a SNPlex Genotyping System Ligation Probes CD, which contains the files listed in Table 4-2.

Table 4-2 Files in the SNPlex Genotyping System Ligation Probes CD

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNPlex_nnnnnnn_nnnnnnn.xml where nnnnnnnn_nnnnnnn is the design ID.</td>
<td>Assay information file that contains information about the probe pool, including SNP set names. Do not modify this file.</td>
</tr>
<tr>
<td>ablogo.gif</td>
<td>Applied Biosystems logo file.</td>
</tr>
<tr>
<td>aiftypes_v1_1.xsd</td>
<td>Defines the structure of AIF types. Do not modify this file.</td>
</tr>
<tr>
<td>Probes_Insert.DOC</td>
<td>Limited license for the SNPlex System ASO/LSO probe sets.</td>
</tr>
</tbody>
</table>
Importing AIFs

To import AIFs into GeneMapper software:

1. Select **Tools > GeneMapper Manager**.
2. In the SNP Sets tab, click **Import**.
3. Insert the SNPlex Genotyping System Ligation Probes CD, then select the AIF (indicated by SNPlex_{nnnnnnn}_nnnnnnn.xml). When the import is complete, GeneMapper software displays a number of new SNP sets, each corresponding to a single SNPlex System ligation probe pool. The name of each pool is identical to the name on the tube label.

### Importing SNPlex System Data into GeneMapper Software

The data-import process consists of two steps:

- Completing required plate record fields.
- Importing SNPlex System sample files.

#### Required Fields

The following plate record fields must be completed before GeneMapper software can analyze data: Sample Name, Sample Type, SNP Set, Analysis Method, Panel, and Size Standard. Of these fields:

- Sample Name and Sample Type are completed in the Data Collection software prior to the electrophoresis run. These fields can be completed manually or imported from formatted text files (see “Creating Results Groups and Plate Records” on page 3-31).
- SNP Set names can be imported from the AIF into GeneMapper software. The SNP Set names in the Data Collection plate record must match those in the GeneMapper file.

**IMPORTANT!** For GeneMapper software to read SNP Set names from the plate record, you must import the AIF into GeneMapper software before importing the SNPlex System sample files (*.fsa).

- Depending on the way you set up your plate record (see “Creating Results Groups and Plate Records” on page 3-31), Analysis Method, Size Standard, and Panel information can be completed:
  - In the plate record before electrophoresis, using Data Collection software, typically by importing a formatted text file containing this information.

---

### Table 4-2 Files in the SNPlex Genotyping System Ligation Probes CD

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNPlexAIF_v1_1.xsd</td>
<td>Defines the structure for the AIF file. Do not modify this file.</td>
</tr>
<tr>
<td>SNPlexStylesheet_v1_0.xslt</td>
<td>Contains instructions for displaying the SNPlex System data sheet. Do not modify this file.</td>
</tr>
</tbody>
</table>

---

**SNPlex**<sup>TM</sup> Genotyping System 48-plex User Guide
Importing SNplex System Data into GeneMapper Software

- Automatically upon sample file import. (See “Setting Analysis Method, Size Standard, and Panel Automatically” on page 4-7.)
- Manually, using GeneMapper software to edit the plate record

**Note:** Applied Biosystems recommends using either of the first two methods. Manually entering the information by editing the plate record in GeneMapper software can be time-consuming and error-prone.

### Setting Analysis Method, Size Standard, and Panel Automatically

To set Analysis Method, Size Standard, and Panel automatically:

1. In the GeneMapper main window, select **Tools > Options**, then select the **Add Samples** tab.

2. Specify the Analysis Method, Size Standard, and Panel as shown in the following figure.

   ![Figure](image)

   The size standard and panel should be the same for all analyses. However, you can set the analysis method to SNplex_Model_3730, SNplex_Rules_3730, or SNplex_Rules_3130 depending on which method you are using to analyze your samples.

   For more information about analysis methods, refer to **Appendix B**.

3. Make sure that you set:
   - 310/377 Matrix to **Read from the Sample**
   - Sample Type to **Read from Data collection ‘info’ field**
Importing Sample Files

GeneMapper software retains the folder structure of imported sample files. That is, if the Data Collection software stores each run in a separate folder, GeneMapper software also creates one folder for each run.

For GeneMapper software to correctly analyze data, all sample files from a single run must be stored in the same run folder. Additionally, an allelic ladder sample from the same run must also be included in each run folder. For 384-well plates, sample files should be stored in four run folders for 96-capillary arrays or eight run folders for 48-capillary arrays or 24 run folders for 16-capillary arrays. The folder structure is generated by correctly setting up a Results Group, as described in “Creating Results Groups and Plate Records” on page 3-31.

To import sample files into GeneMapper software:

1. Select File > Add samples to project.
2. Find the data that you want to analyze.
   a. In the tree pane (right side of the workspace), click a folder to select it.
   b. Click Add to list to add the files contained in the folder.
      The files should appear in the list of files (left side of the workspace).
3. After adding all relevant files, click Add to add the files to the project.

Analyzing SNPlex System Data

GeneMapper Software v4.0 provides two methods for analyzing SNPlex System data, based on the clustering algorithms used to calculate the SNP quality. For more information about analysis methods, refer to Appendix B.

To analyze SNPlex System data:

1. Before proceeding with analysis, check to see that:
   • Samples have the correct sample type designations
     – Allelic ladder samples are labeled as “allelic ladder”.
     – No-template control samples are labeled as “negative controls”.
     – All other samples are labeled “sample”.
   • Analysis Method is set to SNPlex_Model_3730, SNPlex_Rules_3730, or SNPlex_Rules_3130 for all samples
   • Panel is set to SNPlex_48plex_Panel_3730 or SNPlex_48plex_Panel_3130 for all samples
   • Size Standard is set to SNPlex_48plex_v1 for all samples
   • SNP Set is set to the appropriate SNP set for each sample
2. Click (Analysis > Analyze Samples).
Reviewing Results

Data quality is most effectively reviewed using the Study Manager as described in Chapter 5, “Troubleshooting.” However, it is good practice to review sizing quality and allelic ladder performance at this stage.

- **Review the sizing quality (SQ)** — Any sample that fails sizing is not used in the analysis.
  
  Select Analysis > Size Map Editor, then observe if the SQ values for size standards passed.
  
  For more information about sizing quality, refer to “Reviewing Size Standard IQC Values” on page 5-12.

- **Review the allelic ladders** — Allelic ladder samples that do not pass the well quality (WQ) parameter are not included in the analysis. Check binning even for allelic ladder samples with passing WQs.
  
  Select Analysis > Display Plots, then observe if:
  
  - Each bin contains a single allelic ladder peak.

  - Each bin contains a single peak, except for the following bins, which should be empty:
    
    - Blue ladder: gray bin for M5.1_CTL_002_PHC
    - Blue ladder: pink bin for M5.1_CTL_001_NHC
    - Green ladder: gray bin for M5.1_CTL_004_PHC
    - Green ladder: pink bin for M5.1_CTL_003_NHC
For more information about allelic ladders, see “Reviewing Ladder IQC Values” on page 5-10.

- **Review the cluster plots.**
  Select **Analysis > Display Cluster Plots**, then observe if:
  - Clusters are tight.
  - Signal strength is consistent.
  - There are any calls that you want to edit.
  For more information about cluster plots, see “Reviewing Cluster Plots” on page 5-23.

### Exporting SNPlex System Data

To export:

- Genotype information – Select the **Genotype** tab, then select **File > Export Table**.
- Sample information – Select the **Sample** tab, then select **File > Export Table**.
- Both genotype and sample information – Select **File > Export Combined Table**.
- SNP Table – Once the cluster plot has been selected, select **File > Export Table**.

**Note:** When exporting both types of information, you can select **File > Export Combined Table** regardless of which tab you are viewing.

You can also use the Report Manager feature of GeneMapper Software v4.0 to generate multi-column, custom reports from the data in the sample and genotype tables.

For more information about exporting SNPlex System data, refer to the GeneMapper software online help.
This chapter covers troubleshooting SNPlex results using the GeneMapper ® Software v4.0 Study Manager.

Troubleshooting Overview ........................................... 5-2
Checking File Structure ............................................. 5-3
Reviewing Raw Data .................................................. 5-4
Adding Runs to the Study Manager ............................. 5-8
Reviewing IQC Metrics ............................................... 5-9
Reviewing Cluster Plots .............................................. 5-23
Reviewing SQC Values ............................................... 5-28
Troubleshooting Overview

You can use the GeneMapper® Software v4.0 Study Manager to troubleshoot SNPlex™ System results. In the Study Manager you create a study (a set of GeneMapper projects, or runs, grouped together for fast process analysis and data review), then use quality control metrics to evaluate SNPlex results.

The Study Manager includes a set of initial quality control (IQC) metrics that apply to both run- and plate-level measurements. IQC metrics evaluate the process of generating SNPlex system data, rather than evaluating genotyping results, which are addressed with secondary quality control (SQC) metrics. Process issues addressed by the IQC metrics are injection variability, problems with binding and hybridization on the streptavidin plate, and other assay chemistry and/or DNA problems.

SQC metrics test genotype reproducibility in replicate samples and Hardy-Weinberg criteria. These tests are applied to single runs as well as multiple runs in a study.

Note: The GeneMapper® Software Version 4.0 Microsatellite Analysis Getting Started Guide (PN 4363095) provides a tutorial with sample data. If you are new to the functionality of the study manager, review this document before proceeding with SNPlex troubleshooting.

Troubleshooting Workflow

Follow these steps to troubleshoot and monitor the processing of SNPlex System data:

1. Verify that SNPlex System data are collected and stored with the correct file structure.
2. Review raw data for obvious process and/or instrument errors.
3. Add analyzed SNPlex System projects to the Study Manager.
4. Review IQC metrics for indications of process parameters that are outside the expected range.
5. Review Cluster Plots.
6. Review SQC metrics for indications of genotyping results that are outside expected behavior.

Note: Failures in IQC or SQC metrics do not necessarily indicate unreliable or failed genotyping. Rather, they indicate certain parameters that are outside the expected limits. The IQC and SQC thresholds can be adjusted either globally for all projects or on a per study basis; these thresholds can be “dialed in” to match the performance requirements of each individual user or laboratory.
Checking File Structure

File structure requirements:

- Data from each run on the 3730, 3730xl, or 3130xl instrument must be collected into a separate data folder. If your data are not automatically collected into separate data folders:
  - Sort the files by date
  - Manually separate the data collected from multiple runs
  - Place the files into individual folders before GeneMapper software analysis

- Each run should contain at least one allelic ladder well.
  - If you use a 3730xl instrument, each run folder should contain 96 sample files, two of which should be from wells designated as allelic ladder wells.
  - If you use a 3730 instrument, each run folder should contain only 48 sample files, two of which should be from wells designated as allelic ladder wells.
  - If you use a 3130xl instrument, each run folder should contain only 16 sample files, one of which should be from a well designated as allelic ladder.
Following these requirements allows the GeneMapper Software v4.0 to adjust the allele bins for an individual run. If data are not collected using this structure, allele binning errors are possible.

**Note:** See “Creating Results Groups and Plate Records” on page 3-31 for a discussion of file structure and methods for setting up the correct structure automatically.

## Reviewing Raw Data

Review the raw (unanalyzed) data to identify obvious process and/or instrument errors in SN Plex System data. While it may be neither feasible nor necessary to review the raw data from all SN Plex system runs, a systematic review of the data may result in identifying the following problems:

- Missing Allelic Ladders
- Missing Size Standard
- Overall low or off-scale signal intensity
- Poor resolution
- Incorrect or poor spectral calibration
- Injection failures
- Assay failures

To view raw data in GeneMapper, open an existing project, or add samples to a new project, and select **View > Raw Data**. Scroll up and down the list of samples to review the unanalyzed electropherograms from many samples checking elements listed in **Table 5-1**.

### Table 5-1 Raw data to review

<table>
<thead>
<tr>
<th>Sample(s) to Review</th>
<th>Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allelic Ladder</td>
<td>Data from the allelic ladder(s) present (see “Reviewing Allelic Ladders: Signal Strength” on page 5-5)</td>
</tr>
<tr>
<td>Allelic Ladder</td>
<td>Typical peak height from the allelic ladder(s) in the range 1500 to 5000 RFU for the 3730/3730xl instrument or 300 to 1500 RFU for the 3130xl instrument (see “Reviewing Allelic Ladders: Signal Strength” on page 5-5)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Action if Fail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add allelic ladder to appropriate wells and rerun the electrophoresis (see “Preparing Samples for Electrophoresis” on page 3-29)</td>
</tr>
<tr>
<td>Confirm proper dilution of allelic ladder (see “Preparing Samples for Electrophoresis” on page 3-29)</td>
</tr>
<tr>
<td>Adjust injection time between 5s and 15s if significantly outside expected intensity range (see “Out-of-range signal strengths” on page 5-6)</td>
</tr>
</tbody>
</table>
### Reviewing Raw Data

**Note:** To return to the samples view, select **View > Samples.**

#### Table 5-1 Raw data to review

<table>
<thead>
<tr>
<th>Sample(s) to Review</th>
<th>Check</th>
<th>Action if Fail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allelic Ladder</td>
<td>All peaks well resolved (see “Reviewing Allelic Ladders: Resolution” on page 5-7)</td>
<td>Verify proper array conditioning if new array (see “Preconditioning the Capillary Array” on page 2-6)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Verify proper instrument maintenance (fresh polymer, buffer, and clean septa, for example)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If more than 300 runs have accumulated on the current array, verify array performance with sequencing standard</td>
</tr>
<tr>
<td>All Wells</td>
<td>Size Standard visible in all wells (11 orange peaks) (see “Reviewing Allelic Ladders: Signal Strength” on page 5-5)</td>
<td>Confirm that size standard was added during ZipChute elution (see “Preparing the Sample Loading Mix” on page 3-27)</td>
</tr>
<tr>
<td>All Wells</td>
<td>Minimal or no visible spectral pull-up or pull-down (see “Reviewing All Wells: Spectral Calibration” on page 5-8)</td>
<td>Repeat spectral calibration if excessive spectral errors are observed (see “Performing a Spectral Calibration” on page 2-7) and rerun the assay plate</td>
</tr>
<tr>
<td>Sample Wells</td>
<td>Assay peaks in sample wells (blue and green peaks)</td>
<td>Remove bad wells from project and reanalyze data in GeneMapper software</td>
</tr>
</tbody>
</table>
| Sample Wells         | Data saturated  
- 3730/3730xl instrument – Many peaks reaching 32000 RFU  
- 3130xl instrument – Many peaks reaching 8000 RFU | Confirm correct volume of PCR product transfer (see “Binding PCR Products to the Hybridization Plate” on page 3-24)  
Rerun plate with lower injection time (see “Out-of-range signal strengths” on page 5-6) |

#### Normal signal strengths

Typical signal strengths for ZipChute™ probes in the allelic ladder are between 1500 and 5000 RFUs (3730/3730xl instrument) or 300 to 1500 RFUs (3130xl instrument), as shown in **Figure 5-2.** Signals that are slightly outside of this range may still be considered normal. Also, signal strength can vary between instrument types and between instruments of the same type.

Although signal strengths significantly outside these ranges do not necessarily mean that samples will fail, you should consider signal strength when adjusting run conditions for future runs. However, if signals for the allelic ladder are offscale, you must rerun samples.
Out-of-range signal strengths

If the signal strength is significantly outside the expected range:

1. Confirm that the Allelic Ladder is appropriately diluted (see “Preparing Samples for Electrophoresis” on page 3-29).

2. If the allelic ladder is appropriately diluted, adjust the injection time to compensate for instrument-to-instrument variation.

**Note:** The default injection time for the SNPlex System module is set to 10 s at 1 kV. Increasing the injection time increases the signal strength; decreasing the injection time decreases the signal strength.

**Note:** Applied Biosystems recommends that you keep injection times between 5 and 15 seconds. Injection times outside this range result in poor resolution.

   a. Start the Data Collection software.
   b. Open the Module Manager, then click **New**.
   c. Enter new injection data using the Run Module Editor:
      - Name – Enter a name for the module.
      - Type – Select **Regular**.
      - Template – For Data Collection v2.0, select **HTSNP_POP7_V2**.
        For Data Collection v3.0, select **HTSNP_POP7_V3**.
      - Injection Time – Enter a new injection time between 5 and 15 seconds.
   d. Click **OK** to save the module.
Reviewing Raw Data

e. Open the Protocol Manager.

f. Create a new protocol using the module you just created. Alternatively, edit an existing protocol by replacing the currently selected module with the module you just created.

Reviewing Allelic Ladders: Resolution

Note that new arrays must always be preconditioned (see “Preconditioning the Capillary Array” on page 2-6) Failure to precondition a new array results in poor resolution and inconsistent signal strength. Figure 5-3 shows poor resolution for a non-conditioned capillary.

Figure 5-3 Raw data view of an allelic ladder showing poor resolution and loss of signal

If your raw data displays poor resolution:

- Ensure that all reagents in the instrument are fresh and that regular maintenance has been performed. Refer to the Applied Biosystems 3730/3730xl DNA Analyzer Getting Started Guide or the Applied Biosystems 3130/3130xl DNA Analyzer Getting Started Guide.
- Precondition arrays before filling them with polymer or running samples. Refer to “Preconditioning the Capillary Array” on page 2-6.
- In cases where only one of several runs that were processed simultaneously shows poor resolution, try reinjecting samples a second time.
Reviewing All Wells: Spectral Calibration

Pull-up or pull-down peaks in raw data indicate problems with spectral calibration (Figure 5-4).

![Figure 5-4 Raw data view of allelic ladder showing pull-down peaks](image)

If you observe spectral errors in a significant number of capillaries, repeat the spectral calibration as described in “Performing Spatial and Spectral Calibrations” on page 2-7. When you have successfully completed a spectral calibration, rerun the SNPlex assay plate.

Refer to the *Applied Biosystems 3730/3730xl DNA Analyzer Getting Started Guide* or the *Applied Biosystems 3130/3130xl DNA Analyzer Getting Started Guide* for more information about running and troubleshooting spectral calibrations.

Adding Runs to the Study Manager

**IMPORTANT!** Before adding runs to the Study Manager, analyze data with either the Rules or Model analysis methods using the appropriate SNP Set, as described in Chapter 4, “Analyzing Data Using GeneMapper Software.”

1. Close any open projects by selecting **File > New Project**.
   
   **Note:** You cannot view projects simultaneously in the Project and Study Manager windows.

2. Select **Tools > Study Manager** to open the Study Manager.

3. Click the **Add Projects** button (**File > Add Projects**).

4. Click **Search** to see a list of all available projects.

5. Check the boxes to the left of the project(s) to add.
   
   **Note:** Checkboxes of projects belonging to existing studies are greyed out.

6. Click **OK**, name the study, click **OK**, and then click **OK** after all projects have been added to the study.
After you have added projects to the Study Manager, the General tab displays information about the number of runs in the study and the number of runs that passed or failed either IQC or SCQ analysis. The Runs tab displays detailed information about each run, including ICQ and SQC status.

**Note:** In order to place a project in multiple studies, create multiple copies of the project using the Save As function in the GeneMapper Manager.

### Reviewing IQC Metrics

#### Purposes of IQC Metrics

The IQC metrics are used to evaluate the processing of SNPllex System plates, not genotyping results. Use IQC metrics to evaluate the following:

- Allelic ladder
  - Pass/fail status
  - Allele bin offset
- Size standard
  - Pass/fail status
  - Average signal
  - Signal variability
- Positive hybridization control
  - Average signal
  - Signal variability
- Assay results
  - Average signal
  - Signal variability
  - Out-of-bin peaks

Excessive signal variability indicates potential problems with specific steps in the SNPllex System assay. You can use signal variability as a troubleshooting aid: When you add multiple runs to a study, you can monitor run-to-run trends in the assay signals to evaluate process stability over time.

#### About Review Modes

You can review IQC results either in *symbols mode*, where pass/fail status is indicated by a green or red symbol respectively, or in *numbers mode*, where the specific IQC values are displayed. Use symbols mode for an at-a-glance evaluation of the runs in the Study. Use numbers mode to watch for trends in IQC values over several runs to determine if laboratory processes are unstable.

**Note:** In numbers mode, it is convenient to export the IQC table and use it to plot trended data for later viewing.
Chapter 5  Troubleshooting

Changing Review Modes

To change between symbols and numbers mode for viewing IQC results:

1. Select the Project Window by clicking in the main GeneMapper window.
2. Select Tools > Options.
3. Select the Analysis tab.
4. Select either Symbols or Numbers in the Quality Metrics Display section.
5. Click OK.

Review Strategy

A recommended strategy for reviewing IQC values is outlined in the tables in the following sections. Pass/Fail settings, significance of failure, and recommended actions are included in the tables. The review strategy is based on “backing in” to the SNPlex assay process, looking first at the steps that occur last in the protocol. Issues affecting the allelic ladder, the last reagent added to the plate, can cause problems with correctly identifying peaks in all wells of a run. Problems with injection are indicated by low and/or variable signal in the size standard, positive hybridization control (PHC), and assay signals. Problems with the binding and hybridization manifest as low signal and/or high variability on the PHC and assay signals across the plate, with size standard signal relatively unaffected. Problems with DNA, OLA and PCR appear as low and/or variable assay signals, with PHC and size standard behavior unaffected. The following troubleshooting workflow uses the “backing in” concept to troubleshoot with the Study Manager:

1. Review Ladder IQC values to verify minimum passing ladders and acceptable bin offsets.
2. Review Size Standard IQC values for number of sizing failures, average size standard signal per run, and within run variability in size standard signal.
3. Review PHC IQC values for average PHC signal per run and within run variability in PHC signal.
4. Review Assay IQC values for average Assay signal per run and within run variability in Assay signal.
5. Review Signals Plot for indications of low intensity and/or excessive variability in size standard, PHC, and assay signals on a per run basis.
6. Review plate views of various IQCs patterns that might indicate problems with sample handling and transfer equipment.

Reviewing Ladder IQC Values

About Ladder IQC Values

Two IQC values are related to allelic ladder performance: # Failed and Binning. Acceptable performance of the allelic ladder wells in SNPlex System analysis is critical for reliable genotyping. GeneMapper adjusts the position of each allele bin based on the mobility of each peak in the allelic ladder relative to the size standard peaks. As laboratory conditions (including buffer temperature and polymer age) change, bin positions can change slightly. Including an allelic ladder well in each run allows unique bin offsets (the correction from the default bin positions) to be applied to each allele individually on a per run basis. If no ladders pass in any single run, no offsets are applied, with the likely result of incorrect allele identification. This condition will be indicated by a red light in the Ladders: # Fail IQC column.
The Ladders: Binning IQC value indicates the magnitude of the offsets required to locate all the peaks in the allelic ladder. Larger offsets typically indicate polymer that has been sitting at room temperature more than one week. Failure in the Ladders: Binning IQC column reminds the user that the offsets are larger than expected, and that it may be time to change the polymer. If the offsets are too large, the ladder well ultimately fails, triggering the Ladders: # Fail IQC flag. Details of the Ladders IQC metrics are summarized in the following table.

### Table 5-2 Ladder IQC values

<table>
<thead>
<tr>
<th>IQC</th>
<th>Pass Setting</th>
<th>Significance</th>
<th>Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td># Failed</td>
<td>Passes if at least one allelic ladder passes (WellQ &gt; 0.92) with mean signal &gt;250 RFU (3730 and 3730xl) or &gt;100 RFU (3130xl)</td>
<td>Critical that at least 1 ladder pass per run. Failing or missing ladders can result in binning errors and misidentified allele peaks.</td>
<td>Review traces from failing ladders. If failing due to missing ladders, remake ladder wells and rerun the plate. If failing due to WellQ&lt;0.92, replace old polymer and rerun plate.</td>
</tr>
<tr>
<td>Binning</td>
<td>Passes if all bin offsets are within +/- 0.5 sizing units of default position</td>
<td>Failure indicates larger than expected bin offsets, typically caused by polymer stored at RT for more than 1 week. Usually OK but can result in binning errors.</td>
<td>Review Ladder Binning Test Details to see magnitude of offsets applied. Review traces from failing ladders to ensure proper binning (Figure 5-5 on page 5-12). Replace polymer in the next few days.</td>
</tr>
</tbody>
</table>

a. You can change all IQC and SQC pass settings to suit your particular needs. See page 79 in the GeneMapper® Software Version 4.0 Microsatellite Analysis Getting Started Guide for further information on pass settings.

### Reviewing Failed Ladders

To review allelic ladder traces from the Study Manager, select the run of interest from the Initial QC tab and click the Open Project Window button in the lower right corner of the window. The GeneMapper Project Window contains all the runs associated with that particular project.

Check the well quality (WellQ) for allelic ladder wells in the Samples tab of the open project window. Allelic ladder wells fail if the WellQ is less than 0.92. Low ladder WellQ values are typically caused by using polymer that has been at room temperature in excess of one week. In most cases, installing fresh polymer using the Polymer Change Wizard results in passing ladders.

To confirm correct ladder binning:

1. Highlight the allelic ladder well(s) in the Project Window
2. Select Display Plots from the Analysis menu.
3. Click the Binning Mode icon (second from the right).
4. Confirm that all green and blue peaks fall into bins (see Figure 5-5 on page 5-12).
5. Close project window by selecting File > Close Project.
Figure 5-5  Good allelic ladder sample with even signal and accurate binning

**Note:** In order to have full access to the Study Manager's functionality, the Project Window must be closed. After reviewing failed ladders, select **File > Close Project**.

For more information using reviewing Ladder IQCs, refer to page 62 in the *GeneMapper® Software Version 4.0 Microsatellite Analysis Getting Started Guide*.

**Reviewing Size Standard IQC Values**

**About Size Standard IQC Values**

There are three IQC values associated with size standard performance: # Failed, Average, and CV.

A size standard is included in every well in a SNPlex system plate, including sample wells, allelic ladder wells, positive control wells, and no-template control (NTC) wells. The size standard allows the GeneMapper software to determine the relative mobility, or size, of the allele peaks in each well. Failure of the size standard in any well results in no further processing of data from that well. The Size Standard: # Fail IQC is set to trigger a red light when more than one well in any run fail sizing for data collected on the 3130xl instrument, or when more than five wells fail for data collected on the 3730/3730xl instrument.

Because the size standard is the last reagent added in the SNPlex system protocol, the overall height and well-to-well variability of the size standard peaks should be largely unaffected by any upstream processes. Problems with size standard intensity and variability, then, are likely due to potential problems with dilution, injection or detection, rather than to any SNPlex system chemistry issues. Injection or detection problems affecting the size standard signal affect the signals from the assay and positive hybridization controls (PHC). Remedy these problems to achieve the highest quality SNPlex system data.

The Size Standard: Average IQC alerts the user to lower-than-expected average intensity in the size standard. A run average value of size standard peak height is calculated using the first sizing peak in each well. A red light is generated if the average intensity within a run is less than 100 RFU on the 3130xl instrument or 250 RFU on the 3730/3730xl instrument. Although the peak detection threshold is set
lower than this IQC threshold in the GeneMapper SNPlex System analysis methods, the expected average signal intensity is higher than this detection limit. Some instrument-to-instrument differences in signal intensity is normal; the Size Standard:Average IQC trigger serves as an alert that the value is outside the expected range.

Some signal variability from capillary-to-capillary is expected. The Size Standard: CV IQC alerts to user if the peak height variability between capillaries of any single run is larger than expected. As described above, SNPlex-specific chemistry issues are not expected to affect variability in the size standard.

The within-run variability of the first size standard peak is calculated as the percent CV (100 * standard deviation / average). A CV exceeding 30% triggers a red light in the CV IQC. Large variability can be caused by injection failures, array issues, optical misalignment, dirty septa (both on the sample as well as waste, water, and buffer trays), or differences in salt concentration in the various wells.

Table 5-3  Size Standard IQCs

<table>
<thead>
<tr>
<th>IQC</th>
<th>Pass Settinga</th>
<th>Significance</th>
<th>Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td># Failed</td>
<td>Passes if no more than 1 (3130x/instrument) or 5 (3730/3730x/instrument) wells in any run fail sizing</td>
<td>Failure results in no genotypes reported for the failing wells, for sample wells, or ladder failure for allelic ladder wells</td>
<td>• Select affected run and click Open Project Window</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Review size standard trace using the Size Match Editor button in the Project Window</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(See “Reviewing Size Standards” below)</td>
</tr>
<tr>
<td>Average</td>
<td>Passes if average height of the 1st sizing peak, across all wells in a run, is greater than 100 RFU (3130x/instrument) or 250 RFU (3730/3730x/instrument)</td>
<td>Failure indicates improper dilution of size standard, degraded size standard sample, or a problem with array or CE instrument (optical alignment or contaminated septa, for example)</td>
<td>• Verify Size Standard dilution</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Verify proper maintenance of CE instrument (fresh buffer, water and waste, clean septa)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Run validation plate as described in Chapter 2 to verify instrument performance</td>
</tr>
<tr>
<td>CV</td>
<td>Passes if the well-to-well variability in size standard peak height is 30% or less</td>
<td>Failure indicates greater than expected variability in size standard signal due to injection variability (salt contamination of certain wells) or a problem with the array or CE instrument</td>
<td>• Verify proper maintenance of CE instrument (fresh buffer, water and waste, clean septa, etc.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Run validation plate as described in Chapter 2 to verify instrument performance</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Review “Signals Plot” and “Plate Views” as described below</td>
</tr>
</tbody>
</table>

a. You can change all IQC and SQC pass settings to suit your particular needs. See Chapter 3 in the GeneMapper® Software Version 4.0 Microsatellite Analysis Getting Started Guide for further information on pass settings.

Reviewing Failed Size Standards

To review size standard traces from the Study Manager, select the run of interest from the Initial QC tab and click the Open Project Window button in the lower right corner of the window. The GeneMapper Project Window containing all the runs associated with that particular project opens.
To observe the detailed performance of any sizing failure:

1. Highlight the well(s) of interest in the Project Window.
2. Select **Size Match Editor** under the Analysis menu.
3. Click the Size Matches tab.
4. Confirm that all 11 peaks are present, and that all peaks are of relatively even peak height.
5. Confirm that all 11 peaks are above the detection threshold for the particular instrument (25 RFU for the 3130xl instrument and 50 RFU for 3730/3730xl instrument).

Missing peaks or peaks below the threshold could indicate a problem with one of the reagents (SLR or Size standard) or a possible problem with the CE instrument. Instrument problems can best be evaluated by running a “validation plate” as described on “Validating Instrument Performance” on page 2-11.

Wells showing a fraction of the 11 peaks below the detection threshold can often be rescued by lowering the detection threshold for the orange dye and reanalyzing the data. This procedure is detailed in “Reviewing the Size Standard IQC” on page 68 in the *GeneMapper® Software Version 4.0 Microsatellite Analysis Getting Started Guide*. 
Example: Good Sizing Quality

Figure 5-6 shows a size standard with good sizing quality. Note the even peak height and low background.

Figure 5-6  Size standard with good sizing quality

Example: Poor Sizing Quality

Figure 5-7 shows a size standard with poor sizing quality. Note the low signal in the figure below.

Figure 5-7  Size standard with poor sizing quality
There are three IQCs associated with the Positive Hybridization Control (PHC): Average, CV, and Normalized CV.

The PHC IQC metrics focus on processes involving the hybridization plate. These processes include binding of the biotin labeled PHCs to the streptavidin plate, hybridization of the PHC ZipChutes to the bound PHCs, elution of the PHC ZipChutes, various plate washing steps, and detection on the electrophoresis instrument. Signal intensity and variability of the PHC peaks are expected to be unaffected by upstream SNplex chemistry steps, including DNA quantitation, OLA, and PCR.

The PHC: Average IQC value alerts you to lower-than-expected average intensity observed in the PHC. A run-average value of the PHC is calculated using both PHC peaks in all wells. A red light is generated if the average intensity within a run is less than 100 RFU (3130xl instrument) or 200 RFU (3730/3730xl instrument). A low average-PHC value may indicate inefficient binding and/or hybridization. Inefficient hybridization can result in poorly defined clusters having low intensities.

Some signal variability from capillary to capillary is to be expected. The PHC: CV IQC alerts you that PHC signal variability between wells of any single run is larger than expected. PHC variability is a function of binding and hybridization steps as well as injection and detection effects.
To isolate the variability associated with binding and hybridization, excluding that associated with injection and detection, a normalized PHC signal is calculated for each well by dividing the average PHC peak height by the height of the first Size Standard peak in that well. The variability of these normalized PHC signals is reported as the PHC: Normalized: CV. It is expected that the variability in the normalized PHC will be less than that in the “raw” PHC, because the injection and detection component has been removed.

Table 5-4 PHC IQCs

<table>
<thead>
<tr>
<th>IQC</th>
<th>Pass Setting*</th>
<th>Significance</th>
<th>Action(s)</th>
</tr>
</thead>
</table>
| Average       | Passes if average height of the PHC peaks, across all wells in a run, is greater than 100 RFU (3130x/ instrument) or 200 RFU (3730/3730x/ instrument) | Low PHC signal may indicate inefficient binding and/or hybridization, conditions that can result in low assay signals, fuzzy clusters and failing SNPs | • Check for expected average size standard signal  
• Check for proper dilution of the PHC (see page 3-23)  
• Verify that correct buffers were used in the hybridization steps - Binding Buffer and Dilution Buffer bottles look very similar  
• Verify correct plate shaker and oven settings (see “Hybridizing PCR Products to ZipChute Probes” on page 3-23)  
• Verify that plate washer is not aspirating the wells to dryness between washes  
**Note:** It is better to leave behind some residual liquid, then prior to eluting the ZipChutes, remember to spin the plates upside down on a paper towel to remove any remaining wash buffer (page 3-28). |
| CV            | Passes if the well-to-well variability in PHC peak height is 50% or less        | Excessive variability in the PHC usually results in excessive variability in the assay signals. This variability can cause low assay signals in affected wells, fuzzy clusters and failing SNPs. | Verify that plate washer is not aspirating the wells to dryness between washes  
Stabilize and troubleshoot binding and hybridization steps using PHC only (leave out valuable PCR product).  
Review “Reviewing the Signals Plot” on page 5-21 and “Plate Views” on page 5-22. |
| Normalized CV | Passes if the well-to-well variability in normalized PHC peak height is 40% or less |                                                                                                                                                  |                                                                                                                                                  |

a. You can change all IQC and SQC pass settings to suit your particular needs. See Chapter 3 in the GeneMapper® Software Version 4.0 Microsatellite Analysis Getting Started Guide for further information on pass settings and reviewing PHC IQC values.
Reviewing Assay IQC Values

There are four IQCs associated with the assay signals: Average, CV, Normalized CV, and Sample Binning.

An assay signal intensity is assigned to each well. Assay signal intensity is the median height of all peaks that are found in allele bins for a particular pool. For example, the assay intensity in each well of a 48-plex pool is the median of the peak heights found in the 96 allele bins used by that pool. A 46-plex pool uses the median of the 92 allele bins defined by the smaller pool. An average assay signal for each run is calculated using the assay signal intensity values for wells designated as “Sample” or “Positive Control” in the GeneMapper Sample Sheet. Wells designated as “Allelic Ladder” and “Negative Control” are excluded from all four Assay IQCs. A red light will be generated in the Assay: Average IQC if the average intensity within a run is less than 100 RFU (3130XL instrument) or 250 RFU (3730/3730xl instrument).

The Assay: CV IQC alerts you that assay signal variability between wells of any single run is larger than expected. Assay CV includes variability from all aspects of the SNPlex System, including DNA quality and quantity, OLA, exonuclease cleanup, PCR, binding and hybridization, and injection and detection.

To isolate the variability associated with the SNPlex assay steps, excluding that associated with post-PCR processes, a normalized assay signal is calculated for each well by dividing the assay signal intensity by the PHC signal in each well. The variability of these normalized assay signals is reported as the Assay: Normalized: CV. It is expected that the variability in the normalized assay signal will be less than that in the raw assay signal, because the post-PCR component has been removed.

The Assay: Binning IQC serves to alert the user if a significant number of peaks in the electropherogram lie outside of allele bins. A large number of peaks that are not in bins indicates incorrect bin offsets being applied, and review of the allelic ladder binning is required (see “Reviewing Ladder IQC Values” on page 5-10).

Table 5-5 Assay IQC Values

<table>
<thead>
<tr>
<th>IQC</th>
<th>Pass Settinga</th>
<th>Significance</th>
<th>Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average</td>
<td>Passes if average assay signal, across all wells in a run, is greater than 100 RFU (3130xl instrument) or 250 RFU (3730/3730xl instrument)</td>
<td>Low average assay signal can result in fuzzy clusters and poor performing SNPs.</td>
<td>Check for expected average signal in the size standard and PHC (see Table 5-6 on page 5-20)</td>
</tr>
</tbody>
</table>
| CV                | Passes if the well-to-well variability in assay signal is 60% or less | High variability in assay signal may indicate large fraction of poorly performing wells | • Check for expected variability in the size standard and PHC  
                    |                                                        | Note: Low intensity wells can lead to increased SNP failure rate, and false positive genotype calls assigned to empty wells. | • Review “Signals Plot” as described below. (See Table 5-7 on page 5-21) |
| Normalized CV     | Passes if the well-to-well variability in normalized assay signal is 50% or less |                                                                       |                                                                          |
### Table 5-5 Assay IQC Values

<table>
<thead>
<tr>
<th>IQC</th>
<th>Pass Setting^</th>
<th>Significance</th>
<th>Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Binning</td>
<td>3730/3730xl instrument</td>
<td>Failure indicates possible binning errors that can lead to the misidentification of alleles and genotyping errors.</td>
<td>• Review Ladder Binning Test Details to see magnitude of offsets applied</td>
</tr>
<tr>
<td></td>
<td>3130xl instrument</td>
<td></td>
<td>• Review traces from failing ladders to ensure proper binning (see “Reviewing Failed Ladders” on page 5-11)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Review negative hybridization control behavior in Signals Plot (see “Reviewing the Signals Plot” on page 5-21)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Run “blank” plate (SLR only) to ensure that the instrument is clean and that no extra peaks appear as a result of contamination</td>
</tr>
</tbody>
</table>

a. You can change all IQC and SQC pass settings to suit your particular needs. See Chapter 3 in the GeneMapper Software Version 4.0 SNPlex System Analysis Getting Started Guide for further information on pass settings and reviewing PHC IQC values. You can reduce the default “Number of Peak Threshold” and “Peak Height Threshold” settings in the Assay Sample Binning IQC to two (2) peaks and 250 RFU (100 RFU for the 3130xl instrument) in order to increase the sensitivity to out-of-bin peaks.
If the average assay signal is low, but both the size standard and PHC signals are within the expected range, check the following items.

**Table 5-6 Troubleshooting a low/average assay signal**

<table>
<thead>
<tr>
<th>Potential Cause</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insufficient DNA</td>
<td>Confirm that input quality and quantity of DNA is adequate</td>
</tr>
<tr>
<td>Incomplete or excessive DNA fragmentation</td>
<td>Check distribution of DNA fragments on agarose gel</td>
</tr>
<tr>
<td>DNA contains OLA inhibitors</td>
<td>Repurify DNA</td>
</tr>
<tr>
<td>Used plate cover that is incompatible with the SNplex System assay</td>
<td>Use recommended plate cover (see Table 1-2 on page 1-9)</td>
</tr>
<tr>
<td>Concentration of OLA probe, ligase, or PCR components is too low</td>
<td>Verify that quantities and concentrations of components used are as specified in the protocol</td>
</tr>
<tr>
<td>Incorrect OLA or PCR thermal cycling conditions</td>
<td>Ensure that thermal cycling conditions used are as specified in the protocol</td>
</tr>
<tr>
<td>Exonuclease step omitted</td>
<td>Repeat experiment with exonuclease step</td>
</tr>
<tr>
<td>Exonuclease mix kept at room temperature for more than 1 hour before use</td>
<td>Prepare fresh exonuclease mix and repeat experiment</td>
</tr>
<tr>
<td>Insufficient PCR product transferred during post-PCR step</td>
<td>Check protocol – evaluate and optimize pipetting accuracy in assay workflow</td>
</tr>
<tr>
<td>Sodium hydroxide denaturation step omitted</td>
<td>Repeat experiment with sodium hydroxide denaturation step</td>
</tr>
</tbody>
</table>
If the variability in the assay signal is too high and the variability in the size standard and PHC are normal, check the following items.

**Table 5-7** Troubleshooting excessive variability in the assay signal

<table>
<thead>
<tr>
<th>Potential Cause</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insufficient DNA in wells with low signal</td>
<td>Confirm that input quantity of DNA is adequate</td>
</tr>
<tr>
<td>Incomplete or excessive DNA fragmentation</td>
<td>Check distribution of DNA fragments on agarose gel</td>
</tr>
<tr>
<td>DNA contains OLA inhibitors</td>
<td>Repurify DNA</td>
</tr>
<tr>
<td>Pipetting errors during OLA, PCR, exonuclease digestion, or PCR transfer for wells with low signal</td>
<td>Evaluate and optimize pipetting accuracy in assay workflow</td>
</tr>
</tbody>
</table>

**Reviewing the Signals Plot**

The Signals Plot displays the Size Standard, Positive Hybridization Control (PHC), Assay, and Negative Hybridization Control (NHC) well values for a particular run, overlaid in a single graph. Reviewing the signals plot for each run in the study gives a snapshot of performance in terms of the relative intensity and variability in these four signals. As described above, excess variability that can be isolated to the Size Standard, PHC, and Assay signals help to identify potential problems with injection, binding and hybridization, and SNPlex chemistry, respectively.

Access the signal plot by navigating to the Initial QC tab in the Study Manager and clicking the Test Details button at the bottom of the window. Then select **Signals** in the pull-down menu in the upper right corner of the test details panel. You can view the Signals Plot either by capillary or by well by selecting the appropriate button in the plot window.

The size standard, PHC, assay, and NHC values are plotted in yellow, red, blue, and pink respectively. While some variability is to be expected, this plot can be used to observe excess variability and isolate it to a specific step in the SNPlex system by observing the behavior of the Size Standard, PHC and Assay signals as follows.

**Table 5-8** Troubleshooting issues raised in the signals plot

<table>
<thead>
<tr>
<th>Condition</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>High variability in Size Standard, PHC, and assay, and signals are correlated (in phase)</td>
<td>Likely source of variability is injection or detection related</td>
</tr>
<tr>
<td>Low signal variability in Size Standard signal but high, correlated variability in PHC and assay signals</td>
<td>Likely source of variability is related to binding and or hybridization to the streptavidin plate</td>
</tr>
<tr>
<td>Low variability in Size Standard and PHC signals, but high variability in assay signal</td>
<td>Likely problem with SNPlex system assay steps, including DNA (quality or quantity), OLA, cleanup, PCR or sample transfer errors</td>
</tr>
</tbody>
</table>
The NHC signal in the Signals Plot is typically low and flat, indicating low signal in the NHC bins, as expected. Strong signals in the NHC indicate potential binning errors that can lead to misidentification of alleles and genotyping errors. Review the allelic ladder traces to ensure proper binning.

For more information using the Signals Plot, please refer to page 92 in the *GeneMapper® Software Version 4.0 Microsatellite Analysis Getting Started Guide*.

**Plate Views**

Additional useful tools in the Study Manager are the plate view of the various signals in the IQC table. Size Standard, PHC (raw and normalized), and Assay (raw and normalized) can be plotted in plate format to look for nonrandom patterns in these signals. Such patterns might indicate a problem in the fluid handling system used. Access the plate view of a specific IQC signal by selecting a signal of interest and clicking the Test Details button.

For more information, please refer to Chapter 3 in the *GeneMapper® Software Version 4.0 Microsatellite Analysis Getting Started Guide*. 
Reviewing Cluster Plots

Reviewing cluster plots along with the Study Manager IQCs helps you narrow down the causes of a problem. Unexpected patterns in cluster plots can originate from components of SNPllex System chemistry, DNA quality, pipetting and liquid handling, robotics, and capillary electrophoresis.

The following sections present examples of typical patterns observed in cluster plots. The table following each plot describes possible causes when evaluated with the PHC, NHC, and size standard.

Example: Cluster Plots Showing Successful Assay Results

Figure 5-8 shows cluster plots from successful SNPllex System assays.

![Cluster plots from successful SNPllex System assays. A: Polar view; B: Cartesian plot view](image)
Example: Data Points Have Low Signal Intensity and Little to No Cluster Formation

Figure 5-9 illustrates cluster plots in which:

- Most of the data points have $\log_{10}$ intensity $<3$
- There are no clearly defined clusters

Action: Review “Assay Average” IQC (see Table 5-5 on page 5-18).

Example: Tight Clustering of Data Points with Few Low-Signal Intensity Outliers

Figure 5-10 on page 5-25 illustrates cluster plots in which:

- Most data points fall into tight, discernible clusters
- Several data points fall outside clusters (outliers)
- Clustered data points have signal intensity of $\log_{10} >3$
- Outliers have signal intensity of $\log_{10} <3$

In such cases, GeneMapper software is unable to identify clusters because of the presence of outliers.

This pattern suggests that the assay chemistry is working but that errors are occurring in specific samples. Delete the outliers and reanalyze your data. After the outliers are removed, the software correctly identifies the clusters.
Figure 5-10  Cluster plots with discernible clusters and low-signal intensity outliers

Action: Review “Assay CV” and “Assay Normalized CV” IQC (see Table 5-5 on page 5-18).

Example: Tight Clustering of Data Points with Outliers at Different Angles

Figure 5-11 illustrates cluster plots in which:

- Most data points fall into tight, discernible clusters
- Several data points fall outside clusters (outliers)
- All data points (clustered and outlying) have signal intensity of $\log_{10} > 3$
- Outliers are present in different angles, as measured in the polar plot

The vertical axis in the polar plot represents the angle, in radians, between the x-axis and the data points in the Cartesian plot. Data points that extend at a different angle in the plot may indicate:

- Sample contamination
- Secondary mutation close to the SNP site on one allele for a subset of the DNA samples
- Allele duplication
Figure 5-11  Polar plots with discernible clusters and outliers present at different angles

Example: Good Signal Intensity but Data Points Smeared Across Y-Axis (Angle); Poor Cluster Formation

Figure 5-12 illustrates cluster plots in which:

- All data points have signal intensity of $\log_{10} > 3$
- No discernible clusters are formed
- Samples appear to be smeared or stretched vertically in the polar plot

Figure 5-12  Cluster plots with good signal intensity but poor cluster formation
As illustrated in Figure 5-13, blue off-scale peaks in M5.1_023 cause a background signal due to the spectral pull-up in M5.1_044. As a result, angle differences occur during clustering for this marker, producing data points that are smeared along the Y-axis.

![Figure 5-13 Off-scale peaks cause spectral pull-up](image)

### Table 5-9 Troubleshooting cluster plots with good signal intensity but poor cluster formation

<table>
<thead>
<tr>
<th>Potential Cause</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNA samples contaminated with DNA of a different genotype.</td>
<td>Repeat experiment with uncontaminated DNA.</td>
</tr>
<tr>
<td></td>
<td>Decontaminate pipettors or robotic tips with 10% bleach solution.</td>
</tr>
<tr>
<td>Off-scale peaks result in spectral pull-up in a bin of a different color, causing angle distortion in the SNP clusters. See Figure 5-13 for further explanation.</td>
<td>Too much PCR product transferred to post-PCR step. Adjust amount of PCR product transferred to streptavidin plates.</td>
</tr>
<tr>
<td></td>
<td>Reduce injection time for capillary electrophoresis.</td>
</tr>
<tr>
<td></td>
<td>Additional dilution of samples with sample loading reagent containing size standard.</td>
</tr>
<tr>
<td>OLA probes are not specific to a unique locus—two different regions may be genotyped by one probe set.</td>
<td>SNP may not be assayable.</td>
</tr>
<tr>
<td><strong>Note:</strong> Strong possibility if nonhuman SNPs are assayed and no genome screen is available during probe design.</td>
<td></td>
</tr>
<tr>
<td>Used plate cover that is incompatible with the SNPlex System assay.</td>
<td>Use recommended plate covers (see Table 1-2 on page 1-9)</td>
</tr>
</tbody>
</table>
Reviewing SQC Values

The Secondary Quality Controls (SQC) are directed towards specific genotyping results rather than the process of generating SNplex data. Two tests are performed by the SQCs: a Replicates test and a Hardy-Weinberg Test. Both tests are applied within a single run (data from a single injection on a CE instrument) and across multiple runs defined in any study.

The replicates test compares genotype calls made on duplicate samples. By default, duplicate samples are defined as those having the same text entered in the Sample Name column of the sample sheet. You can also make use of the User Defined columns in the sample sheet to define replicate samples. Additionally, you can select samples manually for genotype comparison.

**Note:** If a replicated sample's genotype is undefined in one instance but generates a call in another instance, a fail will be triggered in the replicates test.

As this function is computationally intensive, especially for large projects, performance can be improved by turning off the replicates test in the Study Manager by selecting **Tools > Enable/Disable Modules**, and deselecting the replicates test(s).

Like the replicates test, the Hardy-Weinberg test is applied both within a single run and across multiple runs in a study. A fail will be generated for any SNP where the p-value is greater than the default values of 0.05 or 0.01 for a single run or across multiple runs, respectively. It is worth noting that at a p-value of 0.05, one would observe that 5% of “good” SNPs would fail this criterion by chance alone. Thus, it is best to use the Hardy-Weinberg test as a guide to review certain SNPs rather than to discard the genotypes from SNPs that fail the Hardy-Weinberg SQC test. Because a number of good SNPs are expected to fail by chance alone, many users find it more convenient to turn this test off in the Study Manager by selecting **Tools > Enable/Disable Modules**, and deselecting the Hardy-Weinberg test(s).
This appendix covers:

- Product Description .................................................. A-2
- About the Control Pool SNPs ........................................ A-2
- About the Dried gDNA Plate ....................................... A-4
- Using the Control Pool .............................................. A-5
- Expected Results ....................................................... A-5
Product Description

The SNPlex™ System Control Pool (PN 4362635) is a set of ligation probes that can be used together with the SNPlex™ System Dried gDNA Plates Kit (PN 4362637) to evaluate the performance of the SNPlex System. When used with SNPlex™ System kits and reagents, the ligation probes in the control pool detect 48 human SNPs in a single multiplex reaction.

About the Control Pool SNPs

The Control Pool SNPs

- Were selected from a list of SNPs for which validated TaqMan® assays were available
- Typically have a minor allele frequency of at least 0.1 in at least one of the following populations: African-American, Caucasian, Japanese, Chinese
- Were validated by individually genotyping 180 DNA samples selected from the four major populations with TaqMan® probe-based (5′-nuclease) assay

Table A-1 lists the 48 SNPs in the Control Pool.

Table A-1 48 SNPs in the SNPlex System Control Pool

<table>
<thead>
<tr>
<th>Zip #a</th>
<th>Celera Discovery System™ ID (hCV #)</th>
<th>SNP Consortium ID (TSC #)</th>
<th>dbSNP ID (rs #)</th>
<th>Minor Allele Frequency</th>
<th>Location†</th>
</tr>
</thead>
<tbody>
<tr>
<td>M5.1_001</td>
<td>hCV2058031</td>
<td>TSC0630913</td>
<td>rs1425151</td>
<td>0.23</td>
<td>0.26</td>
</tr>
<tr>
<td>M5.1_002</td>
<td>hCV7547436</td>
<td>TSC0691193</td>
<td>rs1457947</td>
<td>0.39</td>
<td>0.42</td>
</tr>
<tr>
<td>M5.1_003</td>
<td>hCV1901045</td>
<td>TSC0806211</td>
<td>rs1323881</td>
<td>0.29</td>
<td>0.20</td>
</tr>
<tr>
<td>M5.1_004</td>
<td>hCV7536854</td>
<td>TSC0556240</td>
<td>rs1388276</td>
<td>0.46</td>
<td>0.33</td>
</tr>
<tr>
<td>M5.1_005</td>
<td>hCV2597763</td>
<td>TSC0926934</td>
<td>rs1980408</td>
<td>0.12</td>
<td>0.23</td>
</tr>
<tr>
<td>M5.1_006</td>
<td>hCV2059319</td>
<td>—</td>
<td>—</td>
<td>0.43</td>
<td>0.31</td>
</tr>
<tr>
<td>M5.1_007</td>
<td>hCV8929459</td>
<td>TSC0339341</td>
<td>rs1035089</td>
<td>0.16</td>
<td>0.42</td>
</tr>
<tr>
<td>M5.1_008</td>
<td>hCV2986015</td>
<td>TSC0295775</td>
<td>rs705681</td>
<td>0.21</td>
<td>0.45</td>
</tr>
<tr>
<td>M5.1_009</td>
<td>hCV8720462</td>
<td>TSC0165692</td>
<td>rs893613</td>
<td>0.30</td>
<td>0.48</td>
</tr>
<tr>
<td>M5.1_010</td>
<td>hCV349615</td>
<td>TSC0314577</td>
<td>rs992690</td>
<td>0.16</td>
<td>0.24</td>
</tr>
<tr>
<td>M5.1_012</td>
<td>hCV8879897</td>
<td>—</td>
<td>—</td>
<td>0.43</td>
<td>0.46</td>
</tr>
<tr>
<td>M5.1_013</td>
<td>hCV7505765</td>
<td>TSC0265430</td>
<td>rs961495</td>
<td>0.26</td>
<td>0.19</td>
</tr>
<tr>
<td>M5.1_014</td>
<td>hCV1637791</td>
<td>TSC0016017</td>
<td>rs729673</td>
<td>0.45</td>
<td>0.40</td>
</tr>
<tr>
<td>M5.1_015</td>
<td>hCV1691378</td>
<td>TSC0265475</td>
<td>rs1115261</td>
<td>0.48</td>
<td>0.46</td>
</tr>
</tbody>
</table>

a Zip # is the SNPlex™ System Control Pool Zip Code

b AfAMb, Caucasian, ChinC, JapnD, Minor Allele Frequency

† Location in Bold Indicates a SNP of Interest
### Table A-1 48 SNPs in the SNPlex System Control Pool (continued)

<table>
<thead>
<tr>
<th>Zip #a</th>
<th>Celera Discovery System™ ID (hCV #)</th>
<th>SNP Consortium ID (TSC #)</th>
<th>dbSNP ID (rs #)</th>
<th>Minor Allele Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>AfA</td>
</tr>
<tr>
<td>M5.1_016</td>
<td>hCV3194437</td>
<td>TSC0301076</td>
<td>rs984071</td>
<td>0.20</td>
</tr>
<tr>
<td>M5.1_017</td>
<td>hCV7571632</td>
<td>TSC0243654</td>
<td>rs927221</td>
<td>0.16</td>
</tr>
<tr>
<td>M5.1_018</td>
<td>hCV7537265</td>
<td>TSC0129483</td>
<td>rs748573</td>
<td>0.32</td>
</tr>
<tr>
<td>M5.1_019</td>
<td>hCV7589926</td>
<td>—</td>
<td>—</td>
<td>0.30</td>
</tr>
<tr>
<td>M5.1_020</td>
<td>hCV8845932</td>
<td>TSC0324505</td>
<td>rs1156404</td>
<td>0.27</td>
</tr>
<tr>
<td>M5.1_021</td>
<td>hCV2179737</td>
<td>—</td>
<td>—</td>
<td>0.33</td>
</tr>
<tr>
<td>M5.1_022</td>
<td>hCV8792022</td>
<td>TSC0213380</td>
<td>rs879253</td>
<td>0.21</td>
</tr>
<tr>
<td>M5.1_023</td>
<td>hCV2489240</td>
<td>TSC0098582</td>
<td>rs1016146</td>
<td>0.12</td>
</tr>
<tr>
<td>M5.1_024</td>
<td>hCV2025116</td>
<td>TSC0757622</td>
<td>rs1507213</td>
<td>0.12</td>
</tr>
<tr>
<td>M5.1_025</td>
<td>hCV1653240</td>
<td>TSC0136611</td>
<td>rs751340</td>
<td>0.42</td>
</tr>
<tr>
<td>M5.1_026</td>
<td>hCV357822</td>
<td>TSC0783613</td>
<td>rs1520483</td>
<td>0.10</td>
</tr>
<tr>
<td>M5.1_027</td>
<td>hCV8686971</td>
<td>TSC0465947</td>
<td>rs1570903</td>
<td>0.23</td>
</tr>
<tr>
<td>M5.1_028</td>
<td>hCV706864</td>
<td>TSC0071873</td>
<td>rs288423</td>
<td>0.42</td>
</tr>
<tr>
<td>M5.1_029</td>
<td>hCV3017144</td>
<td>TSC0084538</td>
<td>rs1007106</td>
<td>0.19</td>
</tr>
<tr>
<td>M5.1_030</td>
<td>hCV9621778</td>
<td>TSC0318440</td>
<td>rs995178</td>
<td>0.41</td>
</tr>
<tr>
<td>M5.1_031</td>
<td>hCV8747570</td>
<td>TSC0679949</td>
<td>rs1597695</td>
<td>0.35</td>
</tr>
<tr>
<td>M5.1_032</td>
<td>hCV8862622</td>
<td>TSC0825772</td>
<td>rs1334334</td>
<td>0.15</td>
</tr>
<tr>
<td>M5.1_033</td>
<td>hCV8946637</td>
<td>TSC0809047</td>
<td>rs794108</td>
<td>0.46</td>
</tr>
<tr>
<td>M5.1_034</td>
<td>hCV1358402</td>
<td>TSC0463216</td>
<td>rs1569244</td>
<td>0.42</td>
</tr>
<tr>
<td>M5.1_035</td>
<td>hCV7500677</td>
<td>TSC0296508</td>
<td>rs238196</td>
<td>0.12</td>
</tr>
<tr>
<td>M5.1_036</td>
<td>hCV9589619</td>
<td>TSC0984433</td>
<td>rs1925643</td>
<td>0.42</td>
</tr>
<tr>
<td>M5.1_037</td>
<td>hCV8921382</td>
<td>TSC0910879</td>
<td>rs1713423</td>
<td>0.42</td>
</tr>
<tr>
<td>M5.1_038</td>
<td>hCV1688032</td>
<td>—</td>
<td>—</td>
<td>0.22</td>
</tr>
<tr>
<td>M5.1_039</td>
<td>hCV9636350</td>
<td>—</td>
<td>—</td>
<td>0.16</td>
</tr>
<tr>
<td>M5.1_041</td>
<td>hCV2962785</td>
<td>—</td>
<td>—</td>
<td>0.40</td>
</tr>
<tr>
<td>M5.1_042</td>
<td>hCV2780152</td>
<td>TSC0851851</td>
<td>rs1861606</td>
<td>0.49</td>
</tr>
<tr>
<td>M5.1_043</td>
<td>hCV2569743</td>
<td>TSC0430769</td>
<td>rs1548543</td>
<td>0.22</td>
</tr>
</tbody>
</table>
Table A-1  48 SNPs in the SNPlex System Control Pool (continued)

<table>
<thead>
<tr>
<th>Zip #a</th>
<th>Celera Discovery System™ ID (hCV #)</th>
<th>SNP Consortium ID (TSC #)</th>
<th>dbSNP ID (rs #)</th>
<th>Minor Allele Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>AfA Mb Cauc c Chin d Japn e Locationf</td>
</tr>
<tr>
<td>M5.1_044</td>
<td>hCV468629</td>
<td>TSC0463040</td>
<td>rs1569125</td>
<td>0.41 0.29 0.22 0.2</td>
</tr>
<tr>
<td>M5.1_045</td>
<td>hCV1534177</td>
<td>—</td>
<td>—</td>
<td>0.22 0.20 0.27 0.29</td>
</tr>
<tr>
<td>M5.1_046</td>
<td>hCV11164916</td>
<td>—</td>
<td>—</td>
<td>0.19 0.12 NA NA</td>
</tr>
<tr>
<td>M5.1_048</td>
<td>hCV2214945</td>
<td>TSC1086371</td>
<td>rs220860</td>
<td>0.25 0.22 0.22 0.22</td>
</tr>
<tr>
<td>M5.1_049</td>
<td>hCV8847720</td>
<td>TSC0695101</td>
<td>rs1460239</td>
<td>0.29 0.40 0.19 0.29</td>
</tr>
<tr>
<td>M5.1_050</td>
<td>hCV8777053</td>
<td>TSC0070807</td>
<td>rs954779</td>
<td>0.28 0.18 0.32 0.30</td>
</tr>
<tr>
<td>M5.1_051</td>
<td>hCV7443819</td>
<td>TSC0267953</td>
<td>rs963014</td>
<td>0.48 0.40 0.08 0.11</td>
</tr>
</tbody>
</table>

a. Indicates the correlation between a SNP and its corresponding ZipChute™ probe pair
b. African-American
c. Caucasian
d. Chinese
e. Japanese
f. Indicates chromosome and base position on the chromosome, as derived from the SNPbrowser™ software

About the Dried gDNA Plate

- Each gDNA plate contains 44 unique human DNAs of Caucasian origin.
- Each gDNA is plated at least twice in each quadrant of a 384-well microtiter plate to allow for the assessment of assay reproducibility (refer to the SNPlex™ Genotyping Dried gDNA Plate Control Pool System CD).
- For all gDNAs, a consensus genotype was established using data from repeat SNPlex System assays using the control pool SNPs. These genotypes serve as a reference to calculate the accuracy of the system (refer to the SNPlex™ Genotyping Dried gDNA Plate Control Pool System CD).
- gDNAs are plated into 384-well microtiter plates appropriate for use with the Applied Biosystems 3730/3730xl DNA Analyzer.
- The gDNA plate can be used in conjunction with custom human ligation probe pools. Comparing data achieved with the gDNA plate to data achieved with user-supplied DNA allows you to assess the quality of your DNAs.
- The proportion of female to male DNA is approximately 1:1.
- Users who prefer the 96-well protocol can resuspend the gDNA in one 384-well plate quadrant and transfer the contents to a 96-well plate (refer to “Using the SNPlex™ System Dried gDNA Plates” file on the CD).
Using the Control Pool

To use the SNPllex™ System Control Pool together with the dried gDNA plate, perform the SNPllex System assay as described in Chapter 3, substituting the SNPllex System Control Pool for the SNPllex™ Ligation Probe Pool. See the SNPllex™ Genotyping Dried gDNA Plate Control Pool System CD for information regarding the dispensing of the allelic ladder.

Expected Results

The following results can typically be expected when using the SNPllex System control pool together with the SNPllex System dried gDNA plate:

- Three genotype clusters should be observed for 45/48 SNPs. Exceptions are hcv7505765 (SNP #13), hcv7571632 (SNP #17), and hcv2962785 (SNP #41), which show only two clusters.
- The precision, or the measure of the reproducibility in genotype calls between identical gDNA samples, should be 99.7% or better.
- The accuracy, or the measure of the genotype data achieved with the SNPllex System against reference genotypes, should be 99.5% or better.
- The call rate, or the measure of the number of genotypes made relative to all possible calls, should be 95% or better.

Note: If you use your own gDNA plate together with the SNPllex System control pool, the signal strength and cluster angle you observe for one SNP should be similar to what you observe with the dried gDNA plate.

Figure A-1 shows the cluster plots for each of the 48 SNPs. (Cluster plots are numbered. Note that numbers 40 and 47 are not associated with a SNP in this figure.)
Figure A-1  Cluster plots of the 48 SNPs in the Control Pool
GeneMapper Software v4.0: Analysis Methods for SNPllex System Assays

This appendix covers:

Analysis Methods for SNPllex System Assays ............................... B-2
SNPllex_Rules_3730/ SNPllex_Rules_3130 ............................... B-4
SNPllex_Model_3730 ............................................................... B-9
Analysis Methods for SNPllex System Assays

Overview
An analysis method is a set of algorithm parameters that you apply to samples in a project before analyzing data. The GeneMapper® Software v4.0 uses analysis methods for peak detection, allele calling, peak quality quantification, and quality of results reports.

GeneMapper Software v4.0 includes two default methods for analyzing SNPllex™ system data:

- **SNPllex_Rules_3730 or SNPllex_Rules_3130** – Uses the Rules clustering algorithm to calculate the SNP quality according to a set of custom rules.
- **SNPllex_Model_3730** – Uses the Model clustering algorithm, which compares the behavior of alleles to an ideal (or “model”), to calculate the SNP quality.

**Note:** No model-based allele caller is available for data collected on the 3130xl instrument.

Selecting a Clustering Algorithm
The parameters of an analysis method are specified in the tabs of the Analysis Method Editor. The software online help provides detailed information about each of these parameters. Note that analysis parameters for SNPllex System applications are different from those for other applications (such as AFLP® kits or microsatellites).

To view the descriptions for SNPllex System analysis parameters in the software online help, click the Workflows tab. Under Applications-specific Workflows, click **SNPllex Analysis Workflow**, then click **Creating Analysis Methods**.

Of all the parameters, the clustering algorithm determines how the analysis method analyzes data. The default analysis methods for SNPllex System data are named after the clustering algorithm used in the method.

The following table explains how to decide which method to use for your data.

<table>
<thead>
<tr>
<th>Use the SNPllex_Model_3730 Method ...</th>
<th>Use the SNPllex_Rules_3730 or SNPllex_Rules_3130 Method ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>For high-throughput experiments with 40 to 94 samples per run.</td>
<td>• For low-frequency SNPs.</td>
</tr>
<tr>
<td>• Samples must contain DNA. Positive controls are included in the sample count.</td>
<td>• When you want to apply the filters, such as the Hardy-Weinberg filter, used by the Rules algorithm. Refer to “Modifying Values of Individual Rules (Rules Method Only)” on page B-7 for more information.</td>
</tr>
<tr>
<td>• Samples do not include the no template control (NTC) and allelic ladder.</td>
<td>• When you have fewer than 40 samples.</td>
</tr>
<tr>
<td>• If ≤24 samples are included in a run, the GeneMapper software will not analyze the data using the model-based method.</td>
<td>Note that to use the Model algorithm, probe pools must contain at least 18 SNPs.</td>
</tr>
</tbody>
</table>
**Terms Used in Clustering Analysis**

The following table defines commonly used terms in clustering analysis. For more information about these concepts, refer to the GeneMapper® Software v4.0 online help.

<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confidence Value (CV)</td>
<td>Indicates how confident the software is that a call it has made for a particular point is correct.</td>
</tr>
<tr>
<td>Process (Component-based) Quality Values (PQV)</td>
<td>Reported by the software to aid in finding and fixing problems in sample preparation and analysis.</td>
</tr>
<tr>
<td>Quality Flag</td>
<td>Based on the value of the PQV. For example, if SQ = 1, the quality flag for SQ will be green (pass).</td>
</tr>
<tr>
<td>Sizing Quality (SQ)</td>
<td>If the sizing quality of a SNP falls within the low quality range, the software does not process the sample any further.</td>
</tr>
<tr>
<td></td>
<td>Note that SQ values for SNPLEX System experiments are higher than that for other applications.</td>
</tr>
<tr>
<td>Genotype Quality (GQ)</td>
<td>Quality flag whose value determines whether the software passes or fails a genotype.</td>
</tr>
<tr>
<td></td>
<td>The calculated value is based on allele quality values (AQ) of the two alleles in the SNP and the weighted values of each PQV. The GeneMapper software online help provides detailed information about calculating the GQ.</td>
</tr>
<tr>
<td></td>
<td>For the Rules method, the GQ is zeroed out if GQs fall below the CV.</td>
</tr>
<tr>
<td></td>
<td>For the Model method, the GQ is not set to zero if the value falls below the CV.</td>
</tr>
<tr>
<td>Well Quality (WQ)</td>
<td>Quality flag that represents the mean confidence value (CV) for all SNPs within a well. The software fails wells whose CVs fall below the pass range specified for WQ.</td>
</tr>
<tr>
<td>SNP Quality (SNPQ)</td>
<td>Value serving as a preliminary indicator of the quality of an analyzed SNP.</td>
</tr>
<tr>
<td></td>
<td>For rules-based methods, 1 indicates a passing SNP; 0 indicates a failing SNP.</td>
</tr>
<tr>
<td></td>
<td>For model-based methods, the SNPQ is reported as a value between 0 and 1.</td>
</tr>
</tbody>
</table>

The following sections describe the default methods for analyzing SNPLEX System data.
SNPlex_Rules_3730/SNPlex_Rules_3130

Settings of the SNPlex_Rules_3730 Method

Table B-1 lists the default settings of the SNPlex_Rules_3730/SNPlex_Rules_3130.

Table B-1  Default settings for the SNPlex_Rules_3730/SNPlex_Rules_3130

<table>
<thead>
<tr>
<th>Tab</th>
<th>Default Settings</th>
<th>Modifying the Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Name: SNPlex_Rules_3730</td>
<td>—</td>
</tr>
<tr>
<td>Allele</td>
<td><img src="image" alt="" /></td>
<td>You can modify the following settings in the Allele tab:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Bin Set</strong> – Make sure that the bin set matches the panel used for the analysis. For SNPlex System experiments, the bin set is always SNPlex_48plex_Bin_3730. (Use SNPlex_48plex_Bin_3130 for data collected on the 3130xl instrument.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Allele Calling Method</strong> – Refer to “Selecting an Allele Calling Method” on page B-6 for information about selecting an allele calling method.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clustering – If selected, you can set the clustering threshold and specify how data is clustered. You can also modify values of the rules that the algorithm uses to calculate SNP quality.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Refer to “Modifying the Clustering Parameters” on page B-6 for more information.</td>
</tr>
</tbody>
</table>
Refer to the online help for a detailed description of the parameters in the Peak Detector tab. (Search on the topic “SNPlex Peak Detector”.)

- For SNPlex System experiments, the Peak Detection Algorithm must be **Advanced**.
- The Peak Amplitude Thresholds should be low (default is 10 for B, G, Y, and R and 50 for O; for the 3130xl instrument, it is 25 for O).
  - If set below 10, background noise may lengthen and interfere with analysis.
  - If set above 10, clustering is affected.

Refer to the online help for a detailed description of the parameters in the Peak Quality tab. (Search on the topic “SNPlex Peak Quality”.)

Although the software calculates values for the parameters in this tab, the peak quality parameters do not affect the Genotype Quality because the Quality Flags are set to 0.
Appendix B  GeneMapper Software v4.0: Analysis Methods for SNPlex System Assays

Selecting an Allele Calling Method

GeneMapper Software v4.0 provides two allele calling methods:

- Filtering – The filtering method allows you to analyze sample data based solely on peak height, without clustering analysis.
- Clustering – This method makes calls based on a minimum confidence value for a sample in a particular cluster. Most SNPlex System data is analyzed using this method.

Modifying the Allele Cut-off Value

If you select the Filtering method, you can specify an Allele Cutoff Value, which is the value below which a peak is recognized as an allele. The allele cutoff value is the percentage of the larger peak’s height required for the smaller peak to be called as an allele.

**IMPORTANT!** Applied Biosystems does not recommend using this method for SNPlex analysis.

![Diagram showing allele cutoff value](image)

Modifying the Clustering Parameters

If you select the Clustering method for allele calling, you can:

- Specify how data is clustered
- Set the clustering threshold
- Modify values of the rules that the algorithm uses to calculate SNP quality

---

Table B-1  Default settings for the SNPlex_Rules_3730/SNPlex_Rules_3130 (continued)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality Flags</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Refer to the online help for a detailed description of the parameters in the Peak Quality tab. (Search on the topic “SNPlex Quality Flag”.)

For SNPlex System default analysis methods, all quality flags are set to 0. Consequently, the software does not use these flags to pass or fail a SNP. However, the PQVs are used to calculate the genotype quality, as shown in Table B-1 on page B-4.

![Table showing default settings](image)
Specifying How Data is Clustered

- Select **Cluster By Run** for the software to analyze the samples in one run independently from other runs. Most SNPlex System data is clustered according to this method.

  **IMPORTANT!** If you are using the Model method, you must select Cluster By Run.

- Select **Cluster By Project** for the software to analyze all of the selected samples in a project, regardless of whether the samples were run at the same time. If you select Cluster By Project, make sure that you select the SNP set before analyzing your project.

  For example, if you have 10 runs out of 96 in which a single data point is shown as Heterozygote 2 (Het 2), by clustering the 10 runs in the project, you obtain 10 points displayed as Het 2. Consequently, it is easier to determine if the call is accurate or if it is an experimental artifact.

  **Note:** Regardless of the clustering method that you select, bin offsets are calculated by run (that is, by grouping all samples in a folder into a single run).

Setting the Clustering Threshold

The clustering threshold value is the minimum confidence value of the sample in a cluster.

- For the Rules method, if the confidence value for an individual data point in a particular cluster is $>0.95$, the point is labeled with the genotype for that cluster. If the CV falls below the threshold, the genotype is zeroed out.

- For the Model method, the genotype for the data point is always displayed, whether or not the sample passes the threshold. (An exception is when a sample is removed from analysis, none of its data points will have a CV.)

Modifying Values of Individual Rules (Rules Method Only)

An important point to remember about the Rules method is that the SNP needs to fail only one of the six rules for the software to fail the SNP. The following table lists the six rules according to which SNPs are assessed.

**Table B-2 Modifications of rule values**

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of clusters must be no less than</td>
<td>If the software detects fewer clusters than specified in this rule, the SNP is failed. Default is 1.</td>
</tr>
</tbody>
</table>
Thresholds for the Model Algorithm

IMPORTANT! Applied Biosystems recommends that you do not modify these settings.

The Model algorithm rejects samples according to the following threshold values:

- **Well signal threshold** – Represents the mean signal (from both alleles) of a well. It is the sum of all the peaks, divided by the number of SNPs.
- **Well template threshold** – Represents how far the well’s behavior is from an ideal well (0.5). The software rejects wells that have values that fall below this threshold.
SNPlex_Model_3730

Settings of the SNPlex_Model_3730 Method

Table B-3 lists the default settings of the SNPlex_Model_3730.

Table B-3 Default settings for the SNPlex_Model_3730

<table>
<thead>
<tr>
<th>Tab</th>
<th>Default Settings</th>
<th>Modifying the Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Name: SNPlex_Model_3730</td>
<td>You can modify the following settings in the Allele tab:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Bin Set – Make sure that the bin set matches the panel used for the analysis. For SNPlex System experiments, the bin set is always SNPlex_48plex_Bin_3730.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Allele Calling Method – Refer to “Selecting an Allele Calling Method” on page B-6 for information about selecting an allele calling method.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Clustering – If selected, you can set the clustering threshold and specify how data is clustered. You cannot use the Cluster By Project option.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Refer to “Modifying the Clustering Parameters” on page B-6 for more information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IMPORTANT! Applied Biosystems recommends that you accept the default settings for the Model threshold values.</td>
</tr>
<tr>
<td>Allele</td>
<td></td>
<td>Refer to “Peak Detector” on page B-5.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Refer to “Peak Quality” on page B-5.</td>
</tr>
<tr>
<td>Peak Detector</td>
<td>Same as the settings for the Rules method. Refer to “Peak Detector” on page B-5.</td>
<td></td>
</tr>
<tr>
<td>Peak Quality</td>
<td>Same as the settings for the Rules method. Refer to “Peak Quality” on page B-5.</td>
<td></td>
</tr>
</tbody>
</table>
Table B-3  Default settings for the SNplex_Model_3730

<table>
<thead>
<tr>
<th>Tab</th>
<th>Default Settings</th>
<th>Modifying the Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality Flags</td>
<td><img src="image" alt="Quality Flag Settings" /></td>
<td>Refer to the online help for a detailed description of the parameters in the Peak Quality tab. (Search on the topic “SNPlex Quality Flag”.) For SNPlex System default analysis methods, all quality flags are set to 0. Consequently, the software does not use these flags to pass or fail a SNP. However, the PQVs are used to calculate the genotype quality.</td>
</tr>
</tbody>
</table>
## Index

### Numerics

<table>
<thead>
<tr>
<th>Numerics</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>48-capillary array injection scheme</td>
<td></td>
</tr>
<tr>
<td>384-well plate</td>
<td>3-5</td>
</tr>
<tr>
<td>96-well plate</td>
<td>3-4</td>
</tr>
<tr>
<td>96-capillary array injection scheme</td>
<td></td>
</tr>
<tr>
<td>384-well plate</td>
<td>3-4</td>
</tr>
<tr>
<td>96-well plate</td>
<td>3-3</td>
</tr>
</tbody>
</table>

### A

- AIF, importing                                                      4-5
- allele calling methods described                                    B-6
- Allele Cutoff Value for Filtering method                            B-6
- allele-specific oligos                                              1-2, 1-19
- allelic ladder                                                       1-4, 1-25, 3-11
- Amplification kit                                                   1-7, 3-21
- analysis method defaults                                            B-2
- defined                                                             B-2
- setting                                                             4-7
- which to use                                                        B-2
- analysis methods for SNPlex System data                               4-8
- Applied Biosystems                                                  |
  - contacting                                                        xiii
  - customer feedback on documentation                                 xii
  - Information Development department                                 xii
  - Services and Support                                               xiii
  - Technical Support                                                  xiii
- ASOs. See allele-specific oligos                                     |
- Assay Information File (AIF), importing                              4-5

### B

- biohazard warning                                                   xix
- biohazardous waste, handling                                        xix
- Bold 1-xi                                                           |

### C

- calibration standards                                               1-8
- capillary array, preconditioning                                     2-6
- CAUTION, description                                                xvi
- chemical safety guidelines                                          xviii
- cluster plots, troubleshooting                                      5-23
- clustering analysis, term definitions                               B-3
- Clustering method                                                   |
  - by run or by project                                               B-7
  - clustering threshold value                                         B-7
  - settings                                                           B-6
- Control kit                                                          1-7
- control pool                                                        |
  - results with gDNA plate                                           A-5
  - SNP contents                                                       A-2
  - using                                                              A-5
- controls, hybridization                                             3-23
- conventions                                                         |
  - for describing menu commands                                      xi
  - IMPORTANTS!                                                        xi
  - in this guide                                                      xi
  - Notes                                                              xi
  - safety                                                             xvi
  - user attention words                                               xi
- customer feedback, on Applied Biosystems documents                  xii

### D

- DANGER, description                                                  xvi
- data analysis, required plate record fields                          4-6
- Data Collection v2.0                                                1-2
- documentation, related                                               xii
- Dye Set S, installing                                               2-5
- dye sets                                                            1-8, 3-39

### E

- electrophoresis, plate assembly                                      3-40
- ergonomic safety                                                     xx
- exporting data                                                       4-10

### F

- files                                                                |
  - prebatch                                                          3-41
- Filtering method, using Allele Cutoff Value                         B-6
gDNA
- dispensing into reaction plates 3-11
- drying down 3-10
- fragmenting 3-10
- preparing for fragmentation 3-9

gDNA plate contents A-4
results with control pool A-5
GeneMapper software v 3.7 1-2

genomic DNA guidelines for purification 1-15
purification kits 1-15
quantification 1-17

guidelines chemical safety xviii
gDNA preparation 1-15
waste disposal xix

hybridization binding PCR products 3-24
denaturing with NaOH 3-25
eluting ZipChute probes 3-28
master mix 3-26
overview diagram 1-26
positive control 3-23
preparing plates 3-24
sample loading mix, preparing 3-27
ZipChute probes 3-26

oligo ligation assay master mix, with UNG 3-13
preparing with UNG 3-13
thermal cycling conditions, with UNG 3-17

peaks, pull-up or pull-down 5-8
phosphorylation kit 3-12
pooling probes 3-12
plate records, creating 3-31
plates, hybridization 3-24
pooling SNPlex Ligation Probes 3-12
prebatch files for SNPlex system 3-41
PrebatchModule. txt file, replacing 2-3
prerequisites for running plates 3-41

locus-specific oligos 1-2, 1-19
LSOs. See locus-specific oligos

master mix
- hybridization 3-26
- Lambda-Exo reaction 3-19
- oligo ligation assay, with UNG 3-13
- PCR 3-21
- Purification 3-19

materials
- optional 1-13
- required 2-2

matrix standard, preparing 2-8

mock run 2-11
-evaluating 2-13

Model algorithm, sample rejection B-8

MSDSs
- description xvii
- obtaining xiii, xvii
- referring to xviii

panel, setting for analysis 4-7
panels and bins, importing 4-3
parameter files 4-3
PCR
- Amplification kit 1-7, 3-21
- assembling reaction 3-22
- master mix 3-21
- overview diagram 1-23
- thermal cycling conditions 3-22

phosphorylation kit 3-12
pooling probes 3-12
plate records, creating 3-31
plates, hybridization 3-24
pooling SNPlex Ligation Probes 3-12
prebatch files for SNPlex system 3-41

PrebatchModule. txt file, replacing 2-3
prerequisites for running plates 3-41
probes
  allele-specific 1-2
  ASO/LSO pool 1-3
  concentration of SNPlex Ligation Probes 3-12
  locus-specific 1-2
  OLA probe set 1-3
  pooling OLA probe set 3-12
  SNP-specific 1-2
  universal linkers 1-3
protocol for SNPlex System 2-5
protocols, instrument 3-39
purification
  diluting reactions 3-22
  kit 1-7, 3-19
  Lambda-Exo reaction, preparing 3-19
  overview diagram 1-22
  storing digests 3-20
  thermal cycling conditions 3-20
Purification kit 1-7, 3-19

Q
quantifying gDNA 1-17

R
radioactive waste, handling xix
reaction plate, ligation 3-14, 3-16
records, plate 3-31
replacing PrebatchModule.txt 2-3
required materials 2-2
Results Group, setting up run folder 4-8
Rules method, six rules B-7
run folder
  setting up Results Group 4-8
  software requirements 4-8
run folder naming convention and sample plate layout 3-3
running SNPlex plates on 3730/xl analyzer 3-42

S
safety
  alert words xvi
  chemical xvii
  conventions xvi
  ergonomic xx
  workstation xx
sample plate layout and run folder naming convention 3-3
sample plate requirements 3-3
Services and Support, obtaining xiii
sets, dye 1-8, 3-39
signal strength, for troubleshooting 5-5
size standard, setting for analysis 4-7
SNP control pool
  contents A-2
  using A-5
SNPlex System analysis methods 4-8
SNPlex system prebatch files 3-41
SNPlex System Software Suite 1-2
SNPlex_Rules_3730
  about the algorithm B-4
  default settings B-4
SNP-specific probes 1-2
spatial calibration, performing 2-7
spectral calibration, performing 2-7
spectral calibration, troubleshooting 5-8
Standards kit 3-27
standards, calibration 1-8
streptavidin plates, preparing 3-24

T
Technical Support, contacting xiii
test run 2-11
test run, evaluating 2-13
test sample plate, for mock run 2-11
text conventions xi
thermal cycling conditions
  Exonuclease reaction 3-20
  oligo ligation assay, with UNG 3-17
  PCR 3-22
  Purification 3-20
Training, obtaining information about xiii
troubleshooting
  cluster plots 5-23
  signal strength 5-5
  spectral calibration 5-8

U
user attention words, described xi

W
WARNING, description xvi
waste disposal, guidelines xvi
workstation safety xx

Z
ZipChute probes
  description 1-4
  eluting 3-28
  hybridizing 3-26
ZipCode sequences 1-2
Worldwide Sales and Support

Applied Biosystems vast distribution and service network, composed of highly trained support and applications personnel, reaches 150 countries on six continents. For sales office locations and technical support, please call our local office or refer to our Web site at www.appliedbiosystems.com.

Applera is committed to providing the world's leading technology and information for life scientists. Applera Corporation consists of the Applied Biosystems and Celera Genomics businesses.

Headquarters
850 Lincoln Centre Drive
Foster City, CA 94404 USA
Phone: +1 650.638.5800
Toll Free (in North America): +1 800.345.5224
Fax: +1 650.838.5884

09/2007